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in Bangladesh, roughly half the population depends on agriculture for its livelihood. however, farmers face 
many challenges to earning a living. one challenge is access – access to markets, information, agricultural 
technologies, and related services and public goods. another challenge is the lack of awareness of individual 
farmers of their basic rights. organizations, groups or associations among farmers have the potential to address 
these challenges, increase and diversify production in a sustainable manner, improve food and nutrition 
security, and act as major agents of change in Bangladesh. Farmers’ organizations are increasingly seen as key 
partners in global initiatives, including in the World committee on Food security, the global agriculture and 
Food security Program (gaFsP) and the scaling up nutrition movement. 

there is a role that organizations of farmers can play in the design and management of investments under the 
country investment Plan (ciP) of the government of Bangladesh – a plan that covers agriculture, food security 
and nutrition. developing farmers’ organization capacities - in the design and implementation of activities 
under the ciP - is one of the key goals of the integrated agricultural Productivity Project (iaPP) technical 
assistance component, financed by the gaFsP and implemented by the Food and agriculture organization of 
the united nations (Fao). 

in 2013, Fao launched its new strategic framework. the framework refocuses the work of the organization 
around 5 objectives: (1) eradicating hunger and malnutrition; (2) sustainable agriculture; (3) reducing rural 
poverty; (4) ensuring efficient and fair food systems; and (5) increasing resilience. For each of these objectives, 
the ability of farmers to organize is key to developing lasting solutions. Further, the vision of Fao highlights the 
critical role of agriculture in ending hunger and malnutrition. Farmers’ organizations are major stakeholders 
here, as they bring a nuanced understanding of the local context and actual needs, as well as important 
social capital. 

the first step in Bangladesh to further this work has been to identify the types of organizations that exist, and 
understand the factors that contribute to their success. this review was undertaken in partnership, between 
Fao, the Ministry of agriculture of the government of Bangladesh, the asian Farmers association, and a 
variety of non-governmental organizations (ngos). it aims to provide information for practitioners interested 
in deepening their work with farmers’ organizations in Bangladesh. it provides a mapping of farmers’ 
organizations throughout the country, an assessment of their capacities, a review of enabling environment 
issues, and proposals to strengthen organizations and increase their involvement in investment programming 
in agriculture and food and nutrition security. these proposals will be taken up by the iaPP and, we hope, by 
many others in Bangladesh.

gustavo Merino Md. nasiruzzaman Mike robson 
director Project director Fao representative
Fao investment centre  iaPP Bangladesh     Bangladesh

Foreword
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the aim is to empower 
farmers’ organizations to 
become pro-active partners in 
the investment programming 
cycle. this involvement 
will lead to more effective 
interventions to improve food 
and nutrition security  
in Bangladesh.
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Executive summary

Farmers’ organizations (Fos) in Bangladesh have the potential to be true partners in, rather than “beneficiaries” 
of, the development process. Fos bring to the table a deep knowledge of the local context, a nuanced 
understanding of the needs of their communities and strong social capital. increasing the engagement of Fos 
in the investment programming cycle will strengthen food and nutrition security in Bangladesh. 

With this in mind, the technical assistance (ta) component of the integrated agricultural Productivity 
Project (iaPP), implemented by the Food and agriculture organization of the united nations (Fao), conducted 
a mapping and capacity assessment exercise. the goal was to fill the knowledge gap around Fos in Bangladesh, 
identify the main constraints Fos face to get involved in investment planning and programming, and propose 
solutions.

the mapping team met a variety of Fos, as well as non-governmental organizations (ngos) and government 
bodies involved in the formation of Fos. the team conducted 38 key informant interviews, 18 focus group 
discussions and 31 organization visits. 

during the exercise, 198 114 FOs of various types were identified. eighty-one percent were formed with 
support from government agencies, 14 percent from national ngos, 5 percent from international ngos, and 
less than 0.01 percent – only 12 organizations – were formed autonomously. Just over 2 percent of Fos are 
federated at any level. 

Three main challenges FOs face to being involved in investment programming are the following:

>> The bulk of FOs are small (i.e. community level) and disconnected. as such, their voice in investment 
programming is rarely heard. although some Fos are currently federated at the district level, only a handful 
of organizations claim to speak on behalf of farmers at the national level. however, there are questions 
about the legitimacy of these organizations as many are more connected to political parties than their 
membership. there is a need to help smaller Fos organize and network from the bottom up.

>> Most FOs are externally promoted by Government agencies, NGOs and projects. they are used as 
mechanisms to deliver activities and services (e.g. training, inputs) rather than as autonomous and 
sustainable institutions capable of partnership with other development actors. 

>> Key principles necessary for the development of strong organizations are not applied consistently. 
these key principles are: (i) autonomy; (ii) inclusive leadership; (iii) a strong membership base; (iv) needs-
based service provision; and (v) a clear, “owned” purpose. Without the application of these, organizational 
weakness will prevent meaningful involvement in investment programming. 
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in order to overcome these challenges, support is needed in the following areas:

1. institutional development;

2. business and market-related service provision;

3. facilitation skills of those working with Fos;

4. access to credit; 

5. post-harvest and value addition technology; and

6. strengthening the enabling environment for Fo development. 

The IAPP TA proposes the following interventions, recognizing the need for collaboration with partners in 
implementation:

1. Fo-to-Fo exchange;

2. short-term training of Fo leaders and members;

3. capacity development of those forming and facilitating Fos;

4. ensuring participation of Fos and civil society organizations in government decision making bodies; and

5. facilitation of dialogue between stakeholders to address enabling environment issues.

though support is needed at all levels, the iaPP ta component aims to focus its resources strategically in order 
to have a greater impact. as such, it proposes two main target groups for these activities: (i) iaPP field-level 
institutions and those that facilitate them; and (ii) organizations that are federated or have started making 
progress towards federating, as well as those that facilitate them. 

Next steps for the proposed activities include the following: (i) sharing the report with government officials, 
development partners, ngos and Fos, as well as other interested parties in order to raise awareness and spark 
dialogue; (ii) implementing Fo-related activities from the iaPP ta work plan; (iii) planning for future iaPP ta 
activities that will build upon the growing momentum of this work and provide more opportunities for Fos to 
network, learn from each other and start planning together; (iv) addressing some of the enabling environment 
issues mentioned herein; and (v) developing and strengthening partnerships with other institutions and 
projects working with Fos.

through the combination of these activities, the aim is to empower FOs to become pro-active partners in the 
investment programming cycle. this involvement will lead to more effective interventions to improve food 
and nutrition security in Bangladesh.



The>team>found>a>total>of>198>114>farmers’>
organizations>throughout>different>regions>
of Bangladesh.>>
>
The>majority>of>farmers’>organizations>
were>formed>with>support>from>extension>
agencies>of>the>Government,>or>NGOs.

Most>of>the>farmers’>
organizations>are>very>small>
(around>25-50>members)>and>
are>at>community>level.>

Some>projects>and>organizations>have>
begun>federating>small>organizations>into>
larger>fora,>giving>hope>for>sustainability.



some of the benefits of 
being organized in a farmers’ 
organization include the ability 
to share information and 
ideas, pool resources, lower 
production costs, gain access 
to markets, serve as an efficient 
access point for communication 
with other development actors, 
as well as advocate through 
strength in numbers.
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Background 1
in the face of scarce land and overpopulation, Bangladesh must contend with many challenges to overcome 
poverty and food insecurity. a majority of the population, approximately 16 million families (about 80 million 
people), depend on agriculture (a sector that is plagued by challenges) for their livelihood.

the poor performance of the agriculture sector in Bangladesh is the result of a variety of physical, socio-
economic and institutional constraints. one of the most conspicuous of these is the recurrent cycle of natural 
disasters and environmental concerns in the country – predominantly floods, drought, salinity, and erosion. 
one-fourth of total cultivable land (8.42 million hectares [ha]) is affected by drought, while 0.3 million ha are 
water logged. approximately 5.6 million ha are flood prone, and 0.82 million ha of costal and offshore tidal 
plains are affected by salinity. additionally, annual losses by pests, diseases and weeds amount to 20-50 percent 
of total yield, while losses during storage are at 14 percent.

in order to develop comprehensive interventions to address the many challenges of agriculture, food security 
and nutrition, the government of Bangladesh designed its country investment Plan (ciP), which represents the 
government’s priorities for investment in those areas. 

during late 2010 and early 2011, the Food and agriculture organization of the united nations (Fao) was involved 
in a consultation process designed to strengthen the ciP. Many stakeholders were consulted, including civil 
society groups and non-governmental organizations (ngos). however, there was a lack of awareness and 
understanding of mechanisms with proven efficiency to engage directly with farmers and their representatives, 
which would have involved them in investment planning and the project cycle.

in June 2010, the government of Bangladesh received a usd 50 million grant from the global agriculture and 
Food security Program (gaFsP) for the integrated agricultural Productivity Project (iaPP), which is in line with 
the priorities outlined in the ciP. usd 3.69 million of this amount was allocated for a technical assistance (ta) 
component, implemented by Fao, to develop capacities of a variety of actors, including non-state actors such 
as farmers’ organizations (Fos), in investment programming in agriculture, food security and nutrition.

the ta component has three sub-components: (i) developing capacities in project cycle management; 
(ii)  developing capacities in specific technical areas relevant to the ciP and the iaPP – seed sector quality 
assurance, water management, and nutrition; and (iii) developing capacities to ensure inclusive investment 
programming. this last sub-component takes a ‘twin track’ approach to strengthen inclusiveness – it builds 
both the capacity of state actors in stakeholder mobilization and consultation, and the capacities of non-state 
actors, particularly Fos, to organize, advocate and partake in the investment programming process. it is 
under this third sub-component that this mapping exercise fits.
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the ta component aims to address capacity needs at the individual, organizational and enabling environment 
levels, in order to provide a holistic approach to capacity development. this is in line with the Fao capacity 
development framework and international good practices. 

What are some examples of how this translates concretely in this work with Fos? at the individual level, 
the project is working to develop skills of Fo leaders and members to be able to participate in investment 
programming. at the organizational level, the project is facilitating exchanges between Fos that will strengthen 
their institutions. at the enabling environment level, the project has conducted a review of policies relevant to 
Fos and has proposed some improvements (contained within this report). 

1.1 Farmers’ organizations: Definition 

For the purpose of this exercise, an FO is defined as a formal or informal (registered or unregistered) 
membership-based collective action institution serving its members, who are rural dwellers that get part or 
all of their livelihood from agriculture (crops, livestock, fisheries and/or other rural activities). services provided 
by the Fo aim to improve the livelihoods of its members, and include access to advice, information, markets, 
inputs and advocacy.

1.2 Farmers’ organizations: Benefits of being organized 

some of the benefits of being organized in an Fo include the ability to share information and ideas, pool 
resources, lower production costs, gain access to markets, serve as an efficient access point for communication 
with other development actors, as well as advocate through strength in numbers.  

With regards to market access, by consolidating their efforts, farmers and their organizations are able to pool 
resources and build assets and competency. With a larger market share and with more information, small 
producers can modify transaction conditions, such as price and timing and can exert influence over other 
actors, thereby gaining market and negotiating power. With real market power, Fos gain credibility and are 
in a better position to discuss with policy makers. considering that agriculture in Bangladesh needs to move 
higher in the value chain in order to increase farmer income, the formation of Fos is very beneficial to farmers, 
as it allows them to engage more effectively at these levels.

Farmers’>Organizations>vs.>Farmers’>Groups

In>Bangladesh,>there>is>a>spectrum>of>institutions>formed>by>farmers.>It>ranges>from>farmers’>groups>promoted>
by>external>actors>for>the>main>purpose>of>project>delivery>(whether>stated>explicitly>or>understood>implicitly>
owing>to>the>lack>of>provisions>for>sustainability>following>project>completion)>to>FOs>and>farmers’>federations>
formed>autonomously>by>community>members,>with>the>purpose>of>establishing>a>platform>to>address>the>
needs>of>the>farming>community>on>a>permanent>basis.>In>between>these>two>extremes,>there>are>associations,>
societies,> cooperatives,> unions,> and> even> firms.> The> common> thread> is> that> all> are> established> to> serve> the>
interests>of>farmers.

The>mapping>team>has>intentionally>chosen>to>include>all>institutions>on>this>spectrum,>as>they>are>all>part>of>
the>landscape>of>FOs>(used>in>the>broader>sense)>in>Bangladesh.>The>purpose>of>this>broad>inclusion>is>to>analyse>
the> strengths> and> shortcomings> of> different> types> of> organizations> in> order> to> paint> a> complete> picture> of>
the>situation>and,>therefore,>allow>for>meaningful>insight>into>the>challenges>Bangladeshi>farmers>encounter>
in organizing.
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1.3  Farmers’ organizations: Key factors for success 

the many factors that contribute to a strong Fo vary depending on the context. however, through the exercise, 
the team found the following factors, which are often overlooked, to be particularly important for successful, 
sustainable organizations: 

>> Autonomy: though some Fos may be formed by external facilitators, autonomy is key for long-term 
sustainability. leadership, vision and initiative must come from within the organization. decisions must be 
made genuinely by the members and not through direct or indirect imposition by facilitators. this does not 
mean that there is no role for facilitators, but that all who are engaged as such must genuinely be working 
towards the complete autonomy of the organization within a defined time frame. in order for this to be 
feasible, the formation of Fos cannot be an externally-imposed process, but must, instead, highlight the 
benefits of being organized, facilitate peer-to-peer learning from already established Fos, and build on 
existing networks within villages. this process takes time and those planning to support the formation of 
Fos must allow for it.

>> Inclusive leadership: strong leaders that mobilize and engage their members are also key to ensuring the 
sustainability of Fos. leaders must be genuinely endorsed by members and must make continuous efforts 
to engage and communicate with their organization. grievance and accountability mechanisms should 
also be in place to address any concerns about poor leadership.

>> A strong membership base: an Fo is as strong as its members.   if the members are strong, its leaders 
are likely to be strong as well. the reverse is not necessarily true. in Bangladesh there is a large risk of 
leaders taking all the benefits of the Fo for themselves and not sharing with members (elite capture). as 
such, developing a strong, empowered membership base is critical for ensuring the sustainability of the 
organization. Members must be engaged in the affairs of the organization and must be able to hold their 
leaders accountable.

>> Needs-based service provision:  services provided by the Fo must be based on the true needs of its members, 
and not on the pre-conceived notions of external actors. if service provision does reflect actual needs, this 
can be key to ensuring the financial viability of the Fo. this can take shape through the development of an 
enterprise (a seed mill, for example) that can generate revenue for the organization. it could also be through 
the provision of information or advocacy services, which don’t, per se, generate revenue, but do ensure an 
engaged membership base that is more likely to see the benefits of partaking in the organization (ensuring 
a steadier stream of membership dues, which contribute to financial sustainability).

>> A clear, ‘owned’ purpose: a key step in the Fo development process must be for farmers to make their 
purpose for organizing explicit. this purpose must be clear to all concerned farmers, and not just to the 
facilitators who, in many cases, impose their own ideas. this is a large factor contributing to the mechanical 
nature of Fo development, and why organizations are at risk of failing upon closure of the project under 
which they were developed.



once institutions are strong, 
with a sense of purpose 
and good leadership, they 
are able to vocalize and 
advocate for their needs and 
ideas. as such, they become 
more engaged partners in 
investment. 
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Approach and methodology 2
2.1  Objectives

this exercise had two objectives. the first was to attempt to fill the knowledge gap on Fos in Bangladesh. 
though the mapping exercise did not cover every organization in the country, the intent was to centralize 
information about Fos in order to make it available for the broader development community. the second 
objective was to gather information to analyze capacity needs and tailor capacity development activities under 
this ta component – specifically to adapt the content, targeting and approach of these in order to strengthen 
the institutional capacities of Fos so that they can become strong, legitimate actors in the investment 
programming cycle.

2.2  Geographical coverage

Primary qualitative and quantitative data of this mapping cover organizations in rangpur, Barisal (and rajshahi 
for those linked to helvetas swiss intercooperation [hsi]). secondary information was collected from apex 
agencies (in dhaka, rangpur and Barisal) and covers organizations throughout Bangladesh. 

2.3  Theme

While many organizations have managed to develop their technical capacities, it was found during the initial 
ciP consultations in 2010, and further confirmed during this exercise, that institutional capacities consistently 
lag behind – and were, therefore, the main focus of discussions. this is rooted in the idea that once institutions 
are strong, with a sense of purpose and good leadership, they are able to vocalize and advocate for their needs 
and ideas. as such, they become more engaged partners in investment. 

2.4  Timing and participation

the exercise took place in two phases from spring 2012 to spring 2013. representatives from the iaPP Project 
Management unit and regional offices, the asian Farmers association (aFa), action aid Bangladesh and both 
the ta component project team and the Fao investment centre were involved. 

2.5  The initial mapping

the first phase of the exercise began in april 2012 and is referred to as the ‘initial mapping.’ during this phase, 
three focus group discussions, one each in dhaka, rangpur and Barisal, took place. the team also visited 
Fos in their villages and headquarters (for the few federated groups). in addition to the workshops and field 
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visits, the team held bilateral discussions with ngos working with Fos in the two regions. a sharing meeting 
brought together government/iaPP project staff with ngos to discuss the main findings from the visit, and to 
brainstorm solutions to the constraints faced by the organizations met.

2.6  In-depth mapping

though the initial mapping gave a useful snapshot of the situation, more work was required to better 
understand the landscape. this in-depth mapping began in spring 2012 and continued until spring 2013. 
during this phase, 15 focus group discussions, 38 key informant interviews and 31 Fo visits took place. 
additionally, the team conducted a review of policies relevant to Fo development, as well as the registration 
processes of organizations and cooperatives. the exercise confirmed many of the capacity needs found during 
the initial phase and uncovered some additional needs. importantly, the in-depth mapping also allowed the 
development of a network of Fo leaders and government and ngo partners, which has paved the way for the 
delivery of activities to strengthen Fos by the ta component. 

2.7  Limitations

though the approach aimed to be as inclusive as possible, it is important to note some important limitations. 
this mapping was an attempt to centralize information about Fos in Bangladesh – it does not cover every 
single Fo in the country. Within the selected regions, rangpur and Barisal, even local project staff encountered 
a lack of easy access to information about Fos which resulted in the team being unable to meet with all 
organizations included. 

Members attend a Village association meeting in gaibandha district.
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in addition to difficulties in gathering data on the number of existing organizations, the team faced even larger 
difficulties gathering data on membership numbers and demographics, and organizational purpose. this has 
meant that deeper analysis on the organizations included in this report (such as a breakdown of Fos based 
on organizational purpose or on gender or youth balance) is not possible at this stage. With time, more data 
should become available and this analysis could be conducted at a later stage.

this said, the team did manage to gather a large amount of information on a fairly representative sample of 
organizations. the analysis of this information led to the findings synthesized in section 4.

More information on the methodology can be found in annexes 1, 2 and 9.



Policy makers are increasingly 
emphasizing the central 
contribution of farmers’ 
organizations to food and 
nutrition security, and that 
involving them in investment 
programming ensures more 
effective interventions.
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Enabling environment for  
farmers’ organizations 3
this section includes a review of the enabling environment that shapes the involvement of Fos in investment 
in agriculture, food security and nutrition. this includes the policy framework, the institutions involved in 
registering Fos and the institutional framework for training government agricultural extension workers.

International

at the international level, policy makers increasingly emphasize the central contribution of Fos to food and 
nutrition security, and that involving them in investment programming ensures more effective interventions. 
support to Fos has come from the united nations (un) general assembly, the 2012 World Food day, the 
un secretary-general’s zero hunger challenge and the gaFsP. 

National

there are a variety of policies that place emphasis on Fos (or groups, as they are commonly referred to in the 
policies). although the roles and needs of Fos are recognized at the policy level, this tends to be inadequately 
translated into practice in agricultural development planning and programmes. 

3.1  Breakdown of the 10 relevant policy instruments

the mapping team reviewed a large number of agricultural and rural development policies and strategies 
developed by the government of Bangladesh. it found 10 policy instruments that refer to Fos. 

these policy instruments include:

>> two broad policies: the national agricultural Policy (naP) (1999) and the rural development Policy (2001);

>> one specific cooperative law, drafted in 2011, but not yet approved;

>> three policy tools focusing on agricultural extension as agents are expected to work with and through Fos;

>> more specific sub-sector policies (fisheries, livestock, water management) that also impact the way 
government works with Fos. 

the table below provides information on these policy instruments. a synthesis of findings follows.
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Table>3.1   Major agricultural policies relevant to farmers’ organizations1

Policy/>Implementing>Agency Sections>relevant>to>FOs Status>of>implementation Recommendations

National>Agriculture>Policy>(NAP)>>
–>>1999

Implementing Agency1: Ministry of 
Agriculture (MoA)

Section>10,>page>12:>
Emphasizes reinforcing implementation 
of the New Agricultural Extension 
Policy (NAEP-1996) through a common, 
participatory monitoring approach; aims 
to strengthen agricultural extension 
services to encourage a self-motivated 
cooperative system of production. 

Section>11,>page>14:>
A self-motivated cooperative marketing 
system is encouraged. 

Section>14,>page>16:>
Agricultural Credit Committees at union, 
upazila, district and national levels are 
to be formed with representation from 
at least one FO in each committee. These 
committees are to support farmers in 
accessing credit from krishi (agricultural) 
banks, as well as other government 
banks.

Section>19,>page>20:
Agriculture committees are to be 
formed at different administrative 
levels. One representative from an FO 
is to be included as a member in the 
agriculture committees at each level. 
These committees are to identify and 
assess agriculture-related problems 
and develop solutions in a participatory 
manner.

The goal of the NAP is to ensure 
implementation of the group 
approaches under the NAEP-1996, 
but this extension method still 
does not ensure autonomous, 
sustainable organizations. 

No initiatives by the Department of 
Agricultural Extension (DAE) have 
been taken yet to develop a self-
motivated cooperative system for 
production and marketing. 

Except for a few cases, agricultural 
credit committees are not 
functional.

Though agriculture committees 
do exist, most of them are not 
functional.

A next step could be to develop 
guidelines on how to strengthen 
the capacity of the agriculture 
extension service in order 
to support a self-motivated 
cooperative system of production 
and marketing, as referenced in 
the NAP.

National>Rural>Development>
Policy>–>2001

Implementing Agency: Department 
of Cooperatives (DoC), Local 
Government Engineering 
Department (LGED), and the 
Bangladesh Rural Development 
Board, under the Ministry of Local 
Government, Rural Development 
and Cooperatives (MoLGRD&C) and 
Bangladesh Water Development 
Board (BWDB) under the Ministry of 
Water Resources.

Section>5.8,>page>22:>>
Cooperatives>for>Rural>Development 
focuses on further activation of the 
cooperative movement by creating an 
appropriate institutional framework, 
consistent with the provisions of the 
Constitution, organizing rural capital, 
arranging for the necessary capital 
supply and taking measures for 
production, preservation, processing 
and marketing of agricultural and 
non-agricultural products through a 
demographic system. 

A Water Cell within the DoC has 
been established to develop strong 
rural institutions related to water. It 
is functioning reasonably well.

Some dairy, fish and crop 
cooperatives supported under 
this policy are also functioning 
well. Although water user groups 
(WUGs) (under LGED) and Water 
Management Associations (under 
BWDB) have been mobilized, many 
are not functioning smoothly (more 
information is provided under the 
mapping findings section). 

There is a need for further 
enforcement and concrete action 
from higher levels within the 
Government.

Cooperative>Policy>–>2011>(still>
not>approved>as>of>July>2013)

Implementing Agency: All 
departments that work with 
cooperatives will implement the 
policy according to their specific 
context and needs. The DoC will 
act as the registration authority for 
cooperatives, as well as a monitoring 
agency.

The policy has 6 core pillars:

1) federating primary farmers 
cooperatives at upazila level;

2) building a strong network of 
cooperatives from grassroots to apex 
levels, through the facilitation of 
institutional development;

3) assistance, mostly to access finance 
and marketing to autonomous 
cooperatives so they are able to compete 
in open market economy and global 
market;

4) assisting cooperatives in 
strengthening their organizational 
management;

cont./..

The policy is yet to be approved. The policy is yet to be approved. 
This could be because in order 
to implement the policy, the 
Government would need to 
provide a significant budget 
allocation to strengthen the 
National Cooperative Union, 
the Bangladesh Civil Service 
Cooperative Cadre Service.

1 The responsibility of the implementing agency is to ensure implementation of the policy. 
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Policy/>Implementing>Agency Sections>relevant>to>FOs Status>of>implementation Recommendations

5) mobilization of communities in 
economically and climatically vulnerable 
areas through forming cooperatives and 
provision of credit and inputs; and

6) information and communications 
technology, training, human resources 
development, research and evaluation.

This policy emphasizes the importance of 
value addition by farmers’ cooperatives. 
The Government will support value 
addition enterprises (by co-investing) 
if the cooperative has raised funds 
as capital stock. It proposes that the 
Government act as a guarantor for 
cooperatives looking for credit support.

New>Agricultural>Extension>
Policy>(NAEP)>–>1996

Implementing Agency: MoA

Section>2.3.6,>page>6,>Component 5:>
Working>with>groups>of>all>kinds 
– this section emphasizes that all 
extension agencies should work with 
groups of all kinds, in order to bring 
maximum benefit to farmers. It also 
states that extension workers should 
enable farmers to fully participate in the 
planning of extension programmes.

DAE, Department of Livestock 
Services (DLS), Department of 
Fisheries (DoF) and NGOs have 
largely adopted a group approach 
for extension activities: most FOs 
mapped in the report (section 
4) result from these extension 
activities; however, only DAE has an 
Extension Manual.

Representation of FOs in national 
level decision meetings related to 
extension is still not taking place 
though there are a few cases at the 
local level.

A next step could be to prepare a 
uniform extension manual that 
integrates the approaches of all 
extension agencies. In general, 
though there is greater focus on 
groups, the formation process 
is still quite supply driven and 
should become more bottom up. 

Agricultural>Extension>Manual>
–>1999

Implementing Agency: DAE

Developed on the basis of the NAEP-1996 
for extension workers in DAE, the manual 
provides limited guidance on mobilizing 
FOs and group formation mechanisms in 
Chapter 4, ‘Working with Groups.’

The manual is available in both 
Bangla and English, thus useable 
by all levels of extension staff. 
However, the manual lacks 
concrete examples of how to apply 
different concepts and is, therefore, 
not widely used by village-level 
extension staff.

There is a need for more detailed, 
illustrative guidance in the 
‘working with groups’ chapter. 
This includes more guidance 
on guiding principles for FO 
formation, strengthening, 
and accountability with the 
community. 

NAEP>–>2012>(draft>as>of>
July 2013)

Implementing Agency: MoA 

This revised version of the NAEP-
1996 has nine principles. Principle 3: 
“Targeting and mobilizing farmers’ 
groups (FGs) and their federations” 
(page v) is relevant to FOs.

Among the 24 key pillars of the NAEP-
2012, the following are relevant to FOs:

Pillar 2: Support to FGs and their 
federations.

Pillar 3: Targeting, mobilizing, capacity 
building and registration of “Farmers 
Groups.”

Pillar 4: Implementation of a market-
led, demand responsive, pluralistic, 
decentralized bottom-up extension 
system.

Pillar 5: Development and Strengthening 
of Farmers’ Information and Advisory 
Center as a “One-Stop Service Center.”

The draft version is yet to be signed 
by the Minister.

The NAEP-2012 envisages the 
federation of small farmers’ groups 
(SFGs) into a larger platform. 
However, no concrete guidance 
is provided on how to implement 
this.

Once the new policy is finalized, 
a comprehensive extension 
manual will be needed to provide 
guidance and clarity on the 
approach of group formation and 
federation.
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Policy/>Implementing>Agency Sections>relevant>to>FOs Status>of>implementation Recommendations

National>Livestock>Policy>–2007

Implementing Agency: Ministry of 
Fisheries and Livestock (MoFL)

Section>4.1,>page>6:>
Dairy>Development>and>Meat>
Production:>Cooperative dairy 
development (which follows the 
standard approach of the ‘Milk Vita 
model’ – more detail provided in 
Chapter 4) to be expanded in areas of the 
country with high production potential. 

Section>4.7,>page>27: 
Marketing>of>Livestock>Products:>
The formation of farmers’ groups and 
cooperatives is to be encouraged and 
supported for collective marketing of 
livestock products.

Milk Vita (Bangladesh Milk 
Producers Cooperative Union 
Ltd. [BMPCUL]) has significantly 
contributed to the implementation 
of this policy. From the private 
sector, BRAC Dairy, PRAN, 
Rangpur Dairy and Akij have also 
been using the group approach 
referenced under the policy. 
Despite the fact that organizations 
are forming successfully, there is 
still a large surplus of milk that 
cannot be processed. Therefore, in 
order to capture all the benefits 
of production, organizations 
need to develop value addition 
methods. Except for a few cases 
(Milk Vita and community-based 
organizations [CBOs] of the 
Regional Fisheries and Livestock 
Development Component [RFLDC]) 
no significant implementation of 
section 4.7 has been found.

The development of a module/
extension guideline delineating 
how to implement the policy 
could ensure its enforcement.

With regards to the collective 
marketing of dairy products, 
better guidance on how to handle 
surplus amounts of milk would be 
very useful. 

National>Fisheries>Policy>–>1998

Implementing Agency: MoFL

Section>9.7,>page>12:>
Fisheries>Extension>Programme:>
Assistance to be provided for the 
establishment of different organizations 
for the development of fisheries 
resources, such as fish farmers 
associations and shrimp farmers 
associations.

Section>9.12,>page>14:>
Fisheries>Co-operatives:

9.12.1: For the management of the large 
natural or artificial government khas 
water bodies that exist in rural areas, 
fishers and fish farmers to be organized 
into cooperatives to increase production 
and alleviate poverty.

9.12.2: Formation of fisheries-related 
cooperative societies to be encouraged.

9.12.3: Government khas water 
bodies to be handed over to fishermen 
cooperative societies on a long-term 
basis.

9.12.4:>Members of fisher cooperative 
societies to be trained in fish culture and 
management.

Through different projects 
fish farmers groups have been 
developed, though there are large 
doubts about their sustainability.

Leasing of open water bodies 
(haor, baor, beel, khal, river) 
is largely managed by local 
influential people, instead of the 
organizations referenced in the 
different sections of the policy. 

Guidelines delineating a 
comprehensive approach for 
sustaining fishermen groups are 
still required to guide DoF.

Monitoring is required to ensure 
that elite village members do not 
capture fishermen cooperatives.

Illiteracy problems and a lack of 
understanding of how the system 
works should be addressed to 
enable poor fisherfolk to gain 
legal registration from DoC.

Government>Jalmahal>(wetland)>
Management>Policy>–>2009

Implementing Agency: Ministry of 
Land

The policy is grounded in the concept ‘Jal 
jar Jola ta,’ namely ‘he who possesses the 
fishing net, possesses the water body.’ 
Thus the policy recognizes ownership of 
public water bodies by those who fish 
them.

In leasing wetlands to fishermen 
groups, priority should be 
given to the group living in the 
surrounding area of the water 
body. 

A monitoring system is required to 
identify hereditary fishermen and 
fishermen cooperatives.
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Policy/>Implementing>Agency Sections>relevant>to>FOs Status>of>implementation Recommendations

Guidelines>for>Participatory>
Water>Management>–>2000

Implementing Agency: Ministry of 
Water Resources

These guidelines elaborate the 
legislative framework of forming water 
management organizations, referenced 
in the National Water Policy (1999). They 
aim to avoid conflicts and duplication of 
efforts among the agencies involved in 
water management: BWDB, LGED, the 
Bangladesh Agricultural Development 
Corporation and the Barind Multipurpose 
Development Authority (BMDA) in the 
area of flood control, irrigation, drainage, 
surface/ground water management.

Only BWDB and LGED strictly follow 
these guidelines.

These guidelines place emphasis 
on large irrigation schemes but 
they could also be applied usefully 
to minor schemes under BADC 
and LGED.

Integrated>Minor>Irrigation>
Policy>(Draft)>–>2011

Implementing Agency: BADC

Section>5.21:>>
Stakeholders’>participation>in>
minor>irrigation – This section 
makes a brief reference to the need 
for the development of an instruction 
manual on the formation of WUG 
and distribution of water among the 
beneficiaries.

Still in draft form. An illustrative instruction manual 
on the formation of WUGs is very 
much needed in the field. Upazila 
Irrigation Committees could play 
a critical role in ensuring the 
effectiveness of the instruction 
manual.

Social>Forestry2>Rules>2010>
(updated>version>of>1997>rules)

Implementing Agency: Bangladesh 
Forest Department

Section>4:>>
Formation>of>Social>Forestry>Groups 
to improve and expand the forest area. 
Members of the Social Forestry Group 
are to be selected from inhabitants 
living within 1 sq. km of a selected 
social forestry area. The management 
committee of the group shall include 
a President, Secretary, Treasurer and 
two members, two of which are to be 
women.

After the introduction of the 
concept of social forestry by the 
National Forestry Policy in 1994, 
this approach has become popular. 
Therefore, the social forestry rules 
have been well received.

The rules have been well received, 
but the policy would further 
benefit from guidance on how to 
develop co-management groups. 
For the groups that do exist, 
risk for elite capture needs to be 
mitigated.

2

some of the main features of the policy framework highlighted above are as follows: (i) there is a focus 
to increase the participation of non-state actors in development activities; (ii) some of the text provides a 
sound basis for work with Fos; (iii) some of these policies are outdated and need to be updated; (iv) their 
implementation is sometimes supply driven, which is at the expense of sustainability (this could be addressed 
through better bottom up approaches); and (v) implementation could be improved if some missing elements 
were added, such as guidelines and manuals for government staff, as well as monitoring systems.

3.2 Registration of famers’ organizations

in addition to a review of relevant policies, the mapping team also reviewed the various registration options for 
Fos through different government bodies. 

though encouraged by the draft naeP-2012, registration of Fos is still a tedious procedure. this is because 
registration is  centralized, which means that approval from dhaka is required for each application. there are 
also many steps, including, in some cases, verification from national security intelligence, which makes the 
process quite lengthy. 

there are three organizations in Bangladesh responsible for the registration of organizations. different 
registration bodies handle different types of organizations, varying from cooperatives and business ventures 
to social welfare organizations. they are:

2 Social forestry refers to afforestation programmes: in marginal and degraded state and communal forest lands; village woodlots; farm forestry; strip plantations alongside railways; 
highways and embankments; ‘community plantations’ on public or communal lands with joint management (group) and benefit-sharing arrangements between the government and 
local communities.
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1. the department of social services (dss): the legal body responsible for registering non-Profit social Welfare 
organizations;

2. the office of the registrar of Joint stock companies and Firms (rJsc): the office provides two types of 
registration under the companies and societies act; and

3. the doc: gives registration to common interest groups using a cooperative model.

in addition to these agencies, the department of Youth development (dYd) also provides registration to youth 
groups, including youth farmers’ clubs. 

these registration agencies are responsible for registration and ensuring lawful administration among social, 
voluntary, or for-profit organizations. however, post-registration activities, like monitoring of activities or audit 
by these three agencies are not visible. that said, being registered with one of these three agencies provides 
an organization with legal recognition, as well as access to government assistance, such as social safety nets, 
vulnerable group feeding, tree plantation, and cash/food for work. an organization must determine which of 
the four types of registration described below best fits its nature. it was found that besides the dss, the other 
types of registration authorities emphasize the general committee as an independent decision maker over 
the executive committee. organizations registered with dss are, by and large, controlled by the government. 
thus for the purpose of developing sustainable and autonomous Fos, the society registration act (1860) 
and the cooperative society ordinance (1984) seem more appropriate, as they allow for the participation of 
members in changing the constitution, leadership or the making of any other decisions for the betterment of 
their organization.

the following table summarizes the key features of the three registration authorities, as well as their procedures:

Table>3.2   Features of registration agencies

Registration>Agencies

Features Department>of>Social>
Services>(DSS)

Office>of>the>Registrar>of>Joint>Stock>Companies>and>
Firms>(RJSC)

Department>of>
Cooperatives>(DoC)

Founding>Act Voluntary Social Organization 
(1961) 

The Society Registration Act  
(1860)

The Companies Act (1994) Cooperative Society  
Ordinance (1984)

Nature>of>organizations>
eligible>for>registration

Non-profit voluntary 
organization.

Non-profit voluntary 
organization.

For-profit organization. For-profit organization.

Documents>required>for>
registration

Constitution and Application for 
Registration.

Memorandum of Association 
and Rules & Regulations.

Memorandum of Association 
and Rules & Regulations.

• Five different notes needs 
to be submitted, regarding:
1. Share;
2. Savings;
3. Book of accounts;
4. Resolution;
5. List of board of 

directors.
• By-laws.
• Minimum share value is 

BDT 20 000 (USD 245).

Place>of>registration/
office

All districts. Dhaka, Chittagong, Rajshahi and Khulna. All districts.
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Registration>Agencies

Features Department>of>Social>
Services>(DSS)

Office>of>the>Registrar>of>Joint>Stock>Companies>and>
Firms>(RJSC)

Department>of>
Cooperatives>(DoC)

Internal>and>external>
control>measures

• Prior permission from 
DSS needed to change 
constitution.

• Government has the power 
to abolish the FO executive 
body or abolish the 
organization as a whole if the 
FO fails to fulfil requirements 
mentioned in its articles, or 
conducts unlawful activities.

• General Committee of 
the FO has the power 
to abolish the Exec. 
Committee.

• General Committee can 
amend the constitution.

• General Committee can 
propose to abolish the 
organization.

• General Committee has 
the power to amend the 
constitution. 

• General committee 
can abolish the Exec. 
Committee.

• General committee 
can also abolish the 
organization. 

• Exec. Committee formed by 
election.

• General Committee has 
the power to amend the 
constitution.

• General committee can 
abolish or change the Exec. 
Committee.

Audit • Voluntary Organization can 
audit accounts at its own 
cost.

• No need to submit audit 
report to DSS.

• Accounts to be audited by 
an established chartered 
accountant firm and 
submitted to RJSC.

• Accounts to be audited by 
an established  chartered 
accountant firm and 
submitted to RJSC.

• Audited by DoC.
• 10 percent of audited 

profits to be submitted to 
the government annually. 

Process>of>registration • Tedious steps, needs security 
clearance, less expensive.

• Tedious steps, needs 
security clearance, 
expensive.

• Tedious steps, needs 
security clearance, 
expensive.

• Comparatively easy but 
tedious .

3.3 Agricultural training institutes

a further constraint to the successful development of sustainable Fos is the limited capacity of extension 
personnel in organization formation and institutional development. a potential solution is to work with the 
agricultural training institutes (atis) throughout the country.

these institutes (of which there are 240 nationwide, including 15 run 
by the government) prepare students for a career in agricultural 
extension within the government or private sector. the Bangladesh 
technical education Board (BteB) is responsible for developing the 
curriculum of the institutes. a review of the current curriculum (found 
in annex 3) shows a lack of emphasis on skills in facilitating rural 
institutional development. at present, of a total of eight semesters 
and 153 credits, only six  credits focus on agricultural extension 
approaches (where institutional development would fit). this 
contrasts with the emphasis put by the naeP-1996 on working with 
and through Fos as the primary means for extension work. Further, 
the curriculum was found to be largely theoretical, lacking a variety 
of practical sessions that would give students hands-on experience 
in working with communities to form organizations. 

atis are also constrained by unplanned transfers of training staff, as well as a severe shortage of revenue budget 
for operations and maintenance costs. 

the condition of private atis is more problematic than that of dae atis. Most of the private ati focus more 
on their students’ obtaining a diploma certificate than on the skills and knowledge needed for effective 
employment. Private atis are for-profit organizations, and suffer from insufficient quality standard control by 
the BteB.

List>of>govt.>ATIs>in>Bangladesh

Sl # Govt. ATIs District
1 ATI, Bangla Bazar Gaibandha
2 ATI, Sher-e-Bangla Nagar Dhaka
3 ATI, Tajhat Rangpur
4 ATI, Gridhanarayanpur Sherpur
5 ATI, Isurdi Pabna
6 ATI, Begumganj Noakhali
7 ATI, Gongabordi Faridpur
8 ATI, Shimultoli Gazipur
9 ATI, Doulatpur Khulna
10 ATI, Rahmatpur Barisal
11 ATI, Khadimnagar Sylhet
12 ATI, Rangamati Rangamati
13 ATI, Hathazari Chittagong
14 ATI, Homna Comilla
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3.4 Potential way forward

in order for interventions at the enabling environment level to be effective, a key principle must be remembered: 
extension support should empower farmers and give them a voice and a role in their own development. there 
are indeed several government policies that give support for Fos, though their implementation is generally 
weak. as such, farmers remain relatively unorganized and unable to participate in investment programming 
and decision making platforms of government agencies. to improve the situation, there is a need for specific 
points in the government investment planning and programming cycle when Fos are consulted. to make this 
consultation meaningful, relevant information should be provided to Fos in advance and their proposals must 
be formally considered and reflected. an even better solution would be to have Fo representatives participate 
in regular planning processes as partners with the government. this would ensure that prioritization of public 
investment reflects the opportunities and challenges of (small) producers.

3.4.1 Coordinated agricultural extension

empowerment of farmers must be a unifying principle of agricultural extension. a unified approach to group 
formation by government extension agencies would facilitate this by supporting the development of strong, 
well-organized, federated Fos. Further, there is a need for better coordination of extension services provided 
by the different public, private and civil society agencies. these need to be harmonized at regional and national 
levels to avoid duplication of efforts and to facilitate scaling up of successful approaches.

a unified extension manual for government extension agencies, which incorporates all of the policies 
mentioned above and reduces discrepancies in approach, would very much serve this purpose of coordination. 
at present, the absence of this type of manual results in the extension agencies (dae, doF, dls and ngos) 
mobilizing farmers into groups in an uncoordinated manner. 

the agricultural extension Manual (January 1999, revision) developed by dae based on the naeP-1996, is 
a good basis for this as it is comprehensive. however, it was designed for higher-level extension personnel 
of dae, not for sub-assistant agriculture officers (saaos) or field level extension agents. Moreover, little is 
mentioned about the processes of farmers’ group formation in this manual. such guidance might include how 
to address governance and legitimacy issues, targeting clusters/villages and individual beneficiaries, formation 
of Fos, graduation of Fos from primary to federated bodies, registration processes, developing committees 
and sub-committees, developing memoranda of articles, business skills (savings, credit, and business services 
centers) and conflict resolution. the manual should include all of this information in an illustrative manner.

3.4.2 Capacity development of extension agents

current analysis of atis is based on an initial review of the BteB-issued curriculum. More detailed 
understanding  should be developed through focus group discussions with students, trainers and ati 
management, as well as a more thorough review of the curriculum and the internship experience. the 
review process will lead to more concrete recommendations, which would be discussed with dae and other 
government extension departments, as well as BteB.

the goal is to place more emphasis on community mobilization and organizational development. specifically, 
more instruction would be provided with regards to targeting, participatory identification of the poor, 
visioning, mission development, membership empowerment and the development of organizational values. 
additionally, improvements would be made to the six-month internship at the end of the four-year course, so 
that all graduates are truly ready for hands on work upon graduation. Further, discussion with dae indicated 
the need to expand instruction on information and communications technology (ict) tools for extension.

in addition to strengthening the capacities of future extension agents, there is also a broader need to develop 
the institutional capacity of the current government extension staff in community mobilization. this can be 
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done through a combination of training and exposure visits and exchanges with facilitators of successful 
community mobilization projects from different institutions as well as engaging directly with successful Fos.

this capacity development of extension agents would pave the way for a shift in mindset from organizing 
farmers into groups as a tool for distribution of inputs to seeing Fos as true partners in extension. in partnership 
with extension agents, Fos could become one-stop service centres for the farming community – where services 
such as information and advisory services, input bulk purchasing, bulk selling, farm machinery rental services 
and savings and credit would be provided.

3.4.3  Streamlined Registration Process

a further challenge to address is the tedious and time-consuming registration process. Fos face many barriers 
in this process. dialogue with key stakeholders is required in order to address the main problems.

3.4.4  FAO support to modernization of extension through its  
Country Programming Framework

Fao’s 2013-14 country Programming Framework, currently a final draft for consultation, includes the 
modernization of extension as one of its five strategic priorities for Bangladesh. through the Framework, 
Fao plans to provide broader support to coordinated agricultural extension and the capacity development 
of extension agents in addition to the work under the iaPP ta. Within this, a major study on extension 
modernization will be conducted that will deepen and broaden the analysis of the issues mentioned herein.



Farmers’ organizations 
are still largely considered 
‘beneficiaries’ of project and 
programme activities. they 
are still not really seen as true 
partners in the development 
and implementation of 
investment programmes.
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Mapping f indings 4
4.1 Summary

a wide range of Fos is covered here, ranging from temporary groups to longstanding organizations. the team 
found a total of 198 114 FOs throughout different regions of Bangladesh.

Most of the Fos are very small (around 25-50 members) and are at the community level. there are few 
organizations at the district and regional levels and very few at the national level. the majority of Fos were 
formed with support from (and most are still facilitated by) projects of different extension agencies of the 
government, or of national or international ngos. the organizations have been created, in most cases, as a 
channel for the delivery of project activities, services and goods, rather than as sustainable rural institutions. 
these project-based Fos tend to lack plans for sustainability after the withdrawal of project assistance. as such, 
their sustainability is questionable.

that said, some projects and organizations have begun federating small organizations into larger local (up to 
upazila and district) fora, and some at even higher levels, which gives some hope for sustainability. however 
their coverage and impact are still rather limited. of the 198 114 Fos, the team found 4 144 (2 percent) that are 
federated at some level (union, upazila, district, nationally). there were few organizations found that are truly 
autonomous, though some examples are provided.

approaches to forming Fos vary greatly across projects, as needs of farmers vary. this diversity of approaches 
is not necessarily problematic, however, there is a lack of key factors for the success of any organization. these 
key factors are: (i) autonomy; (ii) inclusive leadership; (iii) a strong membership base; (iv) needs-based service 
provision; and (v) a clear, ‘owned’ purpose. 

the Fos found also have a variety of purposes for organizing. there are commodity-based organizations, 
advocacy-based organizations, multi-purpose organizations and others. as mentioned earlier, data for full 
analysis based on organizational purpose is not available, however it is important to recognize that the Fos 
herein have a variety of mandates, and therefore require a variety of capacity development interventions. 
What is common to all, though, is the benefit to farmers of being organized, and the opportunity it creates for 
strengthening farmers’ voices in development.

Perhaps the most important finding, though, is that Fos are still largely considered ‘beneficiaries’ of project and 
programme activities. they are still not really seen as true partners in the development and implementation of 
investment programmes. 

a large amount of information on these various Fos was collected during this exercise. salient points are 
provided in this chapter, with further detail, including information on related projects and geographical 
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distribution, provided in annexes 4-7. different organizations were able to provide more and less information 
based on their own internal data collection techniques. this is reflected in the varying levels of detail provided 
in this report.  

4.2 Typology

this report divides Fos into 4 categories according to their origin, in order to have a simple, clear typology on 
which to base analysis:

(vi)> autonomously formed Fos;

(vii)> Fos formed with support from government extension agencies;

(viii)> Fos formed with support from international ngos; and

(ix)> Fos formed with support from national ngos.

4.2.1 Autonomously-formed farmers’ organizations

this type of organization is formed through the initiative of farmers themselves. their aim is to defend farmers’ 
interests and solve problems themselves. the mapping found 12 organizations that were formed autonomously 
(with some receiving support at a later stage) and are registered with various government agencies. however, 
although they are registered, the information available on these organizations was rather limited. 

Table>4.1   Autonomously- formed FOs 3 4

Sl>no. Name>of>FO Region>covered No.>of>members> Federated> Remarks>

1 Adarsha Chashi Unnayan Samity Charfasson 700 -

2 Andulbaria Multipurpose Vegetables Seed production Cooperative 
Society Ltd JIbon Nagar, Chuadanga 150 -

3 Bangladesh Farmers Marketing Group Association 4 districts of North Bengal 
and Gabtoli, Dhaka 105 1

4 Chimbuk Falchashi Bahumukhi Samabay Samity Ltd. (Chimbuk 
Fruit-Farmers Multipurpose Cooperative Association Ltd.) Chimbuk, Bandarban 50 -

5 Fishery Natun Para Shutki Babosayee Kalyan Samity (Dry Fish 
Producers Association) Nazirertek, Cox’s Bazar 111 -

6 Gadkhali Phulchashi o Phul Babshayi Kallyan Samity (Gadkhali 
Flower-Farmers & Traders Welfare Association) Gadkhali, Jessore 144 -

7 Idilpur Anarosh Chashi Bahumukhi Samobay Samity Ltd. (Pineapple 
Producers Association) Madhupur, Tangail 250 - Gold medal3

8 Kuralganchi Adarsha Samobay Samity Chuadanga - Gold medal

9 Nabogonga Water Management Association Chuadanga 250 - Gold medal

10 RidoyeMati O Manush Krishak Samobay Samity Ishurdi, Pabna 1,000 - 4 ideal 
farmers4

11
Savar Kumar Khoda Phulchashi Bahumukhi Samabay Samity Ltd. 
(Savar Kumar Khoda Flower-farmers Multipurpose Cooperative 
Association Ltd.)

Savar 92 -

12 Shurjamukhi Mahila Samity (Sunflower Women Association) Laimipara, Bandarban 54 -

3 This is a form of recognition from the DoC, which is given to organizations that have strong governance and performance.
4 Annually, DAE awards several farmers with the title ‘ideal farmer’ to recognize their contribution to agriculture.
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4.2.2 Farmers’ organizations formed with support from Government extension agencies

as a means to transfer technology and services, the government plays an important role in forming this 
type of Fo through their extension agencies. the team found 160 348 Fos formed with support from seven 
government extension agencies, departments and organizations. Members of these Fos work in the crop, 
livestock and/or fisheries sectors. some organizations focus on one specific thematic area (i.e. crop), whereas 
others are a blend of different themes, and others address broader issues such as overall village development.

to understand Fos formed with support from government extension agencies, one must understand how 
the government extension system works. different agencies and departments have different approaches to 
facilitating Fos (for example, the social development Foundation spends a significant amount of time on the 
process of institutional development, while other agencies, such as dae or dls focus more on the distribution 
of inputs through groups). this stems from the fact that agencies and departments depend quite heavily on 
project funding for their operations. as such, they implement a multitude of government and donor-funded 
projects, and each project requires a different approach. additionally, there are cases in which different 
agencies implement different components of a single project. this leads to instances in which one project 
will have differences in the Fo facilitation approach. this is due to the lack of integration of the agencies and 
departments involved.

some Fos are founded through shorter-term projects, and others through longer-term programmes. this 
explains some of the lack of consistency in how information on different Fos is presented herewith. Finally, the 
general finding is that Fos linked to government extension agencies are still not close to full autonomy and 
sustainability. For the most part (though there are some important exceptions), the organizations exist for the 
lifetime of the respective project, but are discontinued thereafter. this is due to the fact that, as mentioned 
above, the extension approach is generally focused more on forming groups in order to distribute project 
benefits and less on the development of strong, sustainable, internally motivated institutions.

Table>4.2   FOs formed with support from Government extension agencies

SI>
no.

Name>of>
Gov.>agency Name>of>FO Name>of>project Funded>by Regions>covered No.>of>FOs Federated

1
BADC

Livelihood field 
school (LFS) IAPP (WUG) GAFSP North and south 230 -

WUG Completed projects & core Multi All over Bangladesh 17,843 -

Sub-total 18,073

2 DAE

Climate Field 
School  (CFS)

Disaster and Climate 
Risk Management in 
Agriculture Project 
(DCRMA)

Multi donor 5 regions 156 -

Common interest 
group (CIG)

National Agricultural 
Technology Project (NATP)

IDA, International 
Fund for Agricultural 
Development (IFAD)

25 districts 13,450
UPO-1,345
UzPO-120

Integrated crop 
management (ICM) 
Club

Agricultural Extension 
Component (AEC)

Danish International 
Development Agency 
(DANIDA)

All over Bangladesh 16,438 UNFA-1,087

LFS IAPP (DAE &BADC seed) GAFSP North and South 375 -

SFGs
North-west Crop 
Diversification Project 
(NCDP)

Asian Development 
Bank (ADB)

16 districts of 
North-west 12,480 FMG-490

SFGs
Second Crop 
Diversification Project 
(SCDP)

ADB North and South 866 -

Sub-total 43,765

3 DoC Cooperative 
Association

Legal entity and 
development projects - All over Bangladesh 83,853 100

4
DoF

CIG NATP IDA 25 districts 2,670
UPO-1,345
UzPO-120

LFS IAPP GAFSP North and south 850 -

Sub-total 87,373
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5
DLS

CBO RFLDC-Noakhali DANIDA Greater Noakhali 172 CBO 
Association-4

CBO RFLDC-Barisal DANIDA Greater Barisal 296 CBO 
Association-5

CIG NATP IDA 25 districts 3,921
UPO-1,345

UzPO-120

Livestock Rearers 
Group IAPP GAFSP North and South 1,214 -

Sub-total 5,603

6 Rural Division, 
MoLGRD&C

Village Savings and 
Loan Group

Chars Livelihoods 
Programme (CLP)

Department for 
International 
Development (UK)

Jamuna Chars
2,272

(CLP I- 1,712
CLPII – 560)

-

7
Social 
Development 
Fund (SDF)

Gram Parishad
Social Investment 
Program Project (SIPP) 
1 and 2

World Bank Northern and 
southern regions 3,262 Not yet

Total:>FOs>formed>with>support>from>Government>departments 160,348 3,151

4.2.3 Farmers’ organizations formed with support from international non-governmental 
organizations

though there are many international ngos working in Bangladesh, the mapping team found only six that work 
with Fos. the respective Fos are mobilized under a variety of foreign-funded projects, directly implemented 
by international ngos, sometimes in collaboration with government agencies. Fos here are from the crop, 
livestock, fisheries and agro-forestry sub-sectors. all of the international ngos mentioned herein take an 
approach towards Fo mobilization that includes federation. this support for federation has resulted in Fos 
with better prospects for sustainability and autonomy in the future.

Table>4.3   FOs formed with support from international NGOs

Sl>
no.

Name>of>
agency Name>of>FO Name>of>project Funded>by Region>covered No.>of>FOs Federated>

1 Action Aid 
Kendrio

Krishok Moitree (KKM)

Capacity building of 
KKM Agricord/AFA Southern and northern 

region 252 9

2 CARE Village Development 
Committee FSUP-HP* European 

Commission (EC) Haor regions 645 Federation to 
come after 2014

3 HSI National Nursery Society
Agro-Forestry 
Improvement Project 
(AFIP)

Swiss Agency for 
Development 
and Cooperation 
(SDC)

All over Bangladesh 62 1

Service Provider Association SAMRIDDHI SDC Northern and Haor 4,831 58

4 iDE Farmers Association ISEM, EIDSP, MIDPCR, 
IMPACT** IFAD Mostly in northern and 

southern districts N/A*** 55

5 Save the 
Children Various Nabo Jiban

United States 
Agency for 
International 
Development

Southern region 3,860 -

6 World 
Vision

Development Group (DG) 
as primary and CBO as 
federated

Area Development 
Programme (ADP) multi 72 upazila 509

Total:>FOs>formed>with>support>from>projects>of>international>NGOs 4,819 632

* Food security for ultra-Poor in the haor region.

** integrating smallholders into expanding Markets; enhancing the impacts of decentralized seed Production; Market infrastructure 
development Project in charland regions; improving Markets and Poverty alleviation through cash transfer.

***note: although it provides backstopping support for market development to more than 6 000 farmers’ groups, ide itself has only 
formed and mobilized 42 collection Point Market centres (cPMcs) and 13 farmers’ associations, totalling 55 farmers’ associations in 
different regions.
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4.2.4 Farmers’ organizations formed with support from national non-governmental 
organizations

Many national ngos that work with rural people in Bangladesh focus almost exclusively on forming groups 
in order to disburse microfinance. the largest of these ngos are asa, Brac, grameen Bank and thengamara 
Mahila sabuj sangha (tMss). Members of these groups may indeed be farmers, however the focus of the 
group is predominantly to deliver and collect micro credit, and not to develop Fos that are viable, long-term 
sustainable institutions. as such, in-depth analysis of these groups has not taken place as a part of this exercise. 
however, a short summary of their work is provided later in the report.

this section does not cover the activities of national ngos sub-contracted by government agencies under the 
projects already described above (such as Brac’s contribution to the scdP), though their contribution in this 
regard should be recognized. 

With both of the aforementioned categories not included in this section, the mapping only found the following 
three organizations to fit the criteria of Fo under this mapping. 

Table>4.4   Farmers’ organizations formed with support from national NGOs

Sl>no. Name>of>NGO Name>of>FO Name>of>project Funded>by Region>covered No.>of>
FOs Federated>

1 BRAC Village 
Organization (VO)

Tenant Farmer 
Development Project Bangladesh Bank 210 upazilas of 46 

district 15,162 -

2
Christian Commission 
for Development in 
Bangladesh (CCDB)

People’s 
Institution (PI) Various World Church 15 districts 838 -

3 Rangpur Dinajpur Rural 
Services (RDRS) Union Federation Various

EC, Finland Church Aid, 
Denmark Church Aid, 
Church of Sweden, 
Netherlands Church Aid.

Northern region 12,104 361

Total:>FOs>formed>with>support>from>national>NGOs 28,104 361

4.3 Autonomously-formed farmers’ organizations

4.3.1  Adarsha Chashi Unnayan Samity

in 2004, hellen Keller international (hKi) provided support in vegetable production to Md. solaiman and 
neighbor farmers in charfasson upazila of Bhola district. although yields did increase as a result, farmers were 
unable to reap the benefits at the market because of a lack of bargaining power. shortly thereafter, in 2005, 
in a discussion with a trader at the local market, Mr. solaiman came to understand the importance of bulking 
produce in order to access markets. he asked the trader whether, if he and neighbor farmers bulked their 
produce, they would be able to market it to the trader directly. the trader replied positively. Mr. solaiman and 
his neighbor farmers encouraged other farmers to join them in forming a group so that they could bulk their 
produce and market it successfully to meet local demand.

When purchasing inputs for vegetable production and marketing, the shopkeeper informed the group that 
if they bought large quantities, they could receive a lower wholesale price. they shared this information with 
other farmers who needed the inputs. this experience in bulk purchasing demonstrated the power of being 
organized. it inspired the farmers to create a formal fund to be used to buy common inputs. 

this was the beginning of adarsha chashi unnyan samity (Model Farmers development organization), 
officially formed in 2006. initially they had 101 members from the capital of the upazila and outskirts. now the 
organization has expanded to include all the unions of the upazila. Membership has increased to 1 450. 
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Service provision

Following a negative experience with a seed dealer, the Fo members asked themselves why they could not start 
their own business that supplied necessary farm inputs like seeds, fertilizers, and pesticides. the organization 
began collecting shares of Bdt 1 000 per farmer, and rented a shop at the local market. this venture opened a 
new horizon for the Fo and gave it another opportunity to serve its members. “For organizational sustainability 
we have to make a marginal profit from this venture but our purpose is to ensure that quality seeds, fertilizers 
and other inputs are available at our member farmers’ doorsteps,” shared Mr. solaiman, now the secretary of 
the Fo. 

Partnership

in 2011, recognizing adarsha chashi unnayan samity as a viable entry point for credit provision, the ngo asa 
extended its credit support to members of the organization. Following this positive experience, the united 
leasing and Finance company has used the organization as an entry point to provide loans to the vegetable 
farmers, as the organization has a good track record of credit recovery. international development enterprises 
(ide) often arranges farmers’ visits to the samity and invites lead farmers from the organization to train other 
farmers. the organization now has 17 urea super granule units. the organization acquired these with the 
assistance of the international Fertilizer development corporation. the organization paid five percent and the 
corporation covered the balance.

the adarsha chashi unnyan samity now has a very strong reputation in charfasson and the surrounding 
areas. as a spillover effect of the members’ success, many more farmers in the area are engaged in vegetable 
production. this is evidenced by the 14 000 ha of land that are now being used for vegetable production. large 
quantities of cucumber, bitter gourd and watermelons are now sold to other districts. about 25 percent of 
these producers belong to the organization.  

4.3.2  Andulbaria Multipurpose Vegetables Seed Production Cooperative Society Ltd.

andulbaria union in Jibon nagar upazila in chuadanga district is well known for vegetable seed production. 
But, as is the case with many remote areas, seed growers were not able to market their products successfully. 
this was the result of a lack of access to technologies for sorting, grading, packaging and storing of seeds. 
to resolve this problem, some advanced seed growers decided to establish a common facility centre that 
would provide services to seed growers in the area. thus the ‘andulbaria Vegetable seed Production society’ 
was formed to develop and manage this operation. in 1990, when the organization formally registered with 
the doc, it took its current name, the ‘andulbaria Multipurpose Vegetables seed Production cooperative  
society ltd.’

at the time of the society’s formation, Fao was implementing the ‘strengthening of the national Vegetable 
seed Programme,’ which worked in four vegetable seed clusters in Bangladesh. the programme installed a 
grader machine for vegetable seed cleaning and grading in Jibon nagar upazila of chuadanga district. the 
machine was installed at the organization’s facility. in 1991-92, when the machine was installed, the volume of 
business was Bdt 800 000 per year. today, business is at Bdt 6 000 000 annually.

Organizational structure

the society has 150 members (with an 11 person executive committee), who are contract growers for different 
vegetables. they farm approximately 1 500 acres of land. society members produce a large variety of vegetable 
seeds and bring seeds to the society’s facility, which sorts, grades and cleans them for a nominal charge of 
Bdt 2 per kg of seeds. 

Partnership 

once the seeds have been sorted, graded and cleaned, members are then able to sell their seeds, through the 
society, to more than 10 seed company partners. these include a r Malik seed co. ltd., sreemangal seed house, 
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rajdhani seed co. ltd., united Masud seed co. ltd., shomrat, nadim, Kamal, chittagong seeds, Kashem seed 
co. ltd., and sultan seeds, Mollica. at the beginning of the season, these private companies distribute source 
seeds to the society. the society then distributes these source seeds to its members. Members in turn use the 
source seeds to grow vegetable seeds for sale back to the private companies at a fair price. this arrangement 
benefits the members because they enjoy quality source seeds and fair prices for their product. 

4.3.3  Bangladesh Farmers’ Marketing Group Association (BFMGA)

three years after the completion of the ncdP, several farmer leaders who participated in the project decided 
to develop a network among 75 active, semi-active and dismantled farmers’ marketing groups (FMgs) that 
were formed under the project. one of the major objectives of this networking and coordination was to ensure 
marketing of high value vegetables and fruits at the central market of gabtoli, dhaka. there is still an unmet 
demand for high value fruits and vegetables in dhaka, and this network aims to meet it.

the strategy adopted by the network is to register the interested FMgs as primary cooperatives and then to 
federate them into a central cooperative, the BFMga. this process of networking and federating is ongoing. as 
of april 2013, BFMga had submitted registration documents of 16 FMgs to the doc. 

4.3.4  Chimbuk Falchashi Bahumukhi Samabay Samity Ltd. (Chimbuk Fruit-Farmers 
Multipurpose Cooperative Association Ltd.)

understanding the damage done by the standard slash and burn (zhoom) cultivation techniques commonly 
used in the chittagong hill tracts (cht), Mro5 inhabitants of the chimbuk hill of Bandarban (one of the poorest 
districts of the cht), began to plant fruit6 orchards to reduce dependency on zhoom techniques. after their 
initial experience with fruit production, the Mro farmers realized that they could not earn a profit if they sold 
their fruit individually. Mr. toyo Mro, one of the farmers from the area, mobilized the indigenous Mro fruit 
farmers in chimbuk to form a cooperative. they received registration from the doc on 14 september 2008 as 
‘chimbuk Falchashi Bahumukhi samabay samity ltd.’ 

the organization now has 50 members and an executive committee of nine members, including two 
Mro women. important accomplishments of this organization include: (i) lobbying with the regional hill  
development board to declare the zone as a ‘fruit producing zone’; and (ii) creating direct market linkages  
with chittagong-based wholesalers, which facilitate members receiving a fair price for their products.

4.3.5  Gadkhali Phulchashi o Phul Babshayi Kallyan Samity (Gadkhali Flower-Farmers & 
Traders Welfare Association)

this association, Bangladesh’s first flower farmer association, was established in 2003 and is led by Mr. sher 
ali. Mr. ali himself introduced commercial flower 7 cultivation to Bangladesh following an inspired visit to 
indian flower clusters. Flower cultivation was first introduced in gadkhali village of Jhikargancha upazila in 
Jessore district in the mid-1980s. since then, the crops have been disseminated to neighboring upazilas and 
districts, making the area the largest cluster of flower production in the country. With quickly increasing levels 
of production, flower farmers faced price distortion at the market owing to poor post-harvest processing and 
transportation. in order to advocate on behalf of the flowers farmers and traders to the government, Mr. ali 
along with other farmers established the gadkhali Flower-Farmers & traders Welfare association. at present 
the association has 144 members with an executive committee consisting of nine members, and is registered 
with the doc. the milestone achievement of this association was to convince the government to establish a 
market in gadkhali. around 30 000 flower-farmers of Jessore region are now associated with this market.

5  Mro is an ethnic community from the Chittagong Hill Tracts.
6  The main fruits are papaya (red lady), mango (ranguai) and pineapple (honey queen).
7  Commercial flowers include marigold, rose, tube-rose, gladiolus, zarbera. 
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4.3.6  Idilpur Pineapple Growers Cooperative Ltd.

Mr. Jevier chishim introduced pineapple production to idilpur in 1942. a series of difficulties in accessing 
markets and finance followed its introduction to the area. in the mid-1970s this led Mr. chishim and some 
progressive pineapple farmers from idilpur to come up with an alternative way for pineapple producers to 
access finance. informally they formed a group of 20 pineapple producers and collected monthly savings of 
Bdt 20, and then distributed loans to group members using this money. the group finally took a more formal 
shape on 13 June 1977 as the ‘idilpur Pineapple growers cooperative ltd.’

Advocacy

around this time, the cooperative applied for a loan from the bank but was refused, as pineapple production 
was not included in the bank’s agricultural loan program. the cooperative leaders then lobbied the government 
to be eligible for agricultural loans from commercial banks. during 1978, in a local conference, the then 
President of Bangladesh learned about pineapple producers’ problems in Madhupur from the leaders of idilpur 
Pineapple growers cooperatives. the President then advised sonali Bank to disburse loans to the pineapple 
producers imposing a nominal interest, with a grace period until harvesting to repay the loan. the producers 
then took loans from sonali Bank, with the cooperative as a guarantor. the process continues to this day even 
for producers outside of the idilpur cooperative. 

Growth and service provision

inspired by this positive experience, the cooperative expanded their activities beyond loan provision. 
Membership increased from 20 to 136. twenty of these members are from the garo community, including 
seven female members. in addition to support for access to finance, the cooperative helps its members to 
better market their produce. they also promoted chemical-free ‘safe’ pineapple production in Madhupur. they 
linked the producers of ‘safe’ pineapple with corporate buyers like aftab and Bd Foods, with assistance from 
the agribusiness development Project of adB.

Performance

the cooperative now has 8.17 acres of land, which have been leased to members. some funds have been raised 
in this leasing process. the cooperative has been audited by the doc every year and during these audits it 
was found that profits were distributed transparently. owing to its sincere devotion to members, the idilpur 
cooperative has been awarded the gold medal8 from the doc three times.

4.3.7  Savar Kumar Khoda Phulchashi Bahumukhi Samabay Samity Ltd. (Savar Kumar Khoda 
Flower-farmers Multipurpose Cooperative Association Ltd.)

this organization was launched on 8 april 2010 by Mr. ansar Mollah along with five other farmers. it is registered 
with the doc. its primary goal is to solve problems of seed (tuber) production, post-harvest handling and 
marketing faced by flower producers and traders in savar. the organization has an executive committee with 
six members. they are elected by 92 general members. the organization provides the following services to 
its members: (i) capacity development of flower farmers and traders (members only) on modern technologies 
of different flower production, pest management, post-harvest management, preservation of flowers, 
transportation and marketing; and (ii) advocacy to the government to allocate space in wholesale markets 
(Khamarbari and shahbag) in dhaka for members of this organization. 

4.3.8  Shurjamukhi Mahila Samity (Sunflower Women Association)

this association was established in 1998 after receiving its license from the department of Women affairs. the 
association has 54 indigenous Bawm female farmers. they are associated with the mango orchard in laimipara 
of Bandarban sadar upazila. Prior to joining together, association members faced constraints with mango 
cultivation, processing, marketing and financing. in response, they united under a common platform and 

8  This is a form of recognition from the DoC, which is given to organizations that have strong governance and performance.
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formed ‘shurjamukhi Mahila samity.’ the organization provides the following support to its members: (i) credit 
facilitation for female farmers; (ii) networking with government and international organizations; (iii) training on 
fruit processing and marketing in the local tourist market; and (iv) development of linkages with chittagong-
based wholesalers.

4.4 Farmers’ organizations formed with support from Government  
extension agencies

4.4.1  Bangladesh Agricultural Development Corporation

4.4.1.1 Water User Groups under the Bangladesh Agricultural Development Corporation

Wugs are formed under Badc. the groups then draft proposals for deep tube well or low lift pump schemes. 
the upazila irrigation committee then reviews these proposals to ensure viability. once approved, the proposal 
is submitted to Badc itself. then Badc installs the equipment, and the Wug is thereafter responsible for its 
management.

Badc reports that though there is a Wug associated with each irrigation scheme, there is no database of 
Wugs. Badc estimates to have 17 843 irrigation schemes, therefore, we can assume that the number of Wugs 
is similar. Most of the Wugs are informal, having no legal recognition from any government entity. each Wug 
has a manager, generally elected by the user farmers of the area. it is the manager who collects fees from 
group members – totaling Bdt 30 000 for an electricity connection and irrigation canal costs (see table a5.3 in 
annex 5). the manager often bears most of the burden in collecting participation fees, getting the electricity 
connection and developing irrigation canals. 

Performance and sustainability
cases of mismanagement and elite capture of Wugs have been reported. this generally occurs when managers 
have an influential background. often they create an arbitrary list of water user farmers, while they invest the 
initial participation fee from their own pocket, and thus claim the project as their own. the recovery rates of 
the yearly rent due to Badc of each irrigation scheme (Bdt 15 000) are also poor owing to capture of funds by 
managers of Wugs, as noticed by agricultural engineers working with Badc. Member farmers of Wugs have 
shown  keen interest to be associated with Wugs, but malpractice by the manager of the scheme often stops 
members’ participation in the regular operation and maintenance of units.9 Malpractice includes grabbing the 
whole unit as the manager’s own investment, and imposing higher irrigation charges (Bdt 1 500 / 33 decimals10/ 
season against standard Bdt 800 / 33 decimals / season), but showing a loss by the project. this occurs because 
of Badc’s institutional weaknesses, lack of manpower, and lack of policy enforcement in forming Wugs. 

even the groups that do not suffer elite capture still face challenges regarding sustainability. as operation and 
maintenance costs for the irrigation schemes are covered by projects and not by the Wugs themselves, once 
the project ends, the Wugs are not prepared to be in a position to repair the equipment when needed. thus, 
when the equipment no longer functions, the groups dissolve.

4.4.2 Department of Agricultural Extension

4.4.2.1  Climate Field Schools (CFSs) under the Disaster and Climate Risk Management in  
Agriculture Project

the dcrMa approach is to work with already formed icM or integrated pest management (iPM) clubs (formed 
under the aec of danida’s agriculture sector Programme support [asPs]). the project brings together three of 
these clubs and forms a cFs. there are 156 cFss in 52 upazilas (annex 5: a5.5 to a5.9). these cFss are mobilized 

9 Reported by farmers within a low lift pump scheme in Agailjhara Upazila, Barisal.
10  Unit of measurement used in Bangladesh equal to approximately 40.46 m2.
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with the aim to: (i) organize farmers affected by climate change risks; (ii) adapt and disseminate mechanisms  
to mitigate diverse risks; and (iii) manage the implementation of demonstrations of climate-friendly 
technological innovations.

Performance and sustainability
although the project adopts a unique approach to mitigate climate change risk in the crop sub-sector through 
the cFs, the scope for developing strong village-level institutions is rather limited. this is the result of a lack of 
capacity development activities and handholding on participatory visioning towards a sustainable Fo. 

4.4.2.2  Common Interest Groups, Union Producer Organizations (UPOs) and Upazila Producer 
Organizations (UzPOs) under the National Agricultural Technology Project: Phase I- DAE 
Component

the natP Phase 1-dae component covers 120 upazilas under 25 districts. dae staff has mobilized 13 450 crop-
based cigs, including 4 035 only-female cigs (annex 5: a5.10 and a5.11). there are different types of cigs under 
the natP – some linked to dae, some to dls and some to doF. 

cigs under the dae component are made up of small and marginal farmers of the crop sub-sector. each cig 
consists of 20-30 members, of which 30 percent must be women and 70 percent must be small or marginal 
farmers or sharecroppers. the general body of the cig elects a President, secretary and treasurer. cigs are 
mobilized at the village level with the responsibilities of: (i) disseminating information among members; 
(ii) managing the implementation of demonstrations; (iii) coordinating natP activities among members, such 
as input distribution or marketing of produce; and (iv) developing the group’s micro-extension plan.

cig farmers are vulnerable to market risks and exploitation as a result of a lack of access to market information 
and market linkages – problems that cannot be solved exclusively at the local level. as such, the natP has a 
provision to vertically integrate village level cigs into uPos, and further into uzPos. Producers’ organizations at 
these two tiers have different responsibilities; among them: (i) increasing productivity and production through 
the application of agricultural technology from the national agricultural research system (nars); (ii) ensuring 
increased profit through quality production and market linkages; (iii) obtaining quality inputs at a competitive 
price; (iv) increasing the bargaining power of producers; (v) protecting farmers from exploitation by middle 
men; (vi) providing guidance on innovative approaches and ways to diversify production; (vii) risk reduction 
and mitigation by advising less risky agricultural practices; and (viii) social support. the uPos and uzPos are 
formed from crop based cigs, livestock cigs and fishers cigs.

Performance
in an internal evaluation, the dae project implementation unit assessed that, of the total cigs, 2 percent were 
graded as ‘very good’ (a); 29  percent as ‘good’ (B); 63  percent as ‘average/moderate’ (c); and 6  percent as 
‘poor’ (d). the extension component needs to further mobilize and strengthen the lowest 69 percent of cigs 
to improve their performance and upgrade them to ‘good’ (annual report, Public coordination unit, natP, 
March 2012).

the natP annual report (2010-11) stated that the experience of forming cigs by extension personnel has 
developed the institutional capacity of extension agencies in group formation and mobilization. the cigs 
themselves have developed their capacities in micro plan preparation on crop production.  this has resulted 
in active partnership between groups and extension agents, as well as a stronger feeling of ownership within 
groups, facilitating sustainability of the groups and their activities.

4.4.2.3  Integrated Crop Management Clubs and Union Farmers’ Associations (UNFAs) under the 
Agricultural Extension Component of DANIDA’s Agriculture Sector Programme Support

dae, along with the Bangladesh agricultural research institute, the seed Wing of the Moa and the agricultural 
information service, have established Farmers Field schools (FFss) in 335 upazilas of 64 districts in Bangladesh.
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the FFs provides season-long demand-driven ‘hand holding’ training to a group of male and female farmers at 
field level. a FFs ‘batch’ consists of 50 farmers, 50 percent of whom are female. the FFs batch receives season-
long training (20 sessions). each session lasts 4-5 hours and is made up of theoretical and practical lessons. 
the importance of farmers’ group formation is integrated in the FFs curriculum and capacity building on 
institutional development starts early in the FFs sessions.

after completion of the season-long training, the FFs graduates form icM clubs, as a way to stay connected 
after the FFs and to implement activities using their new knowledge. so far, over 16 438 iPM/icM11 clubs have 
been formed throughout the country (annex 5: a5.12 to a5.15). 

Federation
in unions that have at least three icM clubs, the aec facilitates the formation of unFas. the objective of the 
unFas is to continue activities generated by the FFs process, to build local institutions for FFs implementation, 
to strengthen marketing activities, and to benefit from becoming a larger voice in articulating farmers’ 
demands.

the process of federating village and block level icM clubs into unFas began in early 2011. as of october 
2012, the aec had formed 1 087 unFas in 146 upazilas of 57 districts. it is expected that in the near future 
these unFas will form a larger Fo, which will advocate for its members on production, agricultural policy and 
marketing issues.

Performance
despite the fact that the icM approach has been adopted by dae as a holistic approach to crop production, 
the mapping team struggled to find organizations delivering the intended activities (marketing support from 
unFas, for example) during the visits to rangpur and Barisal. of the total 16 438 icM clubs that have been 
formed, 6 169 are still functional. this is mostly because project support has been phased out in some areas, 
and the clubs themselves are not fully sustainable on their own.

4.4.2.4  Livelihood Field Schools – Crop Farmers Groups under the Integrated Agricultural  
Productivity Project

each lFs is made up of 25 farmers, from poor households, selected through the use of participatory rural 
appraisal (Pra). the lFs has 10 sessions: 5 for demonstration-related training and 5 for adoption-related 
topics. over the course of a season, each lFs farmer receives 33 hours of training. Between the first and second 
years, each lFs receives need-based inputs such as stress-tolerant seeds, farm yard manure pits, agricultural 
machinery (power tillers, power pumps, sprayers). each lFs is expected to raise funds from the rental of 
agricultural machinery to neighboring farmers. the lFs members are to contribute monthly savings and open 
a bank account.  the dae part of the iaPP has a target to mobilize 8  000 lFss over the life of the project 
(annex 5: a5.16). as of June 2013, 2 250 lFss had been formed in the two regions (rangpur and Barisal). the 
overall iaPP has a target of forming 15 004 farmers groups under four departments (dae, dls, doF and Badc) 
over the five years of the project, of which more than 50 percent of these will be mobilized by the dae part. 

4.4.2.5  Small Farmers’ Groups and Farmers’ Marketing Groups under the Northwest Crop  
Diversification Project 

the project formed 12 415 sFgs (240 430 members), in order to provide production and credit assistance. credit 
assistance is delivered by the ngos that are involved in group formation. Farmers were separated into male 
and female sFgs, with female groups accounting for 50.4 percent of the total number of groups, and women 
making up 50.3 percent of overall sFg membership.

11 AEC has two roots in earlier initiatives: IPM and Integrated Plant Nutrition System (IPNS). IPM is an approach to managing pests and crops by combining cultural, biological, genetic, 
mechanical and chemical methods in a way that minimizes economic, health, and environmental risks while IPNS is the management of all available plant nutrient sources, organic 
and inorganic, to provide optimum and sustainable crop production conditions within the prevailing farming system. Later AEC uses the FFS training methodology to train farmers 
groups on Integrated Crop Management, which includes both IPM and IPNS, thus forming a holistic approach to crop production.
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Marketing support
the project formed 490 FMgs, each with representatives from 20 sFgs (2 representatives from each sFg) in 
order to provide marketing assistance to the producers. a model was developed that included the construction 
of 76 markets in the project area. these markets offered modern facilities for high value crops (hVcs) to project 
beneficiaries through the FMgs. this included 60 growers’ markets in 60 upazilas and 15 wholesale markets 
– one for each of the 15 projects districts in the northwest region and one central market at gabtoli (on the 
northern side of dhaka city). the model also defined eligibility criteria, formation guidelines, and training 
modules. the aim of the model was to develop alternate marketing channels through direct involvement of 
hVc producers.

Performance
according to the department of agricultural Marketing (daM), most of these markets are not fully operational 
anymore. the concerned officer of daM reported to the mapping team that modern marketing benefiting 
farmers is a medium- to long-term plan. this is because it requires a change of behavior of farmer groups from 
subsistence agriculture to high value commercial crop agriculture. the daM expected that in the near future 
these markets may start functioning again as farmers develop more experience with hVcs. nonetheless, during 
the field visits, the mapping team found that most of the markets were not constructed in a suitable place for 
both buyers and sellers. the team struggled to find FMgs to interview. it was revealed during discussions with 
some members of FMgs and sFgs that the groups were mobilized by partner ngos contracted by ncdP. the 
partner ngos treated the farmers as their credit borrowers and did not put much emphasis on institutional 
development. no standard procedure in forming Fos was followed by the project and partner ngos. this 
might be the major reason why sFgs and FMgs no longer function following the withdrawal of assistance of 
ncdP (which closed in 2009). 

4.4.2.6 Small Farmers’ Groups and Farmers Marketing Groups under the Second Crop  
Diversification Project

the project has a target of forming around 12 000 sFgs as well as Farmers Marketing groups during its span 
of 2011-2016. scdP has been partnering with Brac in forming and mobilizing sFgs, and facilitating credit 
provision in high value crops cultivation as well as business development. as of november 2012, Brac has 
formed 866 sFgs through their 51 branches in 52 upazilas of 9 districts (annex 5: a5.17).

4.4.3 Department of Cooperatives

the doc is the principal government organization responsible for registering and assisting cooperatives 
in the management of human, agricultural, natural, technical, financial and other resources. Work with Fos 
under the doc differs from the other departments in that the doc does not implement projects to develop 
Fos, but instead, it registers and supports existing organizations. according to the doc, there are 83  853 
registered farmers’ cooperatives of different categories that are functioning throughout Bangladesh. a chart 
with summary information on these is provided in annex 5 (a5.18). details on all the organizations were not 
available, however, details are provided on the BMPcul below and in annex 5.

4.4.3.1  Bangladesh Milk Producers Cooperative Union Ltd.

under the BMPcul (also known as the Milk Vita model), a Village Milk Producers’ cooperative society covers 
3-4 villages. to become a member, a farmer must own a cow, buy a share of Bdt 100 and pay an admission fee 
of Bdt 10. the society must have a joint marketable surplus of 180-200 liters of milk daily.

a managing committee is elected at the annual general meeting of the society. committee members work 
on a voluntary basis as per the by-laws of the cooperative. at the close of each financial year, profit dividends 
are distributed to the members as per their share certificate. dividends are also paid to the government, as 
they are also investors in the cooperative. at present the government’s equity in all Milk Vita cooperatives is 
Bdt 415 million and the farmers’ equity is Bdt 180 million. BMPcul as a federated cooperative has organized 
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over 200 000 dairy farm families into 1 705 village milk producers’ co-operative societies. this covers about 
21 districts in 28 milk-shed areas. 

4.4.4 Department of Fisheries

4.4.4.1 Common Interest Groups under the National Agriculture Technology Project – DoF component

the approach to cigs under the doF component of the natP is the same as that of dls and dae but with 
a different theme. each cig is made up of 15-20 fishers, with a total of 40 050 members (18 percent female). 
the main activities of fisher cigs are to mobilize the fishers’ groups, organize participatory identification of 
problems, and prepare cig micro plans, which reflect priority needs of cig members. the local extension 
agents of Fisheries facilitate these fisher cigs. these extension agents received training from the doF. 

Performance and federation
during the last 3 years of implementation, 2 670 cigs in 120 project upazilas of 25 districts have been formed 
and mobilized (annex 5: a5.20). though these cigs are to be federated into uPos and uzPos, this has yet to 
take place owing to the lack of mature organizations and an insufficient quantity of products for marketing.

4.4.4.2 Livelihood Field School – Fishers Groups under the Integrated Agricultural Productivity Project

the lFs approach is the same as the one described in the dae section. as of december 2012, the project 
had mobilized around 850 lFs-fishers’ groups (annex 5: a5.22). throughout the project period, doF aims to 
mobilize 2 510 such groups. however, as of June 2013 doF had yet to develop lesson plans for the groups. 
instead, the component adopts a non-interactive group training approach. concrete plans for ensuring the 
sustainability of the groups after project closure are still needed.

4.4.5 Department of Livestock Services 

during the 1990s and early 2000s, dls implemented two large projects that adopted a group approach to 
working with livestock and poultry rearers. these projects, the smallholder livestock development Project 
(sldP i & ii) and the Participatory livestock development Project (PldP i & ii), worked with rearer groups, but 
only for microcredit purposes (annex 5: a5.23). unfortunately records of these rearer groups are not available. 

4.4.5.1 CBOs and District CBO Associations (DCAs) under the Regional Fisheries and Livestock 
Development Component of DANIDA’s ASPS Phase II

the rFldc facilitates FFss with livestock and poultry rearers, and fishers, as the main vehicle for all activities. 
the FFs is a participatory extension approach, under which farmers receive training and support over an 
18-month period. the support consists of formal FFs learning sessions as well as advice during trial in their own 
field. group mobilization into cBos is discussed as a sub-topic in one of the FFs sessions. after graduation from 
the FFs process, 10-12 FFss from one union form a cBo. the cBos are institutionalized both through training 
on organizational development, and the supply of inputs, in the form of block grants (Bdt 10 000 to 500 000). 
the rFldc expects that after the withdrawal of project assistance, cBos will be able to operate autonomously. 
in addition to cBos at union level, dcas are formed at the district level (annex 5: a5.24 to a5.35). 

Services provided
cBos are central to rFldc’s strategy for sustainable extension. although the cBos’ main responsibility is the 
running of the FFss, rFldc believes that training will have little impact without the provision of timely quality 
input supplies and market channels that offer poor farmers fair prices for their products. this provision of 
improved services by cBos is important for sustaining the organizations.

details on services provided by cBos to their members are provided in annex 5, but are organized around 
the following broad areas: (i) aquaculture; (ii) livestock; (iii) agriculture/horticulture; and (iv) other activities. 
these services are offered to members and other clients in the vicinity of the cBos. Many of the latter are 
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farmers involved in the FFss. the most successful of the individual cBos have a network of approximately 
1 500 farmers. they have an annual turnover of over Bdt 1 million and annual profits of over Bdt 100 000, 
through the provision of services to members and the community. as such, they can employ their own staff 
and offer honoraria to their executives. they also employ poultry workers, community livestock workers and 
community agriculture and aquaculture resource persons, to provide vaccinations, animal health care and 
advisory services to farmers for a fee. a share of this fee is given to their home cBo.  

Federation
some of these services are provided by dcas made up of between 28-50 individual cBos. it is the role of the 
dcas to provide the services and make the linkages that are beyond the capacity of the individual cBos. this 
includes making contacts with national and regional agribusiness or government organizations. it is the dcas 
that secure supplies of vaccines and quality (hybrid) seeds from private companies at the national level, and 
make contracts for the net-making system with some local agribusinesses. there are nine such associations.

Performance
a total of 468 cBos have been formed through the group development process under the rFldc. in Barisal, a 
total of 188 out of 296 now have legal status from the doc. 

4.4.5.2  Common Interest Groups, Union Producers Organizations and Upazila Producers Organizations 
under the National Agricultural Technology Project: DLS Component

cigs under the dls part are made up of small and marginal farmers from the livestock sector. they have the 
same responsibilities as cigs under the dae part. under this component, a total of 3 921 cigs with 76 335 farmers 
(26 percent female) have been mobilized (annex 5: a5.36). about 30 percent of cigs initiated fund raising by 
collecting member subscriptions of Bdt 50-100. there are seven types of cigs formed under this component: 
17 percent are poultry-related, 17 percent goat, 41 percent cow, 24 percent beef fattening, 0.17 percent duck, 
0.08 percent buffalo, and 0.03 percent sheep in 104, 92, 120, 107, 02, 02, and 7 upazilas respectively. the livestock 
cigs are also part of the uPos and uzPos.

4.4.5.3 Livestock Rearers Groups under the IAPP – DLS Part

the iaPP is in the process of organizing livestock rearer groups (homogenous groups of cow, goat and 
backward poultry rearers). as of december 2012, 1 200 groups had been formed out of the 3 750 planned 
(75 000 members) over the project span (annex 5: a5.37). the primary responsibilities of the livestock rearers 
group are to: (i) adopt the technology promoted under demonstration; and (ii) undertake group activities 
related to learning and distribution of inputs. group members receive training and inputs, including vaccination, 
medication and de-worming activities. one-thousand-eight-hundred-and-seventy-five exclusively female 
groups will receive the backyard poultry-rearing package. nine-hundred-and-thirty-eight groups will receive 
the cow-rearing package and the other 937 groups will receive the goat-rearing package. as the budget for this 
part is relatively small, the lFs approach is not being fully applied. 

Performance/Sustainability
Based on a review of the iaPP project appraisal document and consultation with the dls Project coordinator, 
the mapping team found no strong indication of future sustainability of these groups. this is the result of a lack 
of guidelines on how to develop strong institutions. as such, groups are being formed without some clear key 
principles.
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4.4.6  Ministry Of Local Government, Rural Development and Cooperatives (MOLGRD&C)

4.4.6.1  Village Savings and Loans Groups (VSLGs) under the Chars Livelihood Programme

the Vslg approach enables group members to save and borrow money for small-scale farming, as well as 
access funds in the event of a crisis, and thereby reduce their vulnerability to shocks. Vslgs are composed of 
15-25 female members who meet regularly to deposit savings and collect loan repayments. if desired, they can 
borrow small amounts of money (up to 3 times their savings) for short periods (repayment within 3 months), 
paying monthly interest at a low rate of 5 percent initially, after which a desired rate set by the group is to be 
used. the group’s savings and earnings are shared among the members in proportion to their savings after 
approximately 12 months, while the credit remains within the group.

Performance
clP-i (now closed) enrolled over 35 600 Vslg members (1 712 groups) as of april 2011. as of december 2012, 
clP-ii had enrolled 11  828 members (523 groups). according to a sustainability study conducted by clP 
(Panetta, 2009), some Vslgs are no longer operational as a result of migration owing to river erosion, conflict 
within the group and lack of group leadership. 

4.4.7 Social Development Foundation

4.4.7.1  Gram Samitys (GSs) (Village Associations) under the Nuton Jibon Project

the organizational approach under the nuton Jibon Project is quite complex, but the complexity is a part of 
what has made the institutions so successful. there are a variety of checks and balances in place to ensure 
accountability, inclusion and fairness. Figure a5.2 in annex 5 depicts the following approach in graphic form.

>> the project begins by facilitating participatory identification of the poor (PiP) to identify the hardcore poor 
(hcP) and poor households within a target village. 

>> a general body, the Gram Parishad (GP) (village council), is formed and includes all households within a 
target village. 

>> the gP is made up of Nuton Jibon (New Life) Groups (nJgs), with 10-15 members, all from hcP and poor 
families. each nJg has a leader and cashier. 

>> to maintain savings and keep proper records, the leaders and cashiers of 3-5 nJgs form a Sanchoy 
Sangrakhan Committee (ssc). the ssc elects a leader and cashier, one of whom must be a woman. 

>> at the next level, a Village Credit Organization (Vco) is formed, which is made up of the leaders of all sscs 
in the village, along with two members of the gs (described in the following bullet). at least 60 percent of 
the members of the Vco must be women. the Vco members select a leader, a secretary and a cashier to 
undertake various activities, and at least two of these must be women.

>> the gP forms a committee similar to that of an executive committee, called the gs (Village association), 
which is the most important body in the village, as it has the power to make all decisions. gss consist of nine 
members: president, secretary, cashier and seven members from nJgs. the gs meets at least once every 
three months in the presence of at least 70 percent of the hcP and 60 percent of the poor people of the 
village. at least 50 percent of those present at the gs meetings must be women. 

>> the nJg, the ssc and Vco together undertake the savings and credit activities within a gs.

>> Within the gs, a social audit committee (sac) is also formed, consisting of five members, directly selected 
by the gP. Members of the sac cannot be members of the gs or other committees, nor can they be 
close relatives of gs and other committee members. the sac is formed to ensure the transparency and 
accountability of the activities under the gP.

as of december 2012, the nuton Jibon project had mobilized 3 262 gss in 16 districts covering 3 regions: Barisal, 
rangpur and Jamalpur. 
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Federation
the nuton Jibon Project is in the process of forming ‘second-generation’ institutions, called nuton Jibon cluster 
community societies, in gaibandha and Jamalpur. Between 30 and 35 gss under a cluster (at upazilla level) 
come together and form these societies. at district level, the societies federate to form a nuton Jibon district 
community society. the major focuses of these higher-level organizations are institutional strengthening, 
advocacy and producer group development.

4.5 Farmers’ organizations formed with support from international  
non-governmental organizations

4.5.1 Action Aid Bangladesh

4.5.1.1  Kendrio Krishok Moitree (Central Farmers Alliance) 

KKM is a national federation of Fos. its headquarters are in dinajpur, where it has a seed processing facility, 
which provides seeds to its members. however, more investment is required to reach production levels 
needed to cover all members and have this as a sustainable funding mechanism for the organization. criteria 
for membership include being poor or hardcore poor, and landless. 

the federation is made up of 828 village organizations, with 25 members each, which are federated into 
30 union-based organizations and then into KKM at national level. KKM is run by an executive committee of 13 
members, 6 of which are female. KKM members are strong advocates for farmers’ rights at the local level, and 
have linkages with union and upazila Parishads. KKM is also a member of the asian Farmers association. an 
image showing KKM’s structure is provided in Figure a6.1 in annex 6.

4.5.2 CARE Bangladesh

4.5.2.1 Village Development Committees (VDCs) under the Food Security for Ultra-Poor in the Haor 
Region (FSUP-H Project)

Vdcs are a platform for the poor to actualize their own development agenda in their communities by realizing 
their right to services, information and markets. they act as advocates to improve local governance. Vdcs 
also have their own revolving fund, generated through regular collection of subscription payments. the 
fund provides loans for establishing small businesses, either individually or in groups. it also covers Vdc 
operating costs. these platforms are now being facilitated by the project to evolve into self-managed ‘peoples 
organizations.’ in the future, there is a possibility that the Vdcs will join at the union and upazilla level, to form 
second tier federations (annex 6: tables a6.2 and a6.3).

4.5.3 Helvetas Swiss Intercooperation

4.5.3.1  The National Nursery Society (NNS)

the nns is the national body of upazila and district nursery Malik samitys (nMss) (nursery owners associations). 
it was established in 2010 as a common platform of 9 000 nursery owners from 386 upazilas of 63 districts in 
Bangladesh. the nns has 356 functional upazila nursery Malik samitys (unMss) and 62 district nursery Malik 
samitys (dnMs) (annex 6: table a6.4).  the nns is formally registered with the Joint stock company under 
the society act. the society has a 27 member executive committee and the following sub-committees: policy 
making; planning and fundraising; finance, purchase and expenditure; organization development; training and 
information; marketing; quality plant materials (QPMs) technical committee; fairs and exhibitions; members’ 
welfare; environmental development; disaster management; and recreation.

the major objectives of the nns are to: (i) enhance collaborative efforts among members, which will strengthen 
and provide leadership to the horticultural industry; (ii) bring all concerned nursery industry entrepreneurs 
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into a nationwide umbrella with a focus on production and marketing of QPMs; (iii) support the organizational 
development of the nursery owners associations of Bangladesh; and (iv) develop linkages with government and 
national QPM supply chain players, i.e. research institutes, universities, extension agencies and development 
organizations.

4.5.3.2  Service Provider Associations (SPAs) under the Samriddhi Project

through the samriddhi project, hsi develops the capacity of local service providers (lsPs) in the area of high 
value agriculture (livestock, poultry and horticulture). the lsPs, with their training, then provide demand-
driven business services to farmers and sFgs for a service charge. When lsPs realized that there was an 
increase in demand for relevant technical and business services in their communities, they started to set up 
service Providers’ associations with the intention to better coordinate their service activities in communities. 
the associations allow for more effective promotion and expansion of their services to communities. they 
also facilitate linkages with other resource organizations, such as government line agencies and ngos. these 
linkages give lsPs easier access to information on innovation and technologies, which lsPs need to update 
their skills. 

approximately 4 000 lsPs have been mobilized into 58 sPas (membership of 25 percent women), each led by 
a President. each of the sPas has 50-66 lsPs as members, and each of the lsPs works with 250-300 farmers by 
forming groups of 15-20 farmers. the lsPs currently provide services and support to 4 831 of these farmers’ 
groups and their 208 networks.

sPas earn profits by charging for their services, and by making deals with private companies in the input and 
output markets, facilitating exchanges with farmers, and selling processed products (e.g. medicinal plants). the 
profit generated from these activities is distributed among sPa members, with some percentage of the profit 
deposited in the sPas as savings. this market development model (shown in annex 6: Figure a6.4) is a strong 
tool of sustaining Fos by providing agribusiness support to member farmers. 

4.5.4 International Development Enterprises – Bangladesh

4.5.4.1  Collection Point Market Centres (CPMCs) and Farmers’ Associations

cPMcs are market associations that bundle the produce of smallholders in order to attract more traders. 
the farmers’ associations have been mobilized and facilitated by ide under different projects with a view 
to enabling poor members to participate effectively in high-value agricultural market systems (annex 6: 
table a6.6). the major functions of the associations are to: (i) develop new input sellers within the association to 
enhance farmers’ access to quality inputs; (ii) develop linkages with traders, manufacturers, seed and pesticide 
companies and producers in order to disseminate a range of technologies and services such as bio-fertilizer, 
pheromone traps, shell separators of ground nuts and soil testing services; (iii) establish small processing units 
where producers can undertake product grading; and (iv) market and sell aggregated produce of member 
farmers to local, regional and national buyers.

4.5.5 Save The Children International

4.5.5.1  Household Productive Poor (HPP) Groups, Productive Poor (PP) Groups, Extreme Poor (EP) 
Groups and Village Savings and Loans Associations (VSLAs) under the Nabo Jiban Project

in mobilizing Fos, the nabo Jiban Project targeted different socio-economic groups and formed the following 
homogenous groups: hPP groups, PP groups, eP groups and Vslas, each made up of 20-25 farmers. hPP group 
members are those with less than 50 decimals of land. PP group members are farmers with 50-150 decimals 
of land. eP group members have no land or only a homestead, and are a widow or beggar. Vsla members are 
those who have no access to formal microfinance institutes and are mostly the vulnerable poor. so far, the 
project has mobilized 2 000 hPP groups, 700 PP groups, 1 000 eP groups and 160 Vslas. 



36

c
h

ap
ter 4: M

ap
p

in
g

 fin
d

in
g

s
Farm

ers’ o
rg

an
izatio

n
s in

 B
an

g
lad

esh
: a

 M
ap

p
in

g
 an

d
 c

ap
acity a

ssessm
en

t

4.5.6 World Vision Bangladesh

4.5.6.1  Development Groups and Community Based Organizations

under their area development Programs, World Vision Bangladesh has mobilized 2 178 dgs, which have been 
federated into 509 cBos. the activities of cBos are: (i) facilitating the formation of additional development 
groups within their geographic area; (ii) organizing leadership and financial management training; (iii) building 
skills in community disaster response coordination; (iv) advocacating for women’s control over lending 
resources; (v) training on proposal writing; (vi) ensuring regular and fair elections and promoting organized 
systems and structures within the dgs and cBos themselves; and (vii) ensuring equal representation and active 
participation of farming and non-farming community members, including women and children, in all stages of 
management, planning and monitoring and evaluation of the needs-based activities mentioned above.

4.6 Farmers’ organizations formed with support from national  
non-governmental organizations

4.6.1.  BRAC

4.6.1.1  Village Organizations (VOs) under the Tenant Farmers Development Project (Borga Chashi 
Unnayan Prokalpa [BCUP])

Vos under the BcuP are made up of approximately 22 male and female tenant farmers. tenant farmers must 
be members of a Vo in order to access benefits of the BcuP, which include loan provision. as of March 2013, 
BcuP had mobilized 15 162 Vos made up of 326 847 members. in the future, Vo members may become eligible 
for larger loans. however, the Vos themselves may not continue after project closure, as is the case with other 
microfinance groups12.

4.6.2  Christian Commission For Development In Bangladesh

4.6.2.1  People’s Institutions (PIs)

since 2000, ccdB has formed 838 Pis. among them, 294 have been phased-out 13, 213 are older, but still 
supported by ccdB and 413 are more recently formed. currently ccdB is working directly with older and 
younger Pis. each institution is made up of 100-150 poor people of a village. according to ccdB, about 
80 percent of the members of these Pis are farmers. some of the older Pis are producing seed, including hybrid 
seed. they have a brand name and internal distribution mechanism.

4.6.3 Rangpur Dinajpur Rural Services

4.6.3.1  Union Federations

to ensure empowerment of the rural poor, since the 1980s, rdrs has organized union Federations. these are 
coalitions of small groups of poor and marginalized people within a union. the smallest unit of the Federation 
is the Village group, which is made up of 15-20 households of small and marginal farmers, destitute families and 
indigenous families. the general committee of the Federation is made up of one nominated representative 
from each Village group. Members of all Village groups elect a total of nine members to the executive 
committee of the Federation by direct voting. 

each union Federation is managed by two permanent committees: the general committee (Protinidhi 
committee) and the executive committee. the general committee is the most powerful body of the Federation 
as it has the power to make all decisions. the general committee has several sub-committees: the Women 
Forum (nari Forum); the Youth Forum (Juba Forum); the information and advocacy unit; and the conflict 
resolution committee.

12  As shared by Mr. Alamgir Hossain, Program Manager, Agriculture and Food Security Program.
13  An evaluation of these institutions is still needed in order to get a better sense of their performance.
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all of these fora, including the union Federation itself, have a written constitution. a separate Farmers’ 
Forum (Krishak Forum) has also been proposed under the Federation, for which a draft constitution has been 
developed. the Farmers Forum (one in each union) aims to address constraints associated with small and 
marginal farmers. a circular was placed in all federations encouraging them to launch a separate forum of 
farmers. to date, most of the federations have formed farmers’ fora. 

in addition to the union Federations, a large network has been developed at the upazila, district and division 
(rangpur) levels to maintain unity among the federations, exchange experiences, and better link with 
government and non-government organizations for advocacy purposes. there are Federation coordination 
committees at the upazila, district and divisional levels. all of these have defined constitutions that outline 
their responsibilities.

Performance and sustainability 
the Federation movement continues to gain strength, with individual village groups enhancing their 
physical and economic resources as well as their skills to manage them. one striking example of this: a total 
of 1 430 members from 353 union Federations across 11 northern districts stood as candidates in 2011 union 
Parishad (local council) elections, of which 559 members were successfully elected.

Most of the federations demonstrated strength in the areas of governance, social awareness, female 
empowerment, and resolving land disputes. however, there is a need for more skills in entrepreneurship, 
building business linkages and negotiation capacity. these skills are key to being able to deliver services to 
the poor producers in the economically fragile areas of the northern region. as such, there are still questions 
regarding the sustainability of federations without the assistance of rdrs. 

4.6.4  Microfinance NGOS

4.6.4.1  ASA

groups under asa are made up of 20-25 members. these groups are assembled by asa in order to disburse 
microfinance. 

4.6.4.2  Grameen Bank

grameen Bank forms groups to conduct microfinance activities. these groups form and dismantle; as such, 
there are no centralized records.

4.6.4.3  Thengamara Mahila Sabuj Sangha (TMSS)

tMss also works with microfinance groups, with members from farm and non-farm communities.



some farmers’ organizations are 
stronger in governance but lack 
financial sustainability. others 
are experienced in providing 
services to members, but have a 
poor institutional framework. a 
common thread among all is the 
need for autonomous leadership 
and vision, and for plans for 
long-term sustainability.
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Capacity needs assessment 5
during this participatory exercise, the team uncovered several sets of capacity needs. they are outlined below. 
the constraints and capacity needs are scored, ranked and listed together in annex 9. it is important to note 
that different Fos have different purposes (e.g., some focus on advocacy, others on market access). they will, 
therefore, require different capacities in order to achieve their organizational goals. that said, the overarching 
purpose of this exercise, and the iaPP ta component’s work with Fos, is to increase their involvement in 
investment programming. as such, the majority of information on capacity needs relates to this purpose. the 
first four needs listed below are directly relevant to building sustainable Fos that can be more involved. the 
fifth need, related to post-harvest and value addition technology, though not directly linked to participation 
in investment programming, was brought up often and so is reflected below. the last category relates to the 
overarching macro-level need to strengthen the enabling environment for the sustainable development of 
Fos and their inclusion in investment programming. 

the six areas for improvement are:

1.> institutional development capacities;
2.> business and market-related service provision;
3.> facilitation skills of those working with Fos;
4.> access to credit;
5.> post-harvest and value addition technology; and
6.> strengthening the enabling environment for Fo development. 

naturally, different organizations have different combinations of these needs. some are stronger in governance 
but lack capacity in service provision and, therefore, financial sustainability. others are quite experienced 
in providing agribusiness services to members, but have a poor institutional framework. a common thread 
among all is the need for autonomous leadership and vision, and for plans for long-term sustainability.

5.1 Institutional development capacities

constraints identified relate to organizational management, financial management, project cycle management, 
and networking, lobbying and advocacy. 

Organizational management: there was a strong call for support around leadership and membership 
development, mobilization of members and building trust within groups. this is particularly important 
considering concerns raised about elite capture. Many organizations expressed a lack of clarity about their 
mandate. thus, there is a need to strengthen skills in organizational management and strategic planning 
(visioning, formulation of goals, objectives, strategies) of both leaders and members. there is a need to develop 
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capacities in coordination and collaboration, with a view to federating the organizations as they are further 
developed. Many Fos expressed a need for support in the government’s registration process. in addition, 
there is a need to develop capacities of organizational leaders, particularly executive committee members, 
in leadership and human resources management. this includes general professionalism as well as skills in 
planning, inclusive management, member profiling, needs assessment and demand-driven service provision.

Financial management: Financial management was identified as an important area of intervention as most 
of the organizations’ leaders and members lack basic financial skills. these skills include tracking cash flow 
and simple financial analysis to measure profitability. as the leaders lack these skills, they are unable to 
support member farmers in writing successful business proposals. two benefits are envisaged from educating 
Fo leaders and members in financial management: (i) transparency of Fos in cash flow management; 
and (ii) provision of services to members in agribusiness project proposal writing, resulting in increased  
member loyalty.

Project cycle management: in order to enhance Fo participation in the investment programming cycle, there 
is a need for Fo leaders and members to develop an understanding of how the Bangladesh project cycle works 
and what the role of Fos within this cycle could be. skills are needed in project formulation, implementation/
management, and monitoring and evaluation. in addition to generic skills in these areas, Fos need to become 
familiar with government planning processes and tools, including the development Project Proposal, so that 
they can contribute concretely. capacity development is also needed for investment planning and participatory 
planning, so that Fos can develop their own projects. this will provide a more sound basis for sustainability of 
the organizations. capacity development is also needed to generate knowledge and lessons learned, including 
the systematic management and sharing of information.

Networking, lobbying and advocacy: empowerment of Fos and their members is needed to deepen their 
participation in development processes. there is a need to raise awareness on the advantages of being 
organized that go beyond accessing benefits of external projects. strong and well-organized Fos can play 
an important role in shaping the agenda of decision makers and service providers, defining the most suitable 
interventions and services for their needs, as well as how these services should be delivered and financed. 
skills in lobbying and networking (with local government, service providers, other communities and Fos) are 
critical here. there is also a need to build knowledge of the government’s strategies, policies and processes so 
that Fos can understand exactly where the different entry points are, how decisions are made, and where they 
can most effectively participate. ideally, Fo representatives would be present in union and upazila Parishads. 
there was also a call for a strong national platform through which farmers’ voices can be heard and their needs 
addressed. though Fos are not yet at this stage of development, a mandate and institutional structure will 
need to be established to ensure good communication flow and accountability between the different levels of 
the organization and those working on behalf of the membership at the national level.

additional needs include skills in negotiation and communication, as well as the building of confidence of 
organizations’ leaders and members. 

awareness is also needed about legal rights of farmers and Fo members, including land rights and women’s 
rights. there is also a need for more communication between Fo leaders and members. the role of women 
within the organizations needs to be strengthened as well. this could be done through awareness building of 
husbands, as well as specific targeting of women for organizations and leadership positions, possibly based on 
quotas.

5.2  Business and market-related service provision

as Fos are membership based, their efficacy depends on their capacity to provide services and benefits to their 
members. to be sustainable, Fos should have the capacity to define members’ needs, identify interventions to 
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address them, and deliver these interventions in an inclusive manner. if the services and benefits are demand-
driven, farmers will remain members of the organization and contribute to it. if not, farmers will quit or, at best, 
remain as “dormant” members. a strong and active membership base is also an important part of ensuring the 
financial sustainability of the organization.

Business services: in most cases, Fos failed to provide appropriate business services to their members. this is 
especially important considering the transition from subsistence to market oriented agriculture. need-based 
agribusiness services for members are a path towards sustainability of Fos, which enhance trust, commitment 
and accountability. capacities are needed to deliver common business services to members such as pre-season 
crop budgeting, forecasting of production within the group, quality enhancement and the development of 
market plans for fresh produce. in addition, Fos need capacities to organize commercially viable agribusiness 
clusters, and to train their members as entrepreneurs. More support is needed for Fos in business planning and 
management, mobilizing resources (including savings) within organizations, accessing finance and building 
capital. all business services must begin with the identification of business on the basis of livelihood relevance, 
market opportunities and how it contributes to community development. 

Market-related services: the mapping team identified several constraints faced by Fos related to fair access 
to markets. these include lack of skills in value addition and building linkages with the private sector. in order 
to avoid being taken advantage of by local syndicates, there is a need to develop mechanisms for bulk buying 
of inputs and selling of products. there is also a need for awareness raising around how being organized can 
help members improve their access to and competitiveness in markets. this includes getting good information 
about market prices. Fos also face difficulties accessing up-to-date information on weather forecasts, potential 
business partners beyond the local level, available inputs, modern production and marketing technologies, 
and good agricultural practices. increased awareness of options currently available to farmers is needed.

a farmers’ organization selling carrots in dashuria, Pabna.



42

c
h

ap
ter 5: c

ap
acity n

eed
s assessm

en
t

Farm
ers’ o

rg
an

izatio
n

s in
 B

an
g

lad
esh

: a
 M

ap
p

in
g

 an
d

 c
ap

acity a
ssessm

en
t

5.3  Facilitation skills of those working with farmers’ organizations

in addition to the capacity needs of the Fos themselves, there is a need to enhance the skills of those facilitating 
the development of these organizations, from both the government and ngo side. capacity development 
of these extension agents is required in stakeholder mobilization, targeting of villages and organization 
members, as well as the facilitation of institution development at its many stages. there is a need for clear 
communication from extension agency leadership regarding the value of Fo empowerment so that organizing 
goes beyond group formation for delivery of the organizers’ own projects, and instead, puts the focus on 
building sustainable institutions. 

as discussed in section 3, there is a need to strengthen the curriculum of the agriculture diploma course offered 
by atis throughout the country. at present, there is a lack of strong focus on inclusive extension approaches 
(with guidance on targeting and selection, community mobilization and institution development), as well as a 
lack of practical, well-facilitated hands-on training.

5.4  Access to credit

lacking access to savings and credit services, it is difficult for farmers to build up a resource base. although 
microfinance institutions (MFis) providing microcredit do have a relatively wide outreach in remote areas, 
interest rates are still high, there are no grace periods and the lending is often focused on non-agricultural 
clients. For the type of investments farmers need to make, such as agricultural micro-enterprises, commercial 
farming of high value crops, livestock or fisheries, sizable loans, ranging from usd 1 000 to 10 000, are required. 
MFis cannot provide this type of capital. at the same time, Fo leaders are not well acquainted with small and 
medium enterprise (sMe) loan packages from Bangladesh Bank (central Bank) through public and private 
banks. Fos have an important role to play as guarantors of credit for their members – either with banks or 
input suppliers (for in-kind loans).

5.5  Post-harvest and value addition technology

in general, technical support currently provided to farmers is linked to production. there is a lack of support in 
post-harvest and value addition technologies. Beyond the need for training to Fo members in the use of the 
relevant technologies, Fos themselves should own these technologies and they should be used by members 
through common facility centres. this Fo ownership would be a change to some cases where rich, absentee 
farmers who own the equipment do not put them to full use. With Fo ownership, resource poor farmers 
would be more able to access these technologies, and any margins made through rental of the equipment 
would remain with the Fo, contributing to its financial sustainability. technologies here include closed drum 
threshers (for paddy threshing), corn shellers, vaccination kits, milk chillers, cream separators, spice grinders, 
medicinal leaf/branch driers and grinders, and mobile rice husking mills. improvement here is also important 
from a female empowerment standpoint, as women are very much involved in post-harvest processing, drying 
and storing of grain.

5.6  Strengthening the enabling environment for farmers’ organization 
development

there is a general need for Fos to be more familiar with the various relevant government policies that, though 
not fully implemented, do actually provide broad support for Fo development. Familiarity with these policies 
will allow Fos to advocate for better enforcement.

as referenced in the section on enabling environment issues, there is also a strong need for much more effective 
implementation of these government policies relevant to Fos. the cumbersome Fo registration process 
must also be streamlined. as mentioned earlier, the curriculum of the agricultural diploma courses of the atis 
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requires updating to include participatory extension techniques and facilitation of the development of strong 
Fos. a unified extension manual that can be provided to extension agents working in different government 
ministries and departments would likely strengthen the impact of extension work.

also mentioned in the enabling environment section, there is also a need for specific points in the government 
investment planning and programming cycle when Fos are involved. 



government decision making 
bodies relevant to agriculture, food 
security and nutrition should actively 
engage all stakeholders and allow 
for a dynamic, candid exchange 
of ideas. When used to their full 
potential, these bodies can ensure 
good governance of investment 
operations in the sector.
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The way forward 6
developing the capacities of Fos so that they can become active players in investment requires innovation and 
new ways of thinking. the iaPP ta project cannot fully address all the needs previously mentioned on its own. 
Being successful will require partnerships with government staff, politicians, civil society organizations (csos), 
ngos, academia and the media. the following set of capacity development activities has been identified: 

(i)> Fo-to-Fo exchange; 

(ii)> training for Fos; 

(iii)> capacity development of those facilitating the development of Fos; 

(iv)> ensuring participation of csos and Fos in government decision-making bodies; and

(v)> facilitation of dialogue between stakeholders to address enabling environment issues. 

these proposed interventions were discussed during the in-depth mapping exercise and during a sharing 
meeting with csos and government representatives, held in dhaka in april 2012. the proposals come largely 
from Fo representatives themselves.  

6.1  Targeting

though support is needed at all levels, the iaPP ta component aims to focus its resources strategically in order 
to ensure the highest possible level of impact. as such, it proposes two main target groups for these activities: 
(i) iaPP field-level institutions, and those that facilitate them. Because the iaPP ta is directly connected to 
the iaPP project management unit, it can easily collaborate to make improvements to iaPP Fo development; 
and (ii)  organizations that are federated or have started making progress towards federating, and those 
that facilitate them. this is because much of the initial organizational development work has already been 
completed. this means that less time will be required to bring these organizations to the point where they are 
ready to engage in the investment programming process.

it is important that participation in the capacity development activities mentioned herein is not limited to one 
to two leaders of each organization. in order to ensure sustainable results, participation should be opened 
up to the full membership of the organizations. of course, to ensure logistic feasibility, participation can be 
rotated, but support must not be provided to only one or two leaders per organization. strong membership of 
the Fo is likely to yield strong leadership and therefore a strong and sustainable Fo. 
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6.2  Farmer organization to farmer organization exchange 

as there is such a diversity of Fos in Bangladesh, there is scope to bring organizations together to learn from 
each other’s experiences. exchange visits within Bangladesh should be organized for this purpose. during these 
visits, participants can learn directly from their peers about what has and hasn’t worked in the development 
of their organizations. as an example, representatives from iaPP-promoted lFss could spend time with more 
mature organizations in order to gain an understanding of what was needed to build up the organization 
to where it stands today. on return to their communities, the representatives would then share what they 
learned and see how it can be applied to their own organizations. the representatives could travel with those 
facilitating their organization in order to work together on how best to strengthen the organization upon 
return. 

exchange visits should involve not only leaders of the organizations, but members as well. Member to member 
exchange reduces the risk of elite capture and is an effective mechanism of ensuring that the membership base 
of the concerned organizations is strengthened, as well as its leadership. By developing strong relationships 
between peers, information, ideas and new technologies can flow more easily. 

the team found that often there were Fos formed under one project that were quite geographically close 
to other organizations formed under a different project, or autonomously. a mentoring-type arrangement 
could be established, which would bring together members of the more mature organization with those of the 
younger one, to discuss problems and potential solutions on a frequent basis. a possible example would be for 
cigs formed under the natP to mentor the iaPP lFss. 

the project has already organized:

>> a national federated Fo sharing workshop, which took place in March 2013. it was a successful first attempt 
to bring Fo leaders together to network, learn about each other and receive information regarding the 
project cycle and the benefits of being organized.

>> in June 2013, a study tour to the Philippines was carried out in order to expose Bangladeshi Fos to 
Fo strengthening and federating activities in the Philippines. it was hosted by PaKisaMa and the asian 
Farmers association.

>> in July 2013, two national exchange visits to the idilpur anarosh chashi Bahumukhi samobay samity ltd. 
(Pineapple Producers association) and the adarsha chashi unnayan samity took place. during these visits, 
participants from other mature and/or federated Fos learned from the experience of their host organization.

>> Between July and september 2013, a series of sharing workshops took place between iaPP community 
Facilitators and iaPP lFs leaders, and more experienced Fos from the same district. during these workshops, 
leaders of the more experienced Fos facilitated many of the discussions themselves, thus leaving them 
empowered and demonstrating to the new Fos the potential benefits of being organized.

6.3  Training 

training should be organized to bring additional knowledge in many of the areas mentioned earlier. the best 
approach would be to work with local training providers to develop capacities of both those facilitating the 
development of Fos, as well as Fo leaders and members themselves. a training of trainer approach should 
be used to develop a cadre of resource persons (both facilitators and Fo members/leaders) who could be 
deployed to work with their own organizations or with other organizations who are looking to develop further. 
capacities in the areas mentioned below will become useful at a later stage if and when Fos decide to federate 
more broadly. the ability of federation leaders to develop capacities of member organizations will be key to 
ensuring sustainability.



47

c
ha

p
te

r 6
: t

he
 w

ay
 fo

rw
ar

d
Fa

rm
er

s’
 o

rg
an

iz
at

io
n

s 
in

 B
an

g
la

d
es

h
: a

 M
ap

p
in

g
 a

n
d

 c
ap

ac
it

y 
a

ss
es

sm
en

t

topics for training include:

>> how to build partnerships with local government and service providers;

>> project/investment planning and project cycle management;

>> business development and financial management;

>> negotiation skills;

>> gender sensitive leadership development; 

>> public speaking;

>> mobilization of members;

>> strategic planning;

>> networking;

>> developing group mission statements and action plans; 

>> government policies, strategies, processes and legal frameworks; 

>> good practices in forming and structuring democratic, accountable, and professional Fos;

>> service provision; and

>> information on relevant value addition technologies available in Bangladesh.

6.4  Capacity development of those working with farmers’ organizations 

capacity development here can take a mixed approach. Facilitators could join exchange visits of Fos in order 
to learn from the facilitators of the more mature groups. additionally exchange visits between facilitators 
themselves could also be organized. Field staff of dae, doF and dls, and the iaPP community Facilitators 
could link up with cluster Facilitators and community Professionals of the successful social investment Program 
Project, in order to learn from their sustained experience in building village institutions. specific training to iaPP 

Farmers’ organization leaders on a study tour to the Philippines - June 2013.
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community Facilitators has already been delivered on group formation and facilitation, with a strong focus on 
developing sustainable organizations as well as on proper targeting of villages and members within villages.

as mentioned in the enabling environment chapter, there is room to explore collaboration with the Moa, dae 
and the technical education Board to strengthen and update the curriculum of the atis. areas for improvement 
are targeting, group mobilization, monitoring of extension activities and training in the latest extension 
approaches. 

Finally, the project has started to provide training in ruralinvest, which is a training methodology and tool for 
public institutions and important ngos involved in supporting communities in their investments.

6.5  Ensuring participation of civil society organizations and farmers’ organizations 
in Government decision-making bodies

a concrete way to strengthen the voice of Fos and civil society in investment programming is to ensure that 
Fos that truly represent farmers participate in government decision making bodies relevant to agriculture, 
food security and nutrition. these decision-making bodies should actively engage all stakeholders and allow 
for a dynamic, candid exchange of ideas. When used to their full potential, these bodies can ensure good 
governance of investment operations in the sector. concrete entry points for Fos are required so that they can 
easily get involved in planning, implementing and evaluating investment activities. 

a good place to start is the steering committee of the iaPP itself. this would translate to the more active 
participation of Fos in the Project steering committee and Project implementation committee, as well as 
regional level decision-making bodies. this would be a good means to (i) strengthen Fos’ knowledge and 
understanding of public investment work; and (ii) strengthen the iaPP through insight from the local level. 
Federating and empowering Fos is an important preparatory step to ensure their legitimacy to represent a large 
number of small-scale Fos. a first step could be to organize a series of information sharing and consultation 
meetings between the steering, implementation and local-level committee members and interested csos and 
Fos. the aFa and action aid have begun to bring csos together in order to participate in the iaPP, and work 
under this ta component can further support their efforts. outreach campaigns in rangpur and Barisal could 
be organized to raise awareness about the project. information about the project can be shared, and feedback 
can be gathered and reported to the different committee representatives. as a result of these initiatives, the 
representatives will be able to bring an informed and unified perspective of Fos to the project. innovative 
mechanisms could be drawn from the gaFsP global steering committee itself, which is strengthened by the 
strong presence of international Fo and cso representatives.

6.6  Facilitation of dialogue between stakeholders to address enabling 
environment issues

though the iaPP ta team cannot implement changes to the enabling environment directly, it can play the role 
of a facilitator of dialogue between key stakeholders, including government bodies, Fos and development 
partners. 

iaPP ta can organize opportunities for networking and relationship development between Fos and 
the government, as well as between Fos and development partners. this can set the foundation for the 
development of coordination mechanisms in the future that are well established, truly inclusive and based on 
trust.

the mapping team found that although policies regarding Fos are in place, implementation remains a 
bottleneck. therefore, the project needs to collaborate with the relevant ministries and departments and their 
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partners involved in extension work to support the development of a unified extension manual to improve the 
implementation of these policies.

this extension manual would strengthen and harmonize content on targeting, formation and mobilization of 
and support to Fos, sub-committees that ensure transparency within the Fo, services to be covered by Fos, 
and how to monitor all of these activities. in addition, there should be an illustrated manual that can be used 
by Fos themselves. the following 9 topics could be covered: 

1.> mission and vision statements for developing sustainable Fos;
2.> registration processes under different acts (registrar of Joint stock, doc, etc.);
3.> guidelines for developing strategic plans and business plans;
4.> guidelines for preparing audited financial statements (balance sheet, income and losses, and cash flows);
5.> guidelines for strong governance (forming a general assembly, executive committee, sub-committees, 

making provisions for regular leadership rotation and decision making by an independent board of 
directors);

6.> guidelines for developing service programmes based on the expressed needs of the members including 
savings and loans, agribusiness support and social support;

7.> guidelines to ensure that the organization plays an influential role in representing their constituents in 
councils of government and other fora;

8.> mechanisms for participatory decision making; and
9.> measures to generate revenue to ensure financial sustainability.



to bring this work 
forward partnership 
is needed between 
farmers’ organizations, 
government bodies, 
development partners, 
ngos, and education 
and training bodies.
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Conclusion and immediate next steps 7
Through the combination of these activities, the aim is empower FOs so that they become pro-active 
stakeholders in the investment programming cycle. this would enable them to influence both the policies 
pertaining to and the design, implementation and evaluation processes of investment projects in agriculture, 
food security and nutrition.

this would be the result of partnerships with those involved in Fo work, including Fo  representatives, 
government agencies and departments, development partners, ngos and education and training bodies. the 
first step is to share the report, its findings and proposed actions with them to engage in a productive dialogue. 
the following are other short-term actions that are being undertaken or planned so far:

>> the implementation of FO-related activities of the work plan of the iaPP ta. these include a federated 
Fo sharing workshop (March 2013), a study tour of Fo leaders to visit PaKisaMa in the Philippines (June 
2013), national Fo exchange visits, sharing workshops between local Fos and iaPP lFss and community 
Facilitators, and further training to iaPP community Facilitators and Field assistants on institution 
development and sustainability. 

>> Planning for future activities of iaPP ta in partnership with others that will build upon the gaining 
momentum of this work, and provide more opportunities for Fos to network, learn from each other and 
start planning together.

>> Addressing enabling environment issues mentioned within the report: these include advocating for 
deeper involvement of Fos on the steering committee of the iaPP and other government investment 
project steering committees; discussions with relevant parties on the formulation of a unified extension 
manual; and discussions on how to strengthen the capacities of government extension workers by 
improving the curriculum of atis.

>> Developing and strengthening partnerships with other institutions and projects working with Fos to gain 
support in addressing the aforementioned capacity needs.



the report gives a general 
overview of the many 
organizations met during 
the exercise. the following 
annexes are for those 
looking for more details.
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Annex 1
Methodology of in-depth mapping

Step I: Planning the in-depth mapping 

the team reviewed relevant literature to find out who the key players are and how different agricultural 
extension agencies are working with Fos. Meetings were held to gather more secondary information. the 
team visited rangpur and Barisal to identify organizations to meet with for in-depth discussions. all of this 
information allowed the team to start tracking the organizations and developing the right tools (annex 2: 
instruments i, ii and iii) for further analysis.

additional information needs were then categorized into 3 broad areas: 

(i)> information from agencies that work with Fos (to understand the mechanisms of Fo facilitation); 

(ii)> information directly from Fos (to understand the current situation and capacity needs); and

(iii)> information from agencies involved in the enabling environment of Fos.

the following government and non-governmental extension organizations were consulted during this phase:

>> action aid Bangladesh;

>> the Bangladesh rural development Board (BrdB);
>> the Bangladesh Water development Board (BWdB);
>> Brac; 
>> care Bangladesh;
>> the department of agriculture extension (dae);
>> the department of cooperatives (doc);
>> the department of Fisheries (doF);
>> the department of livestock services (dls);
>> helvetas swiss intercooperation (hsi); 
>> international development enterprise (ide);
>> the local government engineering department (lged); 
>> the Palli Karma sahayak Foundation (PKsF); 
>> rangpur dinajpur rural services (rdrs);
>> the regional Fisheries and livestock development component (rFldc); 
>> the rural development academy (rda);
>> save the children;
>> the social development Foundation (sdF); and
>> World Vision Bangladesh.
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Step II: FO inventory preparation

an inventory of Fos associated with different extension organizations was developed. a modified snowball 
technique was followed, visualized and explained through the example below. 

Fig>A.1.1   Snowball exercise for identifying FOs

the mapping team discussed with ide about projects it is involved in that support Fos. By discussing these 
projects, the team learned of other partners involved, and was then able to follow up with them on relevant 
projects. this approach allowed the team to gather much information on who is doing what, where and with 
whom. With this more complete picture of the situation, the team was able to strategically select organizations 
with which to follow up.

Step III: In-depth mapping and capacity assessment exercises

the mapping tools were used to gather in-depth information on federated Fos and iaPP lFss, as well as their 
partners. Basic information was also gathered for other Fos, but the in-depth focus was on organizations that 
have achieved some level of federation, as well as the newly-formed iaPP lFss.

Both qualitative and quantitative methods of investigation were adopted during the exercise. Qualitative data 
was collected mainly through 15 focus group discussions (Fgd), 38 key informant interviews (Kii), case studies 
and regional workshops (details provided below). these were used to gather information on Fo governance, 
the enabling environment, autonomy, partners, access to basic services, market integration, as well as capacity 
needs. Quantitative data was used for in-depth study of Fos, grading them and for capacity needs assessment. 

the key indicators of the capacity needs assessment are in the areas of:

>> institutional strength and infrastructure/governance;

>> administration and management;

>> financial management;

Padakhep
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>> coordination and advocacy/partnership;

>> women’s empowerment; and

>> access to information, to market, and to finance for members .

Step IV: Assess the enabling environment

the mapping team conducted a review of policies of the government of Bangladesh relevant to cooperatives 
and Fos. the team also examined the cooperative/Fo registration process and the curricula of atis.

Step V: Identification and selection of capacity development activities

Workshops with selected agencies and Fos were the principal tool used to identify priority capacity 
development solutions. it was agreed that interventions must be realistic and feasible and that there must be 
an exit strategy for each intervention. 

the criteria for the selection of interventions include the:

>> extent of its impact on Fos;

>> number of Fos that will benefit;

>> cost effectiveness of the intervention;

>> impact of the intervention on sustainable business services;

>> capacity of existing business service providers to implement or manage the interventions;

>> time frame for completing the intervention;

>> availability of resources (human and financial);

>> synergy of interventions among various services; and

>> ability to promote “win-win” relationships between Fos and private sector, Fos and government, and Fos 
and development Partners.

Table>A1.1   List of Focus Group Discussions (FGDs)

Sl>
no. FGDs>particulars Agenda

No.>of>participants
Venue Date

M F Total

1 FGD with NGOs and FOs in Dhaka
Briefing on mapping, FO needs, 
relationship with civil society and 
government

30 10 40
Bangladesh Institute 
of Administration and 
Management (BIAM)

16/04/12

2 FGD with civil society, government and 
FOs in Rangpur

Briefing on mapping, capacity 
development needs 28 7 35 Rangpur 18/04/12

3 FGD with civil society, government and 
FOs in Barisal

Briefing on mapping, capacity 
development needs 28 2 30

Bangladesh Rice Research 
Institute Meeting Room, 
Barisal

26/04/12

4 FGD with FO members of mixed group 
(KKM, LFS, CBO, ICM club)

Organizational capacity, leadership 
and networking 15 13 28 CDA, Patuakhali 08/10/12

5 FGD with members of Adampur Chashi 
Unnayan IPM Club and Association

Organizational capacity, management, 
services, advocacy and networking 9 0 9 Association office, Adampur, 

Dashmina, Patuakhali 8/10/12

6 FGD with members of Farmers Friends 
Organization

Organizational capacity, leadership 
and networking 8 2 10 FO office, Padri Shibpur 

Market, Bakerganj 9/10/12

7 FGD with FO members of mixed group 
IAPP (9); RDRS (1), KKM(13) and CLP(2)

Organizational capacity, leadership 
and networking 15 10 25 RDRS, Kurigram 22/10/12

8 FGD with Chakirposhar Union 
Federation

Organizational capacity, management, 
services, advocacy and networking 8 6 14 Rajarhat, Kurigram 23/10/12

9 FGD with Chandanpat Union Federation Organizational capacity, management, 
services, advocacy and networking 11 6 17 Sadar, Rangpur 24/10/12

10 FGD with Madhobram Sarderpara Gram 
Samity

Structure of FO, sub-committees, 
principles, services 3 25 28 Madhobram Sarderpara, 

Kurigram 15/01/13

../cont.
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Sl>
no. FGDs>particulars Agenda

No.>of>participants
Venue Date

M F Total

11 FGD with Jatrapur Union Federation Organizational capacity, management, 
services, advocacy and networking 11 2 13 Jatrapur, Kurigram 15/01/13

12 Thethrai Union Federation Organizational capacity, management, 
services, advocacy and networking 9 4 13 Thethrai, Ulipur, Kurigram 16/01/13

13 FGD with Chandripur Gram Samity Structure of FO, sub-committees, 
principles, services 2 28 30 Chandripara, Kawnia, 

Rangpur 16/01/2013

14 FGD with Idilpur Pineapple Producers 
Multipurpose Cooperative Society Ltd.

Structure of FO, sub-committees, 
principles, services 1 11 12 Idilpur, Madhupur, Tangail 17/01/13

15 FGD with Kukua Union Integrated 
Fishermen Cooperative Association Ltd.

Structure, services and sustainability 
after withdrawal of RFLDC’s assistance 11 4 15 Kukua, Amtali, Barguna 22/01/13

16 FGD with Burirchar Union Integrated 
Fishermen Cooperative Association Ltd.

Structure, services and sustainability 
after withdrawal of RFLDC’s assistance 8 4 12 Burirchar, Sadar, Barguna 23/01/13

17 FGD with Uttar Bawalkar Gram Samity Structure and services 1 19 20 Uttar Bawalkar, Badarkhali, 
Barguna Sadar 23/01/13

18 FGD with Monshatoli Gram Samity Structure and services 2 25 27 Monshatoli, Baliatoli, Sadar, 
Barguna 24/01/13

Total 200 178 378

Table>A1.2>  List of key informant interviews

SI>
no. Key>informant> Designation>and>

organization Name>of>project Name>of>related>FO> No.>of>
FOs

Geographic>>
coverage

1 Mr. Nurul Amin Director (operation) ,  
iDE-Bangladesh

ANEP, RED, CLP, CAARP, IMPACT, 
WOTSHAB See numbers 2 and 3 6,000 All over Bangladesh

2

Mr. Susanta Kumar 
Saha

Mr. Mahmud Kabir

Manager- Business 
Development,  
iDE-Bangladesh

Rural Enterprise Development 
(RED), Market Infrastructure 
Development Project in Char 
Regions

Collection point 
marketing center 4

Barisal – Bakerganj, 
Mehendigabj, Hizla & 
Muladi

Patuakhali – 
Dashmina, Bawfal, 
Kalapara & Galachipa

3 Mr. M A Mannan Project Manager, iDE
Women Onset Technology 
for Sustainable Homestead 
Agriculture in Bangladesh

Women Group 50 Ujirpur, Barisal

4 Engr. Kamal Uddin

Regional Project Manager, 
Barisal, IAPP

Cell: 01730-319864

Integrated Agriculture 
Productivity Project (IAPP) Livelihood Field School 12,000 08 districts of Barisal 

and Rangpur Regions

5 Md. Mahbub 
Hassan

Manager- Livelihood,  
Save the Children Nabo Jibon funded by USAID

Household Productive 
Poor (HPP) group

Productive Poor (PP) 
group

Extreme Poor (EP) group

Village Savings and Loan 
Association (VSLA)

3,860 Barisal, Patuakhali, 
Barguna

6 Mr. Shital Krishna 
Das M&E Manager, RFLDC-Barisal Regional Fisheries and Livestock 

Development Component 
funded by DANIDA

Community Based 
Organziation (CBO)

CBO Association

345 Barguna, Bhola, 
Jhalakathi, Pirojpur 
and Barisal7 Mr. Kenneth Hoegh Senior Advisor, RFLDC, Barisal

8 Mr. Shariful Islam 
Khan Program Coordinator, RDRS Core Program Union Federation 361 9 northern districts

9 Ms. Monjusree 
Saha

Head of Programme 
Coordination, RDRS Core program Union Federation 361 9 northern districts

10 Dr. Md. Nurul Islam Project Director, DAE National Agricultural Technology 
Project, DAE Component CIG, UPO, UzPO 13,450 25 districts

11 Mr. Mainur 
Rahman Siddiqui M&E Consultant, DoF National Agricultural Technology 

Project, DoF Component CIG, UPO, UzPO 2,670 25 districts

12 Mr. Harun-ur-
Rashid MIS Consultant, DLS National Agricultural Technology 

Project, DLS Component CIG, UPO, UzPO 3,921 25 districts

13 Dr. S M Monowar Managing Director,  
Hortex Foundation

National Agricultural Technology 
Project, SCDC Component 20 districts
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SI>
no. Key>informant> Designation>and>

organization Name>of>project Name>of>related>FO> No.>of>
FOs

Geographic>>
coverage

14 Dr. A K M 
Aminullah Bhuiyan

Training and Communication 
Specialist 

National Agricultural Technology 
Project, DoF Component CIG, UPO, UzPO 2,670 25 districts

15 Dr. Abu Wali Ragib 
Hassan Programme Manager, DAE DCRMA/CDMP-II – DAE Part Climate Field School 156 26 districts

16 Mr. Raju Ahmed
General Secretary, 
Bangladesh Agro-Processors’ 
Association 

N/A N/A N/A N/A

17 Mr. Abul Hossain Joint Registrar Department of Cooperatives 
(DoC) Farmers’ Cooperatives 83,000 All over Bangladesh

18 Ms. Zebun Nahar Deputy Registrar Department of Cooperatives 
(DoC) Farmers’ Cooperatives 83,000 All over Bangladesh

19 Mr. M Khairul Kabir Legal (Cooperative) Expert Water Cell, DoC Water Management 
Organization 750 All over Bangladesh

20 Mr. Nityananda 
Chakravorty

Institutional/Cooperative 
Specialist  Water Cell, DoC Water Management 

Organization 750 All over Bangladesh

21 Ms. Aroma Dutt Executive Director PripTrust All over Bangladesh

22 Engr. Md. Rezaur 
Rahman Executive Engineer BADC Water User Group All over Bangladesh

23 Engr. Shafiqul 
Islam Asst. Engineer Barind Multipurpose 

Development Authority
Greater Rajshahi 
division

24 Mr. Adwait Kumar 
Roy

Project Coordinator,  
Helvetas Swiss IC Samriddhi Service Providers 

Association 58 Rajshahi and  
Rangpur division

25 Mr. Zenebe Bashaw 
Uraguchi

Adviser, Market Development, 
Helvetas Swiss IC Samriddhi Service Providers 

Association 58 Rajshahi and  
Rangpur division

26 Mr. Shamim 
Hossain

Coordinator, Value Chain, 
Helvetas Swiss IC Samriddhi Service Providers 

Association 58 Rajshahi and  
Rangpur division

27 Mr. Saiful Islam President National Nursery Society

Upazila Nursery Malik 
Samity

District Nursery Malik 
Samity

418 All over Bangladesh

28 Mr. Nurul Islam 
Sarder

Managing Director, Social 
Development Foundation Nuton Jibon Project Gram Samity 3,262 16 districts 

29 Mr. Amirul Islam Manager, Action Aid 
Bangladesh

Food Rights & Sustainable 
Livelihood (FRSL) Policy and 
Campaign

Kendrio Krishok Moitree 828 07 districts 

30 Mr. Alamgir 
Hossain

Program Manager, 
Agriculture and Food Security 
Program, BRAC

Tenant Farmers Development 
Project (BCUP) Village Organization 15,162 46 districts

31 Mr. Shamiran 
Biswas

Manager, Christian 
Commission for Development 
in Bangladesh

N/A Peoples Organization 
(Forum) 920 15 districts

32 Mr. Sadek Hossain Project Director Agricultural Extension 
Component (AEC), ASPS II, DAE ICM Club 16,438 All over Bangladesh

33 Mohammad 
Jahangir Alam Database officer Agricultural Extension 

Component (AEC), ASPS II, DAE ICM Club 16,438 All over Bangladesh

34 Mr. Md. Hamidur 
Rahman Project Director Second Crop Diversification 

Project, DAE
Small Farmers Group 
(SFG) 866 9 districts

35 Dr. Nowsher Ali 
Sarder M&E Specialist Second Crop Diversification 

Project, DAE
Small Farmers Group 
(SFG) 866 9 districts

36 Mr. Masud Alam 
Khan Coordinator, CARE

Food Security for Ultra-Poor  
in the Haor Region  
(FSUP-H Project)

Village Development 
Committee 645

Haor areas of 
Sunamganj, Netrakona 
and Kishoreganj 
districts

37 Dr. Makhan Lal 
Dutt

International Advisor,  
World Vision Bangladesh various Community Based 

Organization (CBO) 27 districts 

38 Engr. Abu Kawser Deputy Controller Bangladesh Technical Education 
Board (BTEB)
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these are the main tools that were used during the exercise to gather information on organizations and their 
capacity needs.

Instrument I:  Format for collection of detailed information from different 
                organizations that work with FOs 

Name of the organization/project

Funded by

Project type Lead Agency

Partners 

Region/location

Duration

Project broad objectives

Sub‐sectors

Working with FOs

No. of beneficiaries No. of FO

Does the project have a mandate 
to federate FOs?

List of groups

Key informant/contact

Instrument II: FO details and capacity needs assessment tool

1.> Basic>information

1.1 Name of FO: ............................................................................................................................................................................................................

1.2 Interview given by:......................................................   Cell: ..................................................................................................................................

1.3 Address   of FO:  ...............................................................................................................................

    Vill: ...............................................................  Union:........................................................

    Upazila: ........................................................  District: ......................................................

    Contact person: ............................................  Cell: ...........................................................

Annex 2
Mapping instruments
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1.4 Date established:  ...................................................................................................................................................................................................

1.5 Geographical area of operation: .............................................................................................................................................................................

1.6 Registered with which GO agency:   DSS / DC / DYD / JS

 Under the Act of: ....................................................................................................................................................................................................

 [e.g. According to Societies Registration Act, 1860]

1.7 If not registered do you have a plan for registration:    yes/no

1.8 If yes, from which agency:   DSS / DC / DYD / JS

1.9 Did you face any barrier in getting registration?:           yes/no

1.10 If yes, please mention:............................................................................................................................................................................................

2.> Typology

2.1 Typology (by formation) FO/PG/FG/CBO/CSO/VSLA/Association/Credit group/ 
  Self Helped Group (formed by own initiative)/federated

2.2 Typology (by assistance): GoB assisted/GoB Revenue Project assisted/GoB Foreign Aided Project assisted/  
  NGO assisted (own)/NGO project assisted(GoB)/NGO project assisted (Donor)/ 
  project assisted by Donor/INGO assisted

2.3 Name of assisting agency and donor: .....................................................................................................................................................................

3.> >Organizational>documents

3.1 Could you please share with us the following organizational documents if available:

Issues Present Non>present Main>point

Memorandum of Articles/Constitution

          Vision/Mission

          Goal

List of Executive/Convener Committee with 
related meeting resolution

Periodic change of EC with minutes

Membership Policy

Gender Policy

Business Operational Policy

Meeting minutes/resolution Register

Evidence of bank accounts

Cash book and ledger

Others, please specify

4.>> Organization’s>structure>(please>draw)
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5.> >Organization’s>support>and>source>of>fund

Types>of>support>(grant,>credit,>etc.) Amount/in>kind Period>covered Source>of>fund/donor/project

6.> >Affiliation/network>(please>specify>as>below)

6.1  Partnership/linkage (in country cooperation with Government/NGO/INGO/federated FOs/Coop)

What>major>partnerships>or>linkages>does>your>organization>have?>Please>specify.

Local level:

Regional level:

National level:

6.2  Partnership/linkage (with private sector)

What>major>partnerships>or>linkages>does>your>organization>have>with>private>sector>and>why?>Please>specify.

Local level:

Regional level:

National level:

6.3  Policy dialogue

In>what>Government>department>or>project>does>your>organization>participate>to>discuss>policy?

1. 

2.

3.

4.

6.4  Research issues

What>are>the>major>partnerships>with>research>institutes>and>universities?>Please>specify.

1. 

2.

3.

4.

7.> >Membership

7.1  How many members do you have as of September 2012? Please provide the breakdown.

Male Female Total

Farmers

Others (RNFS)

Total

RNFS – Rural Non-Farm Sector
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8.> >>Programmes

8.1  What are the major programmes and services being offered by the organization to its membership?  
 Who are entitled to benefit from these programmes/services?

Service>(e.g.>training,>inputs>supply,>
credit,>linkage,>business>operation,>etc.)

Target>beneficiaries>(e.g.>
women,>youth,>crop>farmers,>
fishers,>livestock>rearers,>etc.)

No.>of>members>availed Status>(ongoing/completed>year)

9.> >Assets

9.1  What are the assets, facilities, equipment of the FO? Please specify.

Assets/facilities/equipment Capacity/size Operational/non-operational

10.> >Land

10. 1 What is the status of member in terms of land ownership and access?

Membership
Land/natural>resource>ownership>(please>provide>estimates>only>in>terms>of>%)

Leased>in Shared>tenancy Khas> owned

Farmers

other

11.> >Livelihood

11. 1 What is the major source of livelihoods of the members? Please specify.

Farming>community
Major>source>of>livelihood>
(please>provide>estimates>
only>in>terms>of>percentage)

Average>farm>size>of>
the>members,>dec

Is>there>any>bulk>of>
production>produced>by>
the>members

If>yes,>name>of>crop/fishes/
livestock/value>added>products

Crop farmers

Fishers

Livestock rearers

Others 

12.> >Marketing

12. 1 What are your existing marketing initiatives? 

Marketing>initiative No.>of>members>
involved

Volume>
handled

Where>do>you>sell>product/
service Problems
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13.> >Constraints

13.1  Mention major constraints associated with managing your organization.

Issues> Please>specify>constraint>associated>
with>each>issue Services>that>address>constraints

1. Registration of FOs

2. Leadership

3. Infrastructure

4. Administration and management

5. Financial Management

6. Coordination, advocacy and partnership

7. Women’s empowerment

8. Access to information, access to markets, ,access to finance

14.> >Assistance>withdrawal

14. 1 If the project/agency (as mentioned in 2.3) withdraws their assistance, would the FO be able to sustain itself?  
 If not, how long it will take to become sustainable?

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

15.> >Policy

15.1  Express your candid opinion in the area of policy, law that may foster FO operations?

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

  ...............................................................................................................................................................................................................................
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Instrument III: Checklist for Key Informants relevant to the enabling environment  
                  of FOs

1. Name of agency: ....................................................................................................................................................................................................

2. Name of interviewee: .........................................................................................................................Designation: ................................................

3. Agency mandate: ...................................................................................................................................................................................................

 (agency might provide many services, this section deals only with registration and assistance services relevant with FOs)

 3.1   Registration to FOs: .........................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

 3.2  Assistance to FOs: ............................................................................................................................................................................................

  ...............................................................................................................................................................................................................................

4. Discuss with the KI about the constraints revealed in Instrument II (section 13) 

Issues Services>provided>by>your>agency>that>address>constraints

1.  Registration of FOs

2.  Leadership

3.  Infrastructure

4.  Administration and management

5.  Financial Management

6.  Coordination, advocacy and partnership

7.  Women empowerment

8.  Access to information, access to market, access to finance



64

a
n

n
ex 3: syllab

u
s o

f d
ip

lo
m

a in
 a

g
ricu

ltu
re o

f a
tis

Farm
ers’ o

rg
an

izatio
n

s in
 B

an
g

lad
esh

: a
 M

ap
p

in
g

 an
d

 c
ap

acity a
ssessm

en
t

language of instruction: Bengali

Name>of>subject
Total>marks

Total>credit
Theory Practical

1st>Semester
Introduction to Agriculture & Principles of Production 100 50 3
Bengali 150 00 3
Chemistry-1 150 50 4
Mathematics 150 00 4
Biology-1 100 50 3
Physics-1 100 50 3
English-1 100 50 3
Total 850 250 23
2nd>Semester
Field Crop Cultivation 150 50 4
English-2 100 50 3
Chemistry-2 150 50 4
Biology-2 100 50 3
Physical Training 00 50 1
Physics-2 100 50 3
Vegetable Cultivation  150 50 4
Total 750 350 22
3rd>Semester
Field Crop Cultivation 150 50 4
Computer Science 0 100 2
Rearing Animals 100 50 3
Pisciculture Management 100 50 3
Soil Science-1 100 50 3
Horticulture Management3 100 50 4
Fruit Cultivation 150 50 4
Total 700 400 23
4th>Semester
Poultry Rearing 100 50 3
Soil Science-2 150 50 4
Agriculture Extension-1 100 50 3
Plant Nutrition and Fertilizer Management 150 50 4
Forest and Forestation 100 50 3
IPM Management-1 150 50 4
Development of life and Psychology 100 50 3
Total 850 350 24

Annex 3
Syllabus of Diploma in Agriculture of ATIs
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Name>of>subject
Total>marks

Total>credit
Theory Practical

5th>Semester
Seed Technology 100 50 3
Vegetable Cultivation-2 100 50 3
Nursery Forest and Forestation 100 50 3
Computer Science 100 50 2
Irrigation Management 100 50 3
IPM Store pest and Rodents Control-2 100 50 3
Fruit Cultivation -2 100 50 3
Agriculture Economic 50 50 2
Total 700 400 22
6th>Semester
Agriculture Mechanization  (Farm Power) 100 50 3
Soil and Soil Management 100 50 3
Crop Pest and Control 100 50 3
Agriculture Extension-2 100 50 3
Fruit and Vegetable Processing 100 50 3
Poultry disease management 100 50 3
Heifer, Milking cow and goat rearing 50 50 2
Improvement of livestock 50 50 2
Total 700 400 22
7th>Semester
Agro Forestry and Bio diversity 100 50 3
Soil and Use of Soil Resources 100 50 3
Agrobased Food 100 50 3
Self Employment (Entrepreneurship development) 50 50 2
Agricultural Mechanization (Farm Machinery) 100 50 3
Statistics 100 50 3
Progress of Agricultural Development in Bangladesh 100 50 2
Principles of Education, Method and Evaluation 50 50 2
Total 700 400 21
8th>Semester 6
Internship  attached with DAE

nB: grey shaded bars show areas for improvement in the curriculum.
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the report gives an overview of the many organizations met during the exercise. the following four annexes 
(4-7) are for those who are looking for further information about related projects, geographical distribution 
and other details collected throughout the process. 

Adarsha Chashi Unnayan Samity

Geographical coverage

the organization is present in all unions of charfasson upazila in Bhola district.

Andulbaria Multipurpose Vegetables Seed Production Cooperative Society Ltd.

Geographical coverage

the geographical coverage of this organization is limited to andulbaria union in Jibon nagar upazila in 
chuadanga district.

Idilpur Anarosh Chashi Bahumukhi Samobay Samity Ltd. (Pineapple Producers Association)

in 1942, local garo14 leader Mr. Jevier chishim brought 750 pineapple saplings from Meghalaya, india to idilpur 
village in Madhupur upazila. this was the beginning of pineapple cultivation in the area. since then pineapple 
cultivation has become popular all over the Madhupur area. Prior to the introduction of pineapple, the area 
was barren and food and nutrition insecurity was very high. after introducing pineapple and other crops like 
turmeric, ginger and papaya, the livelihoods of the people in the area started to improve. But this improvement 
did not last long. 

as the amount of land under production increased, input costs also increased. the farmers did not have 
enough money to cover these increasing expenses. during the late 1960s, dadunders (money lenders who 
accept pineapples for repayment of loans, though at a pre-fixed, low price) came and provided credit to the 
poor farmers for pineapple production. though pineapple production increased greatly, the farmers were 
unable to reap the benefits because they had to sell at a low pre-fixed price to the dadunders.

“We are now providing information and advice to our fellow farmers to produce also ginger, turmeric and 
arum after pineapple harvesting to benefit from the residual fertilizer from application during pineapple 
cultivation. We also recommend them to grade their produce, as brokers will pay a higher price for graded 
uniform pineapples,” said Mr. Mafiz uddin Fakir, President of the cooperative.

14 ‘Garo’ refers to a local indigenous group.

Annex 4
Extra details on autonomous farmers’ organizations
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information in this annex is directly linked to the different sections of the main report. it is organized by 
extension agency and by project. 

Table>A5.1   Summary of agency-wise distribution of FOs

Extension>agencies No.>of>FOs Members

DAE 43,765 Crop farmers

DLS 5,603 Livestock rearers

DoF 3,520 Fisherfolk

BADC 18,073 Water users

MoLG&C 2,272 Char-lander

SDF 3,262 Poorest women

DoC 83,853 Multi

Total 160,348

Bangladesh Agricultural Development Corporation

Badc is the largest government organization involved in irrigation schemes/projects in Bangladesh.

Table>A5.2   Division-wise distribution of WUG of BADC (estimated)15

Sl>no. Division15 DTW>scheme>(no.) Low>lift>pump>scheme>(no.) No.>of>WUG>(estimated)

01 Dhaka 5,641 1,083 6,724

02 Rajshahi 4,035 94 4,129

03 Chittagong 1,586 2,251 3,837

04 Khulna 2,550 16 2,566

05 Sylhet 17 241 258

06 Barisal* 1 328 329

Total 13,830 4,013 17,843

Source: Minor Irrigation Survey Report 2010-11, BADC, June 2011.
* This division overlaps with the IAPP.

15 Old division-wise break-up, data of Rangpur division inserted in Rajshahi division.

Annex 5
Extra details on farmers’ organizations formed with
support from Government Agencies
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Table>A5.3   One DTW Scheme cost (rough field estimate) - amounts in BDT

Cost>item BADC>investment WUG>investment Remarks

Pump cost 1,000,000/- -

Civil works 500,000/- -

Electricity connection 350,000/- 15,000/- At a time

Irrigation canal 1,000,000/- 15,000/- at a time

Pump/scheme rent 15,000/- yearly

Department of Agricultural Extension (DAE)

as an apex extension agency in the field of crops, dae works with a large number of farmers’ groups through 
different donor-funded projects. the approach of dae differs from project to project, with no one unified 
extension approach.

Table>A5.4   FOs formed with support from DAE 

Major>DAE>projects>in>Bangladesh>
(2004-present)>period> Name>of>FO Project> Major>source>>

of>funding>
Upazilas>
covered>

Farmers>
benefited

2001-2013 ICM Club, UNFA Agricultural Extension Component (AEC) Danida 329 2,000,000

2004-2009 SFG & FMG North-west Crop Diversification Project (NCDP) ADB 60 240,430

2008-2013 CIG National Agricultural Technology Project (NATP) IDA & IFAD 120 269,000

2010-2014 CFS Disaster and Climate Risk Management in 
Agriculture (DCMRA) Project Multi donor 52 8,500

2010-2015
LFS, Livestock 
rearers Group, 
fishers group

IAPP: Integrated Agricultural Productivity 
Project (DAE part) GAFSP 120 200,000

2011-2015 SFG Second Crop Diversification Project (SCDP) ADB 52 240,000

Total 733 2,957,930

CFSs Under the Disaster and Climate Risk Management in Agriculture Project

Project summary 

the dcrMa project is implemented by the 
comprehensive disaster Management Programme 
(cdMP-ii), of the disaster Management and relief 
division, of the Ministry of disaster Management 
(ModM) in collaboration with the dae. the dcrMa 
project aims to strengthen disaster and climate 
risk management capacities of the dae to ensure 
sustainable livelihoods and food security. the project 
covers 52 upazilas in 26 districts of different agro-
ecological zones (aezs) of Bangladesh, that are 
affected by flood, flash flood, salinity, water logging 
and/or drought. 

KEy>FEATURES

Project:>DCRMA

Funded>by:>UKaid,>EU,>Norweigan>Embassy,>SIDA,>
AusAid,>UNDP.

Duration:>2011-2015

Name>of>FO:>>Climate>Field>Schools

Total>CFSs:>156

Geo.>coverage:>5>regions
Innovation:>Technology>to>mitigate>climate>change
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Table>A5.5   CFS distribution over administrative unit and climatic division

Region District* Upazila* No.>of>CFS Climatic>division

Rajshahi 5 10 30 Drought prone

Jessore 1 2 6 Coastal salinity prone

Barisal**
4 8 24 Coastal salinity prone (including water logged area)
2 4 12 Flood prone (including water logged area)

Chittagong 3 6 18 Coastal salinity prone (including water logged area)

Rangpur** 3 6 18 Flood prone (including water logged area)

Mymensingh
2 4 12 Flood prone (including water logged area)
2 4 12 Flash flood prone area

Dhaka 1 2 6 Flood prone (including water logged area)

Sylhet 3 6 18 Flash flood prone area

Total 26 52 156 5>climatically>critical>areas

Source: DCMRA Project, DAE, 2012.
* These figures represent the total number of districts and upazilas in each region.
** These regions overlap with the IAPP.

District- and Upazila-wise CFS distribution over administrative unit and climatic division

Table>A5.6   Drought prone area

CFS>Code Name>of>CFS Upazila District Region

DP-001 Bianabona

1. Godagari

1. Rajshahi

Rajshahi

DP-002 Delsadpur

DP-003 Tilibag

DP-004 Headbilli

2. TanoreDP-005 Moyenpur

DP-006 Sadipur

DP-007 Shibpur Shiala

3. Nachole

2. Chapainowabganj

DP-008 Sabdalpur

DP-009 Nezampur

DP-010 Lebudanga

4. GomostapurDP-011 Borodadpur

DP-012 Khorkadanga

DP-013 Batikamari

5. Bagatipara

3. Natore

DP-014 Machimpur

DP-015 Noyapara

DP-016 Fulbari Barpara

6. LalpurDP-017 Budhirampur

DP-018 Balititapur

DP-019 Dakhshin Kanupur Nouduari

7. Akkelpur

4. Joypurhat

DP-020 Ghanipur

DP-021 Narikeli

DP-022 Talukderpara Matrai

8. KalaiDP-023 Deogram

DP-024 Itail

DP-025 Sreekrishnapur

9. Porsha

5. Naugaon

DP-026 Dowarpal

DP-027 Shila

DP-028 Sreekrishna

10. SapaharDP-029 Shisha

DP-030 Dowarpal
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Table>A5.7   Coastal saline-prone area (including water logged area)

CFS>Code Name>of>CFS Upazila District Region

SP-031 Lakhsmikhola Purba Para

11. Dacope

6. Khulna Jessore

SP-032 Chalna Purba Para

SP-033 Kocha

SP-034 Sreepur

12. TerokhadaSP-035 Patla

SP-036 Ajgoba

SP-037 Madhya Rajpasha

13. Bhandaria

7. Pirojpur

Barisal

SP-038 Purba Gouripur

SP-039 Bepary and Hawlader Para

SP-040 Paschim Choto Buishakathi

14. NajirpurSP-041 Vimkathi

SP-042 Bhaijora

SP-043 Mahmudpur

15. Satkhira Sadar

8. Satkhira

SP-044 Machghola

SP-045 Darbasistaya

SP-046 Ismailpur

16. ShyamnagarSP-047 Uttar Atulia

SP-048  

SP-049 Purba Shankarpur

17. Chatkhil

9. Noakhali

Chittagong

SP-050 Uttar Ramnarayanpur

SP-051 Baroipara

SP-052 Katabunia

18. SubarnacharSP-053 Charjobbor

SP-054 Bogarbazar

SP-055 Shyamalgram

19. Ramgati

10. Lakhsmipur

SP-056 Borkheri

SP-057 Purba Charsita

SP-058 Purba Charbongshi

20. RaypurSP-059 Kazir Char

SP-060 Char Kachia

SP-061  

21. Kolapara

11. Patuakhali

Barisal

SP-062  

SP-063  

SP-064  

22. MirjaganjSP-065  

SP-066  

SP-067 Choto Bahibdia

23. Fakirhat

12. Bagerhat

SP-068 Mulghar

SP-069 Joypur Betaga

SP-070 Golbunia

24. ShoronkholaSP-071 Kodomtola

SP-072 Uttar Rajoir

SP-073 Hakder Para

25. Kutubdia

13. Cox's Bazar Chittagong

SP-074 Kiran Para

SP-075 Rumai Para

SP-076  

26. ChokoriaSP-077  

SP-078  
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Table>A5.8   Flood-prone area (including water logged area)

CFS>Code Name>of>CFS Upazila District Region

FP-079 Ojir Dharani Bari

27. Gaibandha Sadar 

14. Gaibandha

Rangpur

FP-080 Madhya Moksedpur

FP-081 Purba Balaghata

FP-082 Uttar Kakoishabaha

28. SundarganjFP-083 Paschim Rajibpur

FP-084 Purba Baidyanath

FP-085  

29. Chilmari

15. Kurigram

FP-086  

FP-087  

FP-088 Purba Ghaniarampur

30. RoumariFP-089 Mennagar Preddar Para

FP-090 Bahur Banda

FP-091 Kakoi Bunia

31. Gongachora

16. Rangpur

FP-092 Gopalpur

FP-093 Bashuria

FP-094  

32. TaraganjFP-095  

FP-096  

FP-097  

33. Tungipara

17. Gopalganj Barisal

FP-098  

FP-099  

FP-100 Parkona

34. KotaliparaFP-101 Burua

FP-102 Amtoli

FP-103 Choto Mousha

35. Sokhipur

18. Tangail

Mymensingh

FP-104 Chilimpur

FP-105 Paharpur

FP-106 Amirpur

36. DhonbariFP-107 Sandalpur

FP-108 Baghil

FP-109 Dighalkandi

37. Dewanganj

19. Jamalpur

FP-110 Char Bhabotosh Bhati

FP-111 Takimari

FP-112 Laodutta

38. IslampurFP-113 Sirajabad

FP-114 Patholi Purba Para

FP-115  

39. Harirampur

20. Manikganj Dhaka

FP-116  

FP-117  

FP-118 Baitara

40. DaulatpurFP-119  

FP-120  

FP-121 Chaturpara

41. Madaripur Sadar

21. Madaripur Barisal

FP-122 Nouhata

FP-123 Pangshinathdi

FP-124 Char Bandar Pasha

42. RajoirFP-125 Sormangal

FP-126 Suterkandi
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Table>A5.9   Flash flood-prone area

CFS>Code Name>of>CFS Upazila District Region

FFP-127 Radhanagar

43. Sunamganj sadar

22. Sunamganj

Sylhet

FFP-128 Gerong

FFP-129 Mogaipar Adivashi

FFP-130 Abur Hat

44. JamalganjFFP-131 Bhuiyar Hat

FFP-132 Golampur

FFP-133 Dakhsin Koula Bhotragram

45. Kulaora

23. Moulvibazar

FFP-134 Bhobanipur Bhotragram

FFP-135 Shigur

FFP-136 Monarai

46. BorolekhaFFP-137 Saldia

FFP-138 Kamilpur

FFP-139 Shyampur

47. Baniachong

24. Habiganj

FFP-140 Jatrapasha

FFP-141 Hossainpur

FFP-142 Somipur

48. AjmiriganjFFP-143 Kalnipara

FFP-144 Atpara

FFP-145 Guhiala

49. Barhatta

25. Netrakona

Mymensingh

FFP-146 Bri-adadia

FFP-147 Kodom deola

FFP-148 Gakhagora

50. KolmakandaFFP-149  

FFP-150  

FFP-151 Pora gaon

51. Nalitabari

26. Sherpur

FFP-152 Begpara

FFP-153 Paghora Kandi

FFP-154 Paschim Gojaripara

52. JhenaigatiFFP-155 Khagrakona

FFP-156 Protapnagar

CIGs Under the National Agricultural Technology Project– DAE Component

Project summary

the national agricultural technology Project 
(natP) is the first five-year phase of a long-
term (15 year) programme of the government 
of Bangladesh (goB) to support its strategy 
to increase national agricultural productivity 
and farm incomes. the project has four 
components: i) agricultural research support; 
ii) agriculture extension support (aes); iii) supply 
chain development (scdc); and iv)  project 
management and coordination. 

under the natP, farmers are organized into cigs, 
which are the main vehicle of components of 
(i) aes; and (ii) scdc. aes is being implemented 
by the Project implementation units (Pius) of 

KEy>FEATURES

Project:>NATP/DAE>Component
Funded>by:>IDA,>IFAD>&GoB
Duration:>2008-2013>(Phase>I)
Name>of>FO:>>CIG
Name>of>Federation:>UPO,>UzPO
Total>Crop>CIG:>13,450;>4.035>female>only
Total>UPO:>1,345
Total>UzPO:>120
Geo.>coverage:>120>upazila>of>25>districts
Innovation:>Federating>FOs>at>union>and>upazila>level,>
dissemination>of>demand-led>technologies,establishment>
of>Farmers>Information>and>Advice>Centres.
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the dae, doF and dls, while scdc is being implemented by the hortex Foundation16 of the Moa. the purpose 
of the scdc is to support cigs and producers organizations in 22 selected upazilas (table a5.9). the support 
is on quality production through group/contract farming, post-harvest loss reduction, farmer-trader linkages, 
entrepreneurship development, and capacity development of the different actors involved in the high-value 
crop supply chain.

Table>A5.10   District-wise CIGs, UPOs and UzPOs distribution under NATP-DAE component 

Sl.>no. District Upazila* Union* Pouroshova* Crop>CIG UPO UzPO

1 Mymensingh 8 105 3 1,080 108 8

2 Kishoreganj 4 33 4 370 37 4

3 Sherpur 3 31 3 340 34 3

4 Tangail 8 66 7 730 73 8

5 Gazipur 4 36 4 400 40 4

6 Narsingdi 5 46 5 510 51 5

7 Dhaka 2 28 2 300 30 2

8 Comilla 6 66 6 720 72 6

9 B.Baria 4 46 4 500 50 4

10 Chandpur 4 48 4 520 52 4

11 Chittagong 6 93 6 990 99 6

12 Cox'bazar 3 27 2 290 29 3

13 Sylhet 6 47 2 490 49 6

14 Moulvibazar 6 61 5 660 66 6

15 Kushtia 4 43 4 470 47 4

16 Jhenaidah 3 33 3 360 36 3

17 Jessore 8 91 8 990 99 8

18 Khulna 5 45 2 470 47 5

19 Satkhira 3 38 2 400 40 3

20 Rajbari 3 31 2 330 33 3

21 Faridpur 3 26 1 270 27 3

22 Natore 4 41 6 470 47 4

23 Bogra 6 58 6 640 64 6

24 Dinajpur 6 55 3 580 58 6

25 Rangpur** 6 68 3 710 71 6

Total 120 1,262 97 13,590 1,359 120

Source: PIU, NATP-DAE, November 2012.
* These figures represent the total number of upazilas, unions and pouroshovas (municipalities) in each district.
** This district overlaps with the IAPP.

16 Horticulture Export Development Foundation, in short, Hortex Foundation. It was established in 1993 at the patronage of the Ministry of Agriculture as a non-profit organization.
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Table>A5.11>  Upazila-wise CIGs, UPOs and UzPOs distribution under NATP-DAE, DLS and DOF component

Sl# District Sl># Upazila No.>of>union  Crop>
CIG 

L->CIG F-CIG Total>
CIG 

UPO UzPO Hortex>>
assisted>>

CIGs*        Union P-shava Total        

1 Mymensingh 1 M. Sadar 13 1 14 140 39 28 207 14 1  

    2 Trishal 12 0 12 120 36 26 182 12 1 20

    3 Phulbaria 13 0 13 130 39 28 197 13 1  

    4 Phulpur 20 0 20 200 63 42 305 20 1  

    5 Goforgaon 15 1 16 160 45 32 237 16 1  

    6 Haluaghat 12 0 12 120 36 24 180 12 1  

    7 Gouripur 10 0 10 100 30 20 150 10 1  

    8 Muktagacha 10 1 11 110 30 20 160 11 1  

      Sub-total 105 3 108 1,080 318 220 1,618 108 8 20

2 Kishoreganj 9 K. Sadar 11 1 12 120 33 24 177 12 1  

    10 Bhairob 7 1 8 80 24 16 120 8 1  

    11 Kuliarchor 6 1 7 70 21 12 103 7 1  

    12 Kotiadi 9 1 10 100 27 18 145 10 1  

      Sub-total 33 4 37 370 105 70 545 37 4 20

3 Sherpur 13 Nalitabari 12 1 13 130 39 26 195 13 1  

    14 Shreebordi 10 1 11 110 33 22 165 11 1  

    15 Nokla 9 1 10 100 30 18 148 10 1  

      Sub-total 31 3 34 340 102 66 508 34 3  

4 Tangail 16 Tangail Sadar 11 1 12 120 36 24 180 12 1  

    17 Modhupur 6 1 7 70 21 14 105 7 1  

    18 Bhuapur 6 1 7 70 18 14 102 7 1  

    19 Delduar 8 0 8 80 24 16 120 8 1 20

    20 Ghatail 11 1 12 120 33 24 177 12 1  

    21 Kalihati 11 1 12 120 36 30 186 12 1  

    22 Shokhipur 6 1 7 70 21 12 103 7 1  

    23 Gopalpur 7 1 8 80 24 14 118 8 1  

      Sub-total 66 7 73 730 213 148 1,091 73 8  

5 Gazipur 24 G. Sadar 8 2 10 100 30 20 150 10 1  

    25 Kaliakoir 9 1 10 100 27 20 147 10 1 20

    26 Kapasia 11 0 11 110 33 22 165 11 1 20

    27 Shreepur 8 1 9 90 27 16 133 9 1  

      Sub-total 36 4 40 400 117 78 595 40 4  

6 Norsingdi 28 N. Sadar 14 2 16 160 42 20 222 16 1  

    29 Belabo 8 0 8 80 24 16 120 8 1 20

    30 Monohordi 11 1 12 120 33 24 177 12 1  

    31 Shibpur 9 1 10 100 27 20 147 10 1 20

    32 Polash 4 1 5 50 12 8 70 5 1  

      Sub-total 46 5 51 510 138 88 736 51 5  

7 Dhaka 33 Savar 12 1 13 130 36 26 192 13 1 20

    34 Dhamrai 16 1 17 170 48 34 252 17 1  

      Sub-total 28 2 30 300 84 60 444 30 2  
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Sl# District Sl># Upazila No.>of>union  Crop>
CIG 

L->CIG F-CIG Total>
CIG 

UPO UzPO Hortex>>
assisted>>

CIGs*        Union P-shava Total        

8 Comilla 35 C.A. Sadar 6 1 7 70 24 16 110 7 1 20

    36 Daudkandi 15 1 16 160 45 32 237 16 1  

    37 Chandina 13 1 14 140 39 26 205 14 1 20

    38 Laksham 7 1 8 80 24 16 120 8 1  

    39 Nangolcoat 12 1 13 130 33 24 187 13 1  

    40 Chouddogram 13 1 14 140 42 26 208 14 1  

      Sub-total 66 6 72 720 207 140 1,067 72 6  

9 Brahmonbaria 41 Br. Sadar (5) 11 1 12 120 63 44 227 12 1  

    42 Akhaura 5 1 6 60 18 12 90 6 1  

    43 Koshba 10 1 11 110 30 22 162 11 1  

    44 Nobinagar 20 1 21 210 63 40 313 21 1  

      Sub-total 46 4 50 500 174 118 792 50 4  

10 Chandpur 45 Ch. Sadar 14 1 15 150 42 28 220 15 1  

    46 Haziganj 11 1 12 120 33 24 177 12 1  

    47 Shahorasti 9 1 10 100 27 18 145 10 1  

    48 Motlob Uttor 14 1 15 150 36 26 212 15 1  

      Sub-total 48 4 52 520 138 96 754 52 4  

11 Chittagong 49 Meerershorai 16 2 18 180 48 36 264 18 1 20

    50 Hathazari 15 1 16 160 30 30 220 16 1  

    51 Anowara 11 0 11 110 33 22 165 11 1  

    52 Potia 22 1 23 230 66 46 342 23 1  

    53 Sandeep 14 1 15 150 45 30 225 15 1  

    54 Rangunia 15 1 16 160 30 30 220 16 1  

      Sub-total 93 6 99 990 252 194 1,436 99 6  

12 Cox's Bazar 55 Cx. Sadar 10 1 11 110 30 22 162 11 1  

    56 Ramu 11 0 11 110 33 22 165 11 1  

    57 Teknuf 6 1 7 70 18 8 96 7 1  

      Sub-total 27 2 29 290 81 52 423 29 3  

13 Sylhet 58 Syl. Sadar 8 0 8 80 24 16 120 8 1  

    59 Golapganj 11 1 12 120 33 22 175 12 1  

    60 Biyanibazar 10 1 11 110 33 20 163 11 1  

    61 Jaintapur 6 0 6 60 18 12   6 1  

    62 Fenchugonj 3 0 3 30 9 6   3 1  

    63 Dokhhin Surma 9 0 9 90 27 18   9 1  

      Sub-total 47 2 49 490 144 94 458 49 6  

14 Moulvibazar 64 M. Sadar 12 1 13 130 36 24   13 1  

    65 Kulaura 13 1 14 140 39 26   14 1  

    66 Borolekha 10 1 11 110 30 20   11 1  

    67 Shreemongal 9 1 10 100 27 20   10 1 20

    68 Komolganj 9 1 10 100 27 20   10 1  

    69 Rajnagar 8 0 8 80 24 16   8 1  

      Sub-total 61 5 66 660 183 126 0 66 6   

15 Kushtia 70 Kushtia sadar 14 1 15 150 42 28   15 1  

    71 Bheramara 6 1 7 70 21 14   7 1  

    72 Mirpur 12 1 13 130 39 28   13 1  

    73 Kumarkhali 11 1 12 120 33 22   12 1  

      Sub-total 43 4 47 470 135 92 0 47 4  
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Sl# District Sl># Upazila No.>of>union  Crop>
CIG 

L->CIG F-CIG Total>
CIG 

UPO UzPO Hortex>>
assisted>>

CIGs*        Union P-shava Total        

16 Jhenaidah 74 Jh. Sadar 17 1 18 180 54 36   18 1  

    75 Kaliganj 11 1 12 120 36 24   12 1  

    76 Coat Chandpur 5 1 6 60 18 12   6 1  

      Sub-total 33 3 36 360 108 72 0 36 3  

17 Jessore 77 Jes.Sadar 15 1 16 160 48 32   16 1 20

    78 Chougacha 11 1 12 120 33 22   12 1  

    79 Abhoynagar 8 1 9 90 27 16   9 1  

    80 Sharsha 11 1 12 120 33 24   12 1  

    81 Bagharpara 9 1 10 100 27 20   10 1  

    82 Monirampur 17 1 18 180 51 34   18 1  

    83 Keshobpur 9 1 10 100 27 18   10 1  

    84 Jhikorgacha 11 1 12 120 33 22   12 1 20

      Sub-total 91 8 99 990 279 188 0 99 8  

18 Khulna 85 Dacope 9 1 10 100 30 20   10 1  

    86 Paikgacha 10 1 11 110 30 20   11 1  

    87 Botiaghata 7 0 7 70 21 14   7 1  

    88 Dumuria 14 0 14 140 42 28   14 1  

    89 Rupsha 5 0 5 50 15 10   5 1  

      Sub-total 45 2 47 470 138 92 0 47 5  

19 Satkhira 90 Satkhira Sadar 14 1 15 150 45 28   15 1  

    91 Kolarowa 12 1 13 130 39 26   13 1  

    92 Tala 12 0 12 120 36 24   12 1  

      Sub-total 38 2 40 400 120 78 0 40 3  

20 Rajbari 93 Rajbari sadar 14 1 15 150 45 30   15 1  

    94 Baliakandi 7 0 7 70 21 14   7 1  

    95 Pangsha(7) 10 1 11 110 54 36   11 1  

      Sub-total 31 2 33 330 120 80 0 33 3  

21 Faridpur 96 Faridpur Sadar 11 1 12 120 33 24   12 1  

    97 Modhukhali 9 0 9 90 27 18   9 1  

    98 Alfadanga 6 0 6 60 18 12   6 1  

      Sub-total 26 1 27 270 78 54 0 27 3  

22 Natore 99 Natore Sadar 12 2 14 140 42 28   14 1  

    100 Boraigram 7 2 9 90 21 18   9 1 20

    101 Lalpur 10 1 11 110 30 20   11 1  

    102 Shingra 12 1 13 130 36 24   13 1 20

      Sub-total 41 6 47 470 129 90 0 47 4  

23 Bogra 103 Bogra Sadar 11 1 12 120 33 22   12 1 20

    104 Shibganj 12 1 13 130 39 26   13 1 20

    105 Sherpur 9 1 10 100 30 20   10 1  

    106 Sonatola 7 1 8 80 24 16   8 1  

    107 Kahalu 9 1 10 100 30 20   10 1  

    108 Dhunot 10 1 11 110 30 20   11 1  

      Sub-total 58 6 64 640 186 124 0 64 6  

24 Dinajpur 109 D. Sadar 10 1 11 110 30 22   11 1  

    110 Parbotipur 10 1 11 110 30 20   11 1 20

    111 Khansama 6 0 6 60 18 12   6 1  

    112 Kaharole 6 0 6 60 18 12   6 1  

    113 Chirirbondor 12 0 12 120 36 24   12 1  

    114 Beerganj 11 1 12 120 33 22   12 1 20

      Sub-total 55 3 58 580 165 112 0 58 6  
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Sl# District Sl># Upazila No.>of>union  Crop>
CIG 

L->CIG F-CIG Total>
CIG 

UPO UzPO Hortex>>
assisted>>

CIGs*        Union P-shava Total        

25 Rangpur 115 Rangpur Sadar 11 1 12 120 33 24   12 1  

    116 Peerganj 15 0 15 150 45 30   15 1 20

    117 Peergacha 9 0 9 90 27 18   9 1  

    118 Mithapukur 17 0 17 170 51 34   17 1  

    119 Bodorganj 10 1 11 110 30 20   11 1  

    120 Kaunia 6 1 7 70 21 12   7 1  

      Sub-total 68 3 71 710 207 138 0 71 6  

      Total 1,262 97 1,359 13,590 3,921 2,670   1,359 120 440

ICM clubs and UNFAs under DANIDA’s Agricultural Sector Programme Support

Project summary

danida has been supporting the agriculture sector in 
Bangladesh for over 30 years. the support was first organized 
into a sector Programme support (sPs) framework in 2000 
with the commencement of the first phase of the agriculture 
sector Programme support (asPs). the second phase of asPs 
consists of three components, one of which is the agriculture 
extension component (aec), anchored in the Field services 
Wing of the dae. the aec has been implementing an integrated 
crop Management (icM) approach through three organizations: 
the Bangladesh  agricultural research institute for technology 
generation, the seed Wing of the Moa for certification through 
sca and ensured supply chain of quality seed and the agricultural 
information service (ais) for information dissemination. 

Table>A5.12   Regional distribution of ICM clubs/farmers’ organizations

Region District>(>no.)* Upazila>(>no.)* ICM>Club>(no.)

Barisal** 11 54 2,782

Chittagong 11 48 2,000

Dhaka 12 54 2,931

Khulna 10 34 2,036

Rajshahi 8 67 3,336

Rangpur** 8 57 2,800

Sylhet 4 15 553

Total 64 329 16,438

Source: AEC, DAE, October 2012.
* These figures represent the total number of districts and upazilas in each region.
** The following upazillas of AEC overlap with IAPP: From Barisal division: Barisal, Patuakhali and Barguna. From Rangpur division: Rangpur, Nilphamari, Lalmonirhat and Kurigramp. Despite  
      the overlap, these two projects have different approaches.

KEy>FEATURES

Project:>ASPSII/AEC

Funded>by:>DANIDA>and>GoB

Duration:>2001-2006>(ASPSI)>>
>>>>>>>>>>>>>>>>>>>>>>2006-2013>(ASPSII)

Name>of>FO:>>ICM>Club

Name>of>Federation:>>UNFA

Total>ICM>Club:>16,438

Total>UNFA:>1,087

Geo.>coverage:>All>over>BD
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Table>A5.13   Administrative unit-wise distribution of UNFA

Region District>(>no.)* Upazila>(>no.)* UNFA>(no.)

Barisal** 10 31 221

Chittagong 11 28 167

Dhaka 10 32 232

Khulna 7 18 129

Rajshahi 8 8 137

Rangpur 7 20 144

Sylhet 4 9 57

Total 57 146 1,087

Source: AEC, DAE, October 2012.
* These figures represent the total number of districts and upazilas in each region.
** This region overlaps with the IAPP.

Table>A5.14   District and upazila-wise distribution of ICM clubs

Region District Upazila Clubs
BARISAL Barguna Amtali 55
BARISAL Barguna Bamna 18
BARISAL Barguna Barguna Sadar 81
BARISAL Barguna Betagi 25
BARISAL Barguna Patharghata 24
BARISAL Barisal Agoiljhara 17
BARISAL Barisal Babuganj 117
BARISAL Barisal Bakerganj 112
BARISAL Barisal Banaripara 103
BARISAL Barisal Barisal Sadar 22
BARISAL Barisal Gournadi 34
BARISAL Barisal Hizla 17
BARISAL Barisal Mahendiganj 53
BARISAL Barisal Muladi 8
BARISAL Barisal Ujirpur 32
BARISAL Bhola Bhola Sadar 10
BARISAL Bhola Borhanuddin 26
BARISAL Bhola Charfassion 21
BARISAL Bhola Daulatkhan 49
BARISAL Bhola Lalmohan 55
BARISAL Bhola Monpura 5
BARISAL Bhola Tajumuddin 64
BARISAL Faridpur Bhanga 55
BARISAL Faridpur Faridpur Sadar 42
BARISAL Faridpur Nagarkanda 35
BARISAL Gopalganj Gopalganj Sadar 81
BARISAL Gopalganj Kashiani 52
BARISAL Gopalganj Tungipara 49
BARISAL Jhalokathi Jhalokathi Sadar 64
BARISAL Jhalokathi Kathalia 33
BARISAL Jhalokathi Nalchity 101
BARISAL Jhalokathi Rajapur 64
BARISAL Madaripur Kalkini 80
BARISAL Madaripur Madaripur Sadar 71
BARISAL Patuakhali Bauphal 20
BARISAL Patuakhali Dashmina 67
BARISAL Patuakhali Dumki 21
BARISAL Patuakhali Galachipa 45
BARISAL Patuakhali Kalapara 54
BARISAL Patuakhali Mirzaganj 8
BARISAL Patuakhali Patuakhali Sadar 22
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Region District Upazila Clubs
BARISAL Pirojpur Bhandaria 29
BARISAL Pirojpur Kowkhali 69
BARISAL Pirojpur Mathbaria 93
BARISAL Pirojpur Nazirpur 91
BARISAL Pirojpur Nesarabad 33
BARISAL Pirojpur Pirojpur Sadar 135
BARISAL Pirojpur Zianagar 11
BARISAL Rajbari Baliakandi 109
BARISAL Rajbari Goalanda 56
BARISAL Rajbari Rajbari Sadar 83
BARISAL Shariatpur Damudya 41
BARISAL Shariatpur Naria 41
BARISAL Shariatpur Shariatpur Sadar 79
CHITT. HILL TRACTS Bandarban Bandarban Sadar 35
CHITT. HILL TRACTS Khagrachari Dighinala 41
CHITT. HILL TRACTS Khagrachari Ramgarh 34
CHITT. HILL TRACTS Rangamati Kaptai 33
CHITT. HILL TRACTS Rangamati Kowkhali 42
CHITT. HILL TRACTS Rangamati Rangamati Sadar 29
CHITTAGONG Chittagong Banshkhali 29
CHITTAGONG Chittagong Hathazari 43
CHITTAGONG Chittagong Mirersharai 53
CHITTAGONG Chittagong Patiya 53
CHITTAGONG Chittagong Rangunia 61
CHITTAGONG Cox's bazar Chakaria 53
CHITTAGONG Cox's bazar Ramu 35
CHITTAGONG Cox's bazar Ukhia 46
CHITTAGONG Feni Chagalnaiya 78
CHITTAGONG Feni Dagonbhuiyan 96
CHITTAGONG Feni Feni Sadar 75
CHITTAGONG Feni Fulgazi 18
CHITTAGONG Feni Porshuram 28
CHITTAGONG Feni Sonagazi 20
CHITTAGONG Laxmipur Kamalnagar 5
CHITTAGONG Laxmipur Laxmipur Sadar 70
CHITTAGONG Laxmipur Raipur 7
CHITTAGONG Laxmipur Ramganj 54
CHITTAGONG Laxmipur Ramgati 81
CHITTAGONG Noakhali Begumganj 9
CHITTAGONG Noakhali Chatkhil 15
CHITTAGONG Noakhali Companiganj 56
CHITTAGONG Noakhali Hatiya 9
CHITTAGONG Noakhali Kabirhat 10
CHITTAGONG Noakhali Noakhali Sadar 46
CHITTAGONG Noakhali Senbug 42
CHITTAGONG Noakhali Sonaimuri 4
CHITTAGONG Noakhali Subarnachar 14
COMILLA Brahmanbaria Akhaura 45
COMILLA Brahmanbaria Bancharampur 17
COMILLA Brahmanbaria Brahmanbaria Sadar 38
COMILLA Brahmanbaria Nabinagar 46
COMILLA Chandpur Chandpur Sadar 71
COMILLA Chandpur Faridganj 34
COMILLA Chandpur Haimchar 47
COMILLA Comilla Barura 68
COMILLA Comilla Chandina 47
COMILLA Comilla Comilla Adarsha Sadar 93
COMILLA Comilla Daudkandi 126
COMILLA Comilla Homna 31
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Region District Upazila Clubs
COMILLA Comilla Meghna 5
COMILLA Comilla Titas 8
DHAKA Dhaka Dhamrai 104
DHAKA Dhaka Keraniganj 28
DHAKA Dhaka Savar 75
DHAKA Gazipur Gazipur Sadar 46
DHAKA Gazipur Kaliganj 92
DHAKA Manikganj Manikganj Sadar 73
DHAKA Manikganj Saturia 65
DHAKA Manikganj Shibaloy 57
DHAKA Munshiganj Gazaria 22
DHAKA Munshiganj Munshiganj Sadar 37
DHAKA Munshiganj Tongibari 34
DHAKA Narayanganj Araihazar 43
DHAKA Narayanganj Narayanganj Sadar 55
DHAKA Narayanganj Rupganj 37
DHAKA Narshingdi Belabo 89
DHAKA Narshingdi Monohardi 76
DHAKA Narshingdi Narshingdi Sadar 92
DHAKA Narshingdi Raipura 76
DHAKA Tangail Bhuapur 86
DHAKA Tangail Delduar 59
DHAKA Tangail Dhanbari 2
DHAKA Tangail Ghatail 21
DHAKA Tangail Kalihati 1
DHAKA Tangail Madhupur 19
DHAKA Tangail Tangail Sadar 82
JESSORE Bagerhat Fakirhat 87
JESSORE Bagerhat Morrelgonj 43
JESSORE Bagerhat Rampal 38
JESSORE Chuadanga Alamdanga 109
JESSORE Chuadanga Chuadanga Sadar 66
JESSORE Chuadanga Damurhuda 41
JESSORE Jessore Chowgacha 73
JESSORE Jessore Jessore Sadar 96
JESSORE Jessore Monirampur 65
JESSORE Jessore Sarsa 52
JESSORE Jhenaidha Jhenaidha Sadar 62
JESSORE Jhenaidha Kaliganj 100
JESSORE Jhenaidha Kotchandpur 86
JESSORE Jhenaidha Maheshpur 76
JESSORE Khulna Batiaghata 43
JESSORE Khulna Dacope 29
JESSORE Khulna Digholia 35
JESSORE Khulna Paikgacha 53
JESSORE Khulna Terokhada 54
JESSORE Kushtia Bheramara 55
JESSORE Kushtia Daulatpur 64
JESSORE Kushtia Kushtia Sadar 49
JESSORE Kushtia Mirpur 70
JESSORE Magura Magura Sadar 68
JESSORE Magura Mohammadpur 54
JESSORE Magura Sreepur 59
JESSORE Meherpur Gangni 74
JESSORE Meherpur Meherpur Sadar 79
JESSORE Narail Kalia 23
JESSORE Narail Lohagara 38
JESSORE Narail Narail Sadar 60
JESSORE Sathkhira Debhata 33
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Region District Upazila Clubs
JESSORE Sathkhira Kaliganj 56
JESSORE Sathkhira Shyamnagar 46
MYMENSINGH Jamalpur Bakshiganj 10
MYMENSINGH Jamalpur Dewanganj 116
MYMENSINGH Jamalpur Islampur 78
MYMENSINGH Jamalpur Jamalpur Sadar 13
MYMENSINGH Jamalpur Madarganj 14
MYMENSINGH Jamalpur Melandaha 157
MYMENSINGH Jamalpur Sarishabari 41
MYMENSINGH Kishoreganj Bhairab 60
MYMENSINGH Kishoreganj Hosseinpur 46
MYMENSINGH Kishoreganj Karimganj 103
MYMENSINGH Kishoreganj Katiadi 43
MYMENSINGH Kishoreganj Kuliarchar 55
MYMENSINGH Mymensingh Fulpur 78
MYMENSINGH Mymensingh Gouripur 61
MYMENSINGH Mymensingh Ishwarganj 45
MYMENSINGH Mymensingh Muktagacha 67
MYMENSINGH Netrokona Atpara 22
MYMENSINGH Netrokona Barhatta 13
MYMENSINGH Netrokona Durgapur 25
MYMENSINGH Netrokona Kendua 82
MYMENSINGH Netrokona Khaliajuri 2
MYMENSINGH Netrokona Mohanganj 21
MYMENSINGH Netrokona Netrokona Sadar 119
MYMENSINGH Netrokona Purbadhala 10
MYMENSINGH Sherpur Jhenaigati 115
MYMENSINGH Sherpur Nakla 24
MYMENSINGH Sherpur Nalitabari 120
MYMENSINGH Sherpur Sherpur Sadar 8
MYMENSINGH Sherpur Sreebordi 12
RAJSHAHI Bogra Adamdighi 26
RAJSHAHI Bogra Bogra Sadar 131
RAJSHAHI Bogra Dhunat 33
RAJSHAHI Bogra Dupchachia 17
RAJSHAHI Bogra Gabtali 14
RAJSHAHI Bogra Kahaloo 26
RAJSHAHI Bogra Nondigram 14
RAJSHAHI Bogra Shajahanpur 21
RAJSHAHI Bogra Shariakandi 21
RAJSHAHI Bogra Sherpur 147
RAJSHAHI Bogra Shibganj 117
RAJSHAHI Bogra Sonatola 36
RAJSHAHI Chapai Nawabganj Bholahat 25
RAJSHAHI Chapai Nawabganj Chapai Nawabganj Sadar 45
RAJSHAHI Chapai Nawabganj Gomastapur 11
RAJSHAHI Chapai Nawabganj Nachole 126
RAJSHAHI Chapai Nawabganj Shibganj 139
RAJSHAHI Joypurhat Akkelpur 41
RAJSHAHI Joypurhat Joypurhat Sadar 85
RAJSHAHI Joypurhat Kalai 3
RAJSHAHI Joypurhat Khetlal 76
RAJSHAHI Joypurhat Panchbibi 113
RAJSHAHI Naogaon Atrai 20
RAJSHAHI Naogaon Badalgachi 126
RAJSHAHI Naogaon Dhamoirhat 20
RAJSHAHI Naogaon Manda 23
RAJSHAHI Naogaon Mohadebpur 3
RAJSHAHI Naogaon Naogaon Sadar 78
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Region District Upazila Clubs
RAJSHAHI Naogaon Niamatpur 24
RAJSHAHI Naogaon Patnitala 93
RAJSHAHI Naogaon Porsha 30
RAJSHAHI Naogaon Raninagar 27
RAJSHAHI Naogaon Sapahar 11
RAJSHAHI Natore Baghatipara 10
RAJSHAHI Natore Baraigram 5
RAJSHAHI Natore Gurudaspur 42
RAJSHAHI Natore Lalpur 7
RAJSHAHI Natore Natore Sadar 87
RAJSHAHI Natore Singra 141
RAJSHAHI Pabna Atghoria 114
RAJSHAHI Pabna Bera 53
RAJSHAHI Pabna Bhangoora 21
RAJSHAHI Pabna Chatmohor 40
RAJSHAHI Pabna Faridpur 15
RAJSHAHI Pabna Ishwardi 93
RAJSHAHI Pabna Pabna Sadar 7
RAJSHAHI Pabna Santhia 107
RAJSHAHI Pabna Sujanagar 3
RAJSHAHI Rajshahi Bagha 20
RAJSHAHI Rajshahi Baghmara 71
RAJSHAHI Rajshahi Boalia 7
RAJSHAHI Rajshahi Charghat 12
RAJSHAHI Rajshahi Durgapur 111
RAJSHAHI Rajshahi Godagari 25
RAJSHAHI Rajshahi Mohonpur 26
RAJSHAHI Rajshahi Paba 16
RAJSHAHI Rajshahi Puthia 88
RAJSHAHI Rajshahi Tanore 101
RAJSHAHI Sirajganj Belkuchi 8
RAJSHAHI Sirajganj Chowhali 10
RAJSHAHI Sirajganj Kamarkhanda 17
RAJSHAHI Sirajganj Kazipur 112
RAJSHAHI Sirajganj Raiganj 21
RAJSHAHI Sirajganj Shahjadpur 8
RAJSHAHI Sirajganj Sirajganj Sadar 103
RAJSHAHI Sirajganj Tarash 28
RAJSHAHI Sirajganj Ullapara 85
RANGPUR Dinajpur Birampur 16
RANGPUR Dinajpur Birganj 109
RANGPUR Dinajpur Birol 82
RANGPUR Dinajpur Bochaganj 24
RANGPUR Dinajpur Chirirbandar 22
RANGPUR Dinajpur Dinajpur Sadar 60
RANGPUR Dinajpur Fulbari 9
RANGPUR Dinajpur Ghoraghat 20
RANGPUR Dinajpur Hakimpur 2
RANGPUR Dinajpur Kaharole 81
RANGPUR Dinajpur Khansama 44
RANGPUR Dinajpur Nawabganj 8
RANGPUR Dinajpur Parbatipur 6
RANGPUR Gaibandha Fulchari 14
RANGPUR Gaibandha Gaibandha Sadar 109
RANGPUR Gaibandha Gobindaganj 95
RANGPUR Gaibandha Palashbari 77
RANGPUR Gaibandha Sadullapur 8
RANGPUR Gaibandha Shaghata 19
RANGPUR Gaibandha Sundarganj 19
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Region District Upazila Clubs
RANGPUR Kurigram Bhurungamari 11
RANGPUR Kurigram Chilmari 27
RANGPUR Kurigram Fulbari 12
RANGPUR Kurigram Kurigram Sadar 119
RANGPUR Kurigram Nageshwari 10
RANGPUR Kurigram Rajarhat 13
RANGPUR Kurigram Rowmari 6
RANGPUR Kurigram Ulipur 130
RANGPUR Lalmonirhat Aditmari 121
RANGPUR Lalmonirhat Hatibandha 108
RANGPUR Lalmonirhat Kaliganj 128
RANGPUR Lalmonirhat Lalmonirhat Sadar 124
RANGPUR Lalmonirhat Patgram 15
RANGPUR Nilphamari Dimla 9
RANGPUR Nilphamari Domar 7
RANGPUR Nilphamari Jaldhaka 20
RANGPUR Nilphamari Kishoreganj 68
RANGPUR Nilphamari Nilphamari Sadar 145
RANGPUR Nilphamari Saidpur 92
RANGPUR Panchagarh Atwari 37
RANGPUR Panchagarh Boda 98
RANGPUR Panchagarh Debiganj 14
RANGPUR Panchagarh Panchagarh Sadar 61
RANGPUR Panchagarh Tetulia 6
RANGPUR Rangpur Badarganj 16
RANGPUR Rangpur Gangachara 15
RANGPUR Rangpur Kaunia 28
RANGPUR Rangpur Mithapukur 19
RANGPUR Rangpur Pirgacha 94
RANGPUR Rangpur Pirganj 28
RANGPUR Rangpur Rangpur Sadar 31
RANGPUR Rangpur Taraganj 107
RANGPUR Thakurgaon Baliadangi 18
RANGPUR Thakurgaon Haripur 18
RANGPUR Thakurgaon Pirganj 102
RANGPUR Thakurgaon Ranisankail 20
RANGPUR Thakurgaon Thakurgaon Sadar 99
SYLHET Habiganj Habiganj Sadar 46
SYLHET Habiganj Madhabpur 51
SYLHET Moulavibazar Kulaura 66
SYLHET Moulavibazar Moulavibazar Sadar 64
SYLHET Moulavibazar Srimangal 79
SYLHET Sunamganj Bishwambarpur 3
SYLHET Sunamganj Chhatak 6
SYLHET Sunamganj Derai 15
SYLHET Sunamganj Dharmapasa 31
SYLHET Sunamganj Jamalganj 16
SYLHET Sunamganj Sunamganj Sadar 75
SYLHET Sunamganj Tahirpur 6
SYLHET Sylhet Bishwanath 35
SYLHET Sylhet Golapganj 32
SYLHET Sylhet Sylhet Sadar 28

Total 16,438



84

a
n

n
ex 5: extra d

etails o
n

 Fo
s lin

ked
 to g

overn
m

en
t a

g
en

cies
Farm

ers’ o
rg

an
izatio

n
s in

 B
an

g
lad

esh
: a

 M
ap

p
in

g
 an

d
 c

ap
acity a

ssessm
en

t

Innovative approaches: Agricultural Information and Communication Centres (AICC) linked to ICM/IPM clubs
the ais 17 has established 74 aiccs linked to icM clubs under the aec framework all over the country. this 
includes 11 aiccs in the iaPP project area. ais provides each aicc with a desktop/laptop computer and an 
internet connection and trains 2-3 youths per centre on agriculture-related ict. the initiative aims to bring up-
to-date information on agriculture to the farmers’ doorsteps.

Table>A5.15   ICM clubs within IAPP areas linked to AICCs

Sl>no. Name>of>ICM>club Contact>Address

BARGUNA

01 Boloibunia IPM Farmers Club Mr. Jahidul Islam & Mr. Amal Chandra Sarker 
Amtoli, Barguna.

02 Sonakhali IPM Farmers Club Mr. Shafiqul Islam Monir& Ms. AsmaAkter 
Sadar, Barguna.

03 Bainsamerta IPM Farmers Club Mr. Jalal Ahmed & Ms. Nazma Begum 
Vill: Bainsamerta, Sadar, Barguna.

JHALKATHI

04 Chachoir ICM Farmers Club Mr. BelayetHossainTalukder& Mr. Farid Ahmed 
Sadar, Jhalkathi.

RANGPUR

05 Lahirir Hat ICM Farmers Club Mr. Abdul Khalek& Mr. BoloramMohondo 
Sadar, Rangpur.

06 Abhirampur ICM Farmers Club Mr. GolamMostafa& Mr. Nuru Mia 
MIthapukur, Rangpur.

07 Fatehpur ICM Club Mr. Abdul Wazed& Mr. Mohosin Ali 
Pirganj, Rangpur.

08 PurbadebuMadhyapara IPM Club Mr. Ruhul Amin & Mr. RefaetUllah 
Vill: Purbadebu, Pirgancha, Rangpur.

LALMONIRHAT

09 NamuriHarati ICM Club Mr. Shahjahan 
Sadar, Lalmonirhat.

NILPHAMARI

10 Barogharia ICM Cooperative Association Mr. Yakub Ali Sarker 
Sadar, Nilphamari.

KURIGRAM

11 PurbaShibbari ICM Farmers Club Mr. MasudRana 
Ulipur, Kurigram.

Source: Agricultural Information Service (AIS), October 2012 and field visit during mapping exercise.

17 AIS is a separate department under the MoA.
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Integrated Agricultural Productivity Project – DAE Part

Project summary

the objective of the overall iaPP is to sustainably 
enhance productivity of agriculture (crop, livestock 
and fisheries) in two agro-ecologically constrained 
and economically fragile areas – rangpur and 
Barisal. the iaPP has four components: 1) technology 
generation, implemented by agricultural research 
institutes [Bari, Brri, sca and BFri]; 2) technology 
adoption, implemented by agricultural extension 
agencies [dae, doF and dls]; 3) irrigation and water 
management, implemented by Badc. these three 
components are supervised by the World Bank; 
the fourth component is technical assistance for 
capacity development, directly implemented by 
Fao. Fos have been formed and mobilized by dae, 
doF, dls and Badc with different approaches and 
names through their respective components and 
agencies. 

Seed villages

a total of 54 seed villages will be developed at the upazila level. these will provide services to the lFs members, 
including provision of quality seed, as well as facilitating seed certification through the sca.

geographical information is not available.

Table>A5.16   Year-wise target of LFS under IAPP-DAE part

Agency year-wise>target Total

2011 2012 2013 2014 2015

DAE- part (LFS) 375 1,875 2,625 2,625 500 8,000

Source: Work Plan, IAPP, November 2012.

Northwest Crop Diversification Project

Project summary

the northwest crop diversification Project (ncdP) is a 
completed project of dae, which covered 61 upazilas 
of 16  districts in the northwest region. the aim was to 
accelerate economic growth through production of 
improved high-yield varieties of vegetables, fruits, spices, 
and other high value crops by small- and medium-scale 
farmers. support was provided through production 
credit and marketing assistance to small farmers’ groups 
and farmers’ marketing groups.

growers’ markets under the ncdP that overlap with iaPP 
areas are in Mithapukur, rangpur; rajarhat, Kurigram; 
aditmari, lalmonirhat; and domar, nilphamari).

KEy>FEATURES

Project:>NCDP
Funded>by:>ADB
Duration:>2004-2009
Name>of>FO:>>SFG
Name>of>Federation:>>FMG
Total>SFG:>12,415
Geo.>coverage:>16>districts>of>the>north-west>
region>of>Bangladesh.
Innovation:>Production>credit>and>marketing>
assistance>to>high>value>horticultural>crop>
producers,>construction>of>growers>markets.

KEy>FEATURES

Project:>IAPP

Funded>by:>GAFSP

Duration:>2010-2015

Name>of>FO:>>LFS,>Livestock>Rearers>Group,>LFS-
Fishers>Group,>Water>User>Group

Name>of>Federation:>>none

Total>FO:>4,544>(target>15,004)

Geo.>coverage:>4>districts>in>Rangpur>and>>
>4>districts>in>Barisal.

Innovation:>Livelihood>Field>School,>stress>tolerant>
seeds>and>technology>dissemination,>multi-agency>
(8)>coordination.
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Second Crop Diversification Project

Project summary

the second crop diversification Project (scdP) is a 
follow up of the earlier ncdP of dae. the scdP started 
its activities in 2011. the project is expected to contribute 
to economic growth and food security by creating 
employment opportunities in the crop production 
sector. Poor and marginal farmers will benefit from 
increased incomes as a result of increased returns from 
crop production and increased value added through 
marketing interventions. the landless poor will benefit 
as agricultural laborers from the creation of additional 
employment opportunities in agriculture and its ancillary 
industries.

Table>A5.17   Branch-wise distribution of SFGs formed by BRAC

Region Sl>no. Branch SFGs Female>farmers Total>no.>of>members

Khulna 1 Daulatpur 13 72 271

2 Dumuria 18 62 315

3 Satkhirasadar 17 27 319

4 Debhhata 25 128 488

Pirojpur 5 Bagerhatsadar 20 8 365

6 Fakirhat 15 31 292

7 Nesarabad 9 40 160

8 Jhalokathisadar 6 40 105

9 Mollahat 20 83 389

10 Nazirpur 16 160 312

Madarpur 11 Moksedpur 17 69 313

12 Tungipara 28 129 504

13 Rajoir 9 82 182

14 Kalkini 26 120 539

15 Zazira 21 86 373

16 Bedorganj 20 76 377

17 Barisal Sadar 23 47 442

18 Babuganj 27 128 573

19 Uzirpur 21 48 407

20 Agailjhara 17 117 336

21 Gournadi 20 80 412

Faridpur 22 Faridpur 18 120 341

23 Madhukhali 12 100 220

24 MaguraSadar 13 106 235

25 Sreepur 14 218 278

Jhenaidah 26 Jhenaidahsadar 12 20 200

27 Moheshkhali 10 40 177

28 Korchandpur 6 60 120

KEy>FEATURES

Project:>SCDP
Funded>by:>ADB
Duration:>2011-2016
Name>of>FO:>>SFG
Total>SFG:>866
Geo.>coverage:>9>districts>in>52>upazilas
Innovation:>Developing>farmers’>bargaining>
power>and>joint>investment>with>the>private>
sector.
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Region Sl>no. Branch SFGs Female>farmers Total>no.>of>members

Jessore 29 Jessoresadar 10 90 185

30 Monirampur 11 110 219

31 Jhikargancha 7 81 140

32 Sharsha 7 62 147

33 NarailSadar 9 40 146

Chuadanga 34 Chuadangasadar 12 127 223

35 Dhamurhuda 7 89 150

36 Jibonnagar 10 83 163

37 Meherpursadar 7 86 122

38 Mujibnagar 12 80 144

Kustia 39 Kushtiasadar 8 70 150

40 Mirpur 3 48 68

41 Harinakundu 4 41 76

42 Rajbarisadar 20 133 423

Rajshahi 43 Pabna 24 286 487

44 Godagari 35 200 673

45 Bagatipara 43 140 861

46 Chapainowabganjsadar 16 160 291

47 Sonatola 22 40 418

48 Sadullapur 38 120 727

49 Nageswari 35 198 630

50 Hatibandha 31 289 625

51 Birampur 22 140 426

Total 866 5,010 16,539

Source: BRAC and SCDP, November 2012.
NB: Branches defined as administrative distribution of BRAC.

Department of Cooperatives

the department of cooperatives (doc) is headed by a registrar and has a field presence all the way down to the 
upazila level. the officers-in-charge at the division, district and upazilla levels have been delegated almost all 
the powers of the registrar except those related to the affairs of national level cooperatives. this delegation of 
power facilitates registration of cooperatives at the local level. divisional Joint registrars, district co-operative 
officers and upazilla cooperative officers are the heads of the division, district and upazilla-level cooperative 
offices respectively.

the major services and responsibilities of the doc can be grouped into four categories: statutory, judicial, 
developmental and promotional. the statutory responsibilities are: registration; liquidation of defunct societies; 
annual audit; periodic inspection; and enquiry, whenever needed. the judicial or quasi-judicial responsibility 
refers to settlement of disputes. the developmental roles and responsibilities include: education and training 
for the development of management and business skills; advisory services; and assistance in arranging finances. 
the promotional responsibilities include advocacy with other departments in the government to promote 
working with cooperatives.
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there is a possibility of overlap between the following figures and the figures from dae, dls and doF.

Table>A5.18   Status of farmers’ cooperatives  

Classification>of>cooperatives* No.>of>cooperatives No.>of>female>
members No.>of>members

Central: General

Central Fishers Cooperative Association 
(Kendrio Matshyajibi Samobay Samity) 88 2501

Central Sugarcane Producers Cooperative Association 
(KendrioIkshu Utpadonkari Samobay Samity) 12 755

Central: Bangladesh Rural Development Board (BRDB)

District Village Development Federations Ltd. 
(Zila Palli Unnayan Federation Ltd.) 10 149

Primary: General

Primary Agriculture and Farmers Cooperative Association 1,019 1,087 44,874

Primary Fishers Cooperative Association 8,860 8,511 402,700

Primary Milk Cooperative Association 7 120 784

Water Management Cooperative Association 87 1,265 36,16

Primary: BRDB

Farmers Cooperative Association 55,516 30,626 1,972,757

Primary: Local Government Engineering Department (LGED)

Water Management Cooperative Association 748 54,376 252,001

Primary: Bangladesh Water Development Board (BWDB)

Water Users/Water Management Cooperative Association 1,140 16,095 68,739

Primary: Bangladesh Academy for Rural Development

Village Development Cooperatives 579 16,388 51,659

Primary: Rural Development Academy (RDA)

Village Development Cooperatives 522 10,473 39,024

Primary: Bangladesh Milk Producers Cooperatives Union Ltd.

Milk Producers Cooperative Association (Milk Vita) 1,570 4,959 72,999

Primary: Cooperative Bank

Primary Farmers Cooperative Association 13,695 15,447 601,846

Total>Farmers>Cooperatives 83,853 159,347 3,514,404

Total>Cooperatives 184,486 9,194,787

%>of>farmers>coop.>over>total>coop. 45.45% 38.22%

*Note that ‘central’ refers to the alliance of primary cooperatives.

Milk Vita

Background and formation

the Bangladesh Milk Producers cooperative union ltd. (BMPcul), popularly known as ‘Milk Vita,’ was 
established  in 1973. it was formed in response to the exploitation (unfair pricing and dishonest product 
weighing) of dairy farmers by middlemen. Milk Vita adapted the model of the world-renowned aMul dairy 
cooperative in india18.

Milk Vita helps rural milk producers organize their own village level Primary Milk Producers’ cooperative 
societies so that they themselves can become responsible for marketing their own milk and no longer need to 
depend on middlemen. 

18 Amul is the brand name of largest Indian dairy cooperative, namely the Gujarat Coperative Milk Marketing Federation Ltd. (GCMMF). The Amul Model is a three-tier cooperative 
structure. It consists of a Dairy Cooperative Society at the village level affiliated to a Milk Union at the District level, which, in turn, is further federated into a Milk Federation at the 
State level. The primary objective of forming the cooperative is to protect farmers from unfair and manipulative trade practices.
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Figure A5.1   Milk production model of Milk Vita

Department of Fisheries

the doF is the apex extension agency in the fisheries (fresh and marine) sub-sector. the department has three 
large projects that work with Fos, namely: natP, rFldc and iaPP. doF is also involved in implementing the 
rFldc, which has already been discussed under the dls section, as it deals with both livestock and fisheries 
extension. this section describes only Fos mobilized by the natP-doF component and iaPP-Fisheries Part.  

Table>A5.19   FOs formed with support from DoF

Project>Time>Frame> Name>of>FO Project> Major>source>
of>funding>

Upazilas>
covered>

Farmers>
benefited

2010-2014 CIG NATP: National Agriculture Technology Project 
(Fisheries part)

IDA 120 40,050

2011-2015 Livelihood Field School (LFS)-
Fishers Group

IAPP: Integrated Agricultural Productivity Project 
(fisheries part)

GAFSP 54 62,750

National Agricultural Technology Project – DOF Part

Table>A5.20   Fisheries CIGs under NATP-DoF component

Sl.>No. District Upazila* Union* Pouroshova* Fisheries>CIG

1 Mymensingh 8 105 3 220

2 Kishoreganj 4 33 4 70

3 Sherpur 3 31 3 66

4 Tangail 8 66 7 148

5 Gazipur 4 36 4 78

6 Narsingdi 5 46 5 88

7 Dhaka 2 28 2 60

8 Comilla 6 66 6 140

9 B.Baria 4 46 4 118

10 Chandpur 4 48 4 96

11 Chittagong 6 93 6 194

12 Cox'bazar 3 27 2 52

Smallholders

Coops

Rural produce to urban market

Consumers

Urban cash to rural producers

Product manufacturing 
plants

Rural plants

Distribution 
cooperatives /

agents
Market
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Sl.>No. District Upazila* Union* Pouroshova* Fisheries>CIG

13 Sylhet 6 47 2 94

14 Moulvibazar 6 61 5 126

15 Kushtia 4 43 4 92

16 Jhenaidah 3 33 3 72

17 Jessore 8 91 8 188

18 Khulna 5 45 2 92

19 Satkhira 3 38 2 78

20 Rajbari 3 31 2 80

21 Faridpur 3 26 1 54

22 Natore 4 41 6 90

23 Bogra 6 58 6 124

24 Dinajpur 6 55 3 112

25 Rangpur** 6 68 3 138

Total 120 1,262 97 2,670

* These figures represent the total number of upazilas, unions and pouroshovas in each region.
** This region overlaps with the IAPP.

Table>A5.21   Features of fisheries CIGs

Feature>of>fisheries>CIGs Total

Nos. of CIGs 2,670

Number CIG members 40,050

% female members 18

% members having pond 99

% members having fisheries experience 82

%  of literate CIG members 98

Source: Annual report, PCU, NATP, 2012.

Integrated Agricultural Productivity Project – DOF Part

Organizational approach

lFs fishers’ groups are formed at the village level and are made up of 25 fish farmers. the main purpose of the 
fishers’ groups is to organize demonstrations of fish culture farming of semi-intensive tilapia, carp polyculture, 
koi and pungas. 

Table>A5.22   Yearly targets of LFS-Fishers group mobilized under IAPP-DoF part

Agency year-wise>target Total

2011 2012 2013 2014 2015

DoF (LFS-fishers’ groups) 100 750 830 830 - 2,510

Source: Work Plan, IAPP, November 2012.
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Department of Livestock Services

dls is the extension agency for livestock rearers. like dae, it implements different projects with different 
extension approaches.

Table>A5.23   FOs formed with support from DLS

Project>Time>Frame Name>of>FO Project> Major>source>of>
funding>

Upazilas>
covered>

1992-1998 Livestock Rearers Group SLDP I: Smallholder Livestock Development Project Danida, IFAD, GOB 80

1998-2002 Livestock Rearers Group PLDP: Participatory Livestock Development Project Danida, ADB 89

1999-2003 Livestock Rearers Group SLDP II: Smallholder Livestock Development Project 
Phase 2 DANIDA 26

2004-2010 Livestock Rearers Group PLDP II: Participatory Livestock Development Project 
Phase 2 ADB 157

2006-2013 CBO RFLDC-Regional Fisheries and Livestock Development 
Component  DANIDA 62

2010-2014 CIG NATP: National Agriculture Technology Project 
(Livestock part) IDA 120

2011-2015 Livestock Rearers Group IAPP: Integrated Agricultural Productivity Project 
(Livestock part) GAFSP 54

Regional Fisheries and Livestock Development Component

Project summary 

the rFldc, in noakhali and Barisal, is part of 
danida’s agricultural sector Programme support 
in Bangladesh.  it is the successor to the greater 
noakhali aquaculture extension Project.

Services provided

details on services provided by cBos to their 
members are as follows:

Aquaculture sub-sector
>> promotion of community aquaculture, demand 

assessment for bulk inputs; supply of fish and 
prawn seed; and

>> water pumping services; netting services; and 
marketing of fish from community aquaculture 
sites.

Livestock sub-sector
>> supply of day-old chicks (of the local, indigenous 

variety) and day-old ducklings, goat kids and 
lambs;

>> operation of nurseries for chicks and ducklings; breeding services for goats (bucks) and cattle (red 
chittagong Bulls); and

>> other business services (artificial insemination, feed/fodder, medication, vaccination, marketing).

KEy>FEATURES

Project:>RFLDC
Funded>by:>DANIDA
Duration:>2006-2013
Approach>in>forming>FO:>Farmers>Field>School>
Name>of>FO:>CBO
Name>of>Federation:>District>CBO>Association>(DCA)
Total>FO:>468
Geo.>Coverage:>Greater>Noakhali>(Feni,>
Lakhsmipur,>Noakhali>and>adjacent>parts>of>
Chittagong)>and>Greater>Barisal>(Barguna,>Bhola,>
Jhalakathi,>Pirojpur>and>Barisal.
Innovation:>graduation>of>FFS>to>CBO>and>CBOs>
federated>as>District>CBO>Association>(DCA);>
address>bulk>buying>of>inputs;>internal>credit.
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Agriculture/Horticulture
>> supply of quality (hybrid) vegetable seeds, rice, other field crops (soya bean), fruit saplings, fertilizers;

>> operation of vegetable and fruit saplings nurseries; and

>> provision of transportation to market.

Other activities
>> net-making enterprises through an integrated value chain approach – collection of thread, distribution of 

thread to women net makers, collection and marketing;

>> operation as a consumer cooperative – buying goods in bulk at low price in urban markets and selling 
locally at minimum profit; and

>> awareness campaigns, including for human rights.

RFLDC – Noakhali

the technical support unit (tsu) of the rFldc in noakhali has formed 172 cBos in 23 upazilas of three districts 
of greater noakhali. it has also formed four cBo associations at the district level. details on these cBos and cBo 
associations are provided below (table a5.24 – a5.28).

Table>A5.24   Geographical distribution of CBOs of RFLDC-TSU, Noakhali

District Upazila Union>no.* No.>of>CBOs CBO>associations

Noakhali

Hatiya 7 36

2

Begumganj 3 8

Sonaimuri 2 4

Chatkhil 2 5

Companiganj 4 7

Senbagh 0 7

Sadar 3 7

Subarnachar 8 16

Kabirhat 3 8

SERVICE>PROVISION>–>A>CASE>STUDy

Recognizing>both>the>potential>for>growth,>and>its>member>farmers’>need>for>support>in>order>to>participate>in>
the>duck>value>chain,>a>CBO>in>Lakshmipur>decided>to>intervene>and>provide>its>member>farmers>with>services>
and>opportunities>to>engage>in>this>profitable>value>chain.

The>CBO>saw>that>member>farmers>were>not>able>to>bear>the>risk>of>rearing>day>old>ducklings>themselves,>
and>so,>the>CBO>took>took>upon>the>responsibility>of>raising>flocks>of>ducklings.>The>CBO>brings>the>ducklings>
to>the>point>of>reduced>risk,>and>then>sells>them>to>their>member>farmers,>keeping>a>small>margin>in>order>
to>contribute>to>the>financial>sustainability>of>the>CBO.>The>CBO’s>support>then>extended>to>the>whole>value>
chain>of>the>duck>sub-sector>in>their>geographic>vicinity.>Now>this>CBO>plays>an>active>role>in>the>whole>chain>
by> providing> day> old> ducklings,> feed,> medicine,> vaccines,> and> marketing> of> ducks> and> eggs.> In> addition> to>
financial>sustainability,>this>provision>of>business>services>by>the>CBO>resulted>in>greater>feelings>of>connection>
to> the> organization> by> members,> contributing> to> sustainability> from> an> organizational> standpoint.> RFLDC>
facilitated>this>initiative>in>collaboration>with>the>Sonagazi>Duck>Breeding>Station,>a>state-owned>duck>farm>
where>improved>breeds>of>duckling>are>available.>
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District Upazila Union>no.* No.>of>CBOs CBO>associations

Feni

Sadar 8 9

1

Daganbhuiyan 4 6

Chagalnaiya 3 4

Parshuram 2 2

Sonagazi 5 7

Fulgazi 1 1

Fatikchari 3 5

Mirsarai 1 4

Lakshmipur

Sadar 10 10

1

Raipur 7 7

Ramganj 4 4

Ramgati 4 8

Kamalnagar 5 7

Total 23>upazila 89 172 4

* These figures represent the total number of unions in each upazila.

List of CBOs of RFLDC in greater Noakhali region 

Table>A5.25   List of CBOs in Hatiya upazila

Sl>
no. CBO ID Name Village PO Union Upazila> Communication>

1 36101 Nobo Unnayan Adarsha Sangastha Tamaruddin Tamaruddi Tamaruddi Hatiya 01724741222 (Pre)
2 36102 Gono Mukti Samaj Unnayan Sangastha Sunnerchar Saiwadiabazar Burirchor Hatiya 01716484704 (Pre)
3 36103 Dwip Bikolpo Somaj Unnyan Songstha Jorkhali Sagoria Burirchor Hatiya 01713626871 (Pre)
4 36104 Rehania Akota Somaj Unnyan Songstha Rehania Surjomukhi Burirchor Hatiya 01724185669 (Pre)
5 36105 Burirdona Pani Babosthapona Somittee Bordail Burirchar Burirchor Hatiya 01733250429 (Pre)
6 36106 Koralia Somaj Kollan Songstha Koralia Tamaruddi Tomoruddi Hatiya 01730182318 (Pre)
7 36107 Kazir bazar Megna Somaj Unnyan Songho Purba Lakkhidia Oskhali Charishwar Hatiya 01739366011 (Pre)
8 36108 Rajerhawla Somaj Kollan Songho Rajerhawla Charchannabazar Charishwar Hatiya 01923949096 (Pre)
9 36109 Sorjomukhi Ghat Jele Association Sunnerchar Surjomukhi Burirchor Hatiya 01714433504 (Pre)

10 36110 Danardol Ghat Jele Association Moddah Rehania Surjomukhi Burirchor Hatiya 01731858948 (Pre)
11 36111 Rahmat Bazar Ghat Jele Association Dokkhin Rehania Burirchar Burirchor Hatiya 01713625316 (Pre)
12 36112 Burirdona Ghat Jele Association Aladigram Burirchar Burirchor Hatiya 01722698599 (Pre)
13 36113 Jangalia Ghat Jele Association Mohammadpur Notun shukchar Jahajmara Hatiya 01760008072(Pre)
14 36114 Muktaria Ghat Jele Association Notun Shukchar Notun shukchar Jahajmara Hatiya 01745237174 (Pre)
15 36115 Panchas Acre Ghat Jele Associaion Notun Shukchar Notun shukchar Jahajmara Hatiya 01731352725 (Pre)
16 36118 Participatory Development Society W. Laxmidia Saiwadiabazar Chorishwar Hatiya 01720277497 (Pre)
17 36119 Palii Unayann Songo Purba Changa Charchanga Sonadia Hatiya 01732067276 (Sec)
18 36120 Naba Jagoron Bahumukhi Samabay Samity Daspara Daserhat Charking Hatiya 01720627247 (Pre)
19 36121 Natun Shuk Char Unayan Sonsgtha Natun Shuk Char Notun shukchar Jahajmara Hatiya 01717956645 (Pre)
20 36122 Madha Maij Chara Janakalayan Somitee Madha Maijchara Charchanga Sonadia Hatiya 01725923307 (Pre)
21 36123 Dwip Seba Society Birbiri Jahajmara Jahajmara Hatiya 01717455265 (Pre)

22 36124 Coastal Area Development Organization 
(CADO) Gamchakhali Mofizia Charking Hatiya 01741100862 (Pre)

23 36125 Mohammadpur Bahomukhee Somitee Mohammadpur Notun shukchar Jahajmara Hatiya 01732148544 (Pre)

24 36126 Topania Jubo Unayan Songstha Topania Afazia Nolchira Hatiya 01735982738 (Sec)

25 36127 Al-Amin Somaj Unayan Songstha Khirudia Tamaruddi Tomoruddi Hatiya 01714316493 (Pre)

26 36128 Sonadia Chashi Kalayan Samitee Purba Sonadia Banglabazar Sonadia Hatiya 01713619041 (Pre)

27 36130 Hatiya Nari Unayan Songstha Char Koilash Oskhali Charking Hatiya 01829290011 (Pre)

28 36135 Nolchira Jela para Somaj Unnyan Shagastha Kalumajirgram Afazia Nolchira Hatiya 01714349363 (Pre)

29   Poschim sonadia krishijibi sommittee Poshim sonadia Banglabazar Sonadia Hatiya 01734257656 (Pre)
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Table>A5.26   List of CBOs in Noakhali districts

Sl>no. Name Village PO Upazila>name

1 Kutubpur Shamaj Bhittik Bahumukhi Unnyan Sangstha Kutubpur Kutubpur Begumgonj
2 Sarifpur Krishi Unnayan Sangstha Sonapur Sonapur Begumgonj
3 Allahardhan Samaj Seba Sangstha Dakhin Najirpur Najirpur Begumgonj
4 Sebadhan Society Kashabpur   Begumgonj
5 Choyani Krishi Unnyoun Shogastha Lakshanpur   Begumgonj
6 Gopalpur Krisi Bahumukhi Unnyan Shogastha Koutuba Mohabbathpur   Begumgonj
7 Uttar Jirtali Bahumukhi Unnyan Sangastha Uttar Jirtali   Begumgonj
8 Norottompur Somaj Seba Shangstha Norottompur   Begumgonj
9 Bijoy Taranga Samaj Unnayan Sangstha Moutubi Bazra Sonaimuri

10 Gram Unnyan Shangathan Mokilla Bargaon Sonaimuri
11 Rashidpur Ganojagoran Bahumukhi Sangstha Rashidpur Muslimgonj Bazar Sonaimuri
12 Nobojagoran Somaj Seba Shogastha Amishapara   Sonaimuri
13 Chatkhil Matshya Chashi Unnyan Shangstha Dashani Tabga Amin Bagh Chatkhil
14 Porkot Dashgaria Unnion Unnyan Shamittee Dashgaria Doshgoria Chatkhil
15 Mohammadpur Bansha Shamajk Unnyan Shangstha Bansha Bansha Bazar Chatkhil
16 Pragoti Bhahumukhi Unnyan Shangstha Amorpur Sreepur Chatkhil
17 Sahapur Unioun Somaj Unnyon Shogastha Proshedpur   Chatkhil
18 Panjeree Shamaj Kallyan Shangstha Char Kankra Peshkerhat Companigonj
19 Adarsha Shamaj Unnyan Shangstha Char Fakira Chaprashir Hat Companigonj
20 Char Elahi Nari kallyan Shangstha Char Elahi Char Elahi Bazar Companigonj
21 Progathi Shomaj Kallyan Shogastha Char Parbathi Kadamtala Companigonj
22 Musapur Jubo Sango Somaj Unnyan Shagastha Musapur   Companigonj
23 Char Kalmi Jubo Unnyan Shamittee Char Kalmi   Companigonj
24 Bamni 1 No Pani Babosthapana Shomobai Assocaition Dakshin Char Elahi   Companigonj
25 Nobipur Somaj Unnyan Shangstha Gopalpur Bijbag Senbagh
26 Basnthupur Palli Unnoin Shagastha (BRDA) Basnthupur Basnthapur Senbagh
27 Kadra IPM Club Kadra   Senbagh
28 Uttar Gorkata IPM Club Gorkata   Senbagh
29 Purba Bircot IPM Molsila Club Somittee Bircot   Senbagh
30 Artha Samaj Unnyan Shagastha Yearpur   Senbagh
31 Asmot Danu Foundation Dildar Market   Senbagh
32 Darmapur polli progoti shangstha Darmapur Chowmuhani Bazar Noakhali Sadar
33 Char Matua Jubo Sango Andar Cahar   Noakhali Sadar
34 Kadir Hanif Polli Unnyan shogastha Gopinathpur   Noakhali Sadar
35 Mokimpur samaj unnyan songstha Makimpur   Noakhali Sadar
36 Monnan Nagar IPM Club Paschim Char Uriya   Noakhali Sadar
37 Nayanni Union Bahumaki Unnyan Shangastha Nayanni Noyanni Noakhali Sadar
38 Satota Bahumukhi Unnayan Sangstha (01811313696) Madhyam Bagga Char Zabbar Subarnachar
39 Char Amanullah Bahumukhi Unnayan Sangstha (01732386010) Char Bazalulkarim Char Bata Subarnachar
40 Bangla Bazar Upakulia Bahumukhi Unnayan Sangshta (01713620696) Keramatpur Janatabazar Subarnachar
41 Diganta Bahumukhi Unnayan Sangstha (01813664651) Char Jabbar Parchim Char Zabbar Subarnachar
42 Progoti Samaj Unnayan Sangstha (01725297478) Dakshin Char Majid Char Bata Subarnachar
43 Saikat Bahumukhi Unnayan Sangstha (01822911243) Char Majid Anchermiarhat Subarnachar
44 Char Torab Ali Matsa O krishi Unnayan Sangstha (01716338427) Char Torab Ali Char Laxmi Suburnacahr
45 Meghna Bahumukhi Unnayan Sangstha (01816611804) Char Bagga Char Zabbar Suburnacahr
46 Upakul Unnayan Sangstha (01811998809) Purba Char Bata Anchermiarhat Suburnacahr
47 Char Zabber Upakulio Samannaya Parishad (01921484076) Paschim Char Zabber Kanchan Bazar Suburnacahr
48 Char Jublee Upakulio Samannaya Parishad (01815330191) Dakkhin Kachchapia Habibullah Miar Hat Suburnacahr
49 Karim Pani Bebasthapana Samabaya Dal Ltd. (01714805135) Char Alauddin Char Laxmi Suburnacahr
50 Subarna Somaj Kallayan Sangastha (01719651429) Char Kazi Mokles Charbaishakhi Suburnacahr
51 Ashrayan Bahumukhi Unnyan Shagastha (01712551398) Purbo Char Majid Anchermiarhat Suburnacahr
52 Char Laxmi Janokallayan Sangstha (01725908855) Char Laxmi Char Laxmi Suburnacahr
53 Sagorika Samaj Unnayan Sangstha (01735952489) Charbata Charbata Suburnacahr
54 Boyerchar Jubo Unnayan Sangstha (01713638129) West Rasulpur Afazia Hatiya
55 Janata Samaj Unnayan Sangstha (01734160835) Suhagchowdhury Afazia Hatiya
56 Tankirkhal-2 Pani Bebasthapana Samabaya Dal Ltd. (01722085783) Tanki Samaj Afazia Hatiya
57 Gabtalikhal-4 Pani Bebasthapana Samabaya Dal Ltd. (01712267097) Sirazpur Afazia Hatiya
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Sl>no. Name Village PO Upazila>name

58 Gabtalikhal-3 Pani Bebasthapana Samabaya Dal Ltd. (01728544926) Mohammadpur Afazia Hatiya
59 Banglabazar Samaj Unnayan Sangstha (01758028078) Majlishpur Afazia Hatiya
60 Progati Samaj Unnayan Sangstha (01827108197) Alameen Afazia Hatiya
61 Akata Bahumukhi Unnyan Shangstha Nabagram Thanar Hat Kabirhat
62 Bataiya Union Bahumukhi Unnyan Shangstha Ramdi Bhuiyar Hat Kabirhat
63 Noruttampur Bhahumukhi Unnayan Shangtha Nalua Sundalpur Kabirhat
64 Nalua Asharayan Somaj Kallyan Shogastha Nalua   Kabirhat
65 Samata Bhumukhi Unnyan Sanghatha Uttar Lamsi   Kabirhat
66 Ramnathpur IPM Club Ramnathpur   Kabirhat
67 Chaprashir Hat Rameshwerpur   Kabirhat
68 Development Eport for Self Helf (DESH) Purba Rajargoan   Kabirhat
69 Makimpur samaj Unayann Songstha Makimpur   Noakhali Sadar

Table>A5.27   List of CBOs in Lakhsmipur

Upazila Name>of>CBO Village Union Cashier President/>>>>>
Secretary

Lakshmipur Sadar
01 Hajirpara Matshya Chashi Unnyan Shamittee Yousufpur Hajir Para   01719 878352
02 Gopinathpur Matshya Chashi Unnyan Shamittee Gopinathpur Dakshin Hamchadi   01716 770385
03 Shapla Bhahumikhi Unnyan Shangstha Char Lamchi Char Ruhita 01711713840 01711 3612295
04 Ashar Alo Unnyan Shangstha Bijoy Nagar Uttar Hamchadi 01720 606944 01726 628060
05 Laharkandi IPM Club Laharkandi Laharkandi 01732 856699 01711-949078

06 Jonokollan Shamaj Unnyan Shangstha Modho Char Ramoni 
Mohon Modho Char Ramoni Mohon 01728146566 01736 865428

07 Bandhon Shamaj Unnyan Shangstha Shak Char Tum Char 01751 829785 01816 424498
08 Jiboner Alo Shamaj Unnyan Shangstha Char Ali Hasan Modho Char Ramoni Mohon 01720 984945
09 Khidirpur Shamaj Unnyan Shangstha Khidirpur Dalal Bazar 01719878918
10 Gourinagar ICM Club Gourinagar Gourinagar 01715255225
Raipur 
11 Keroa Shamaj Unnyan Shangstha Uttar Keroa 6 No. Keroa    01711 946217
12 Rupali Unnyan Kendra (RUK) Char Ababil Char Ababil 01713-941873 01724-609781
13 Char Bangshi Shamaj Unnyan Shangstha Char Lakshmi 8 no. Dakhin Char Bangshi 01732-856639 01739-190776
14 Polli Unioun Kendro Char Mohona Char Mohana 01720-212124 01719-559552
15 Sunamgonj Bazar Krishi Seba Kendro Sunamgonj Char Pata 01737-465377 01731-102742
16 Sonar Bangla Shamaj Unnyan Shangstha Char Boga 4 No. Sonapur 01724-742133 01713-606263
17 Kolakopa Shamaj Unnyan Shangstha Kolakopa 7 No. Bamni 01813-332332 01823-252948
Ramgonj 
18 Adarsha Palli Unnyan Shangathan Ali Pur Darbeshpur 01725 504794 01726 282338
19 Polli Samaj Unnyan Shangstha Badarpur Karpara 01738 782332 01721 465400
20 Gorib Chasi Krishi Seba Kendro Vatra Maij Para Pach Rukhi 01733 139732
21 Jafor Nagar Manob Unnoyon Shangstha Jafarnagar Vatra 01721910203
Upazila: Ramgati
22 Mohona Bahumukhi Unnyan Shangstha Char Badam Char Badam   01825 009795
23 Jamidar Hat IPM Club Paschim Char Sita Char Badam   01745 568585
24 Kolakopa Punurbashon Unnyan Shagastha Kolakopa Char Badam 01812 448662
25 Guchhyagram Nari Unnyan Shangathan Guchhyagram Char Badam   01717 986371
26 Char Sita Bahumukhi Unnyan Shangathan Char Sita Char Badam   01921 391828
27 Surjomukhi IPM Club Tum Char Char Gazi 01725 391630
28 Char Alexander UCC Alexander Alexander 01746 837229
29 Ekota Samaj Unnyan Shangstha Char Romij Char Romij 01812357376
Kamalnagar 
30 Megna Bhahumukhi Unnyan Shangstha Char Larance Char Lawrence   01716 652507
31 Ladhua Bhahumikhi Unnyan Shangstha Char Falkon Char Falcon  01737136561 01731 615166
32 Munshigonj Bahumukhi Unnyan Shangathan Char Martin Char Lawrence 01715-640019 01812 940556
33 Hazi Fazil Miaher Hat Samaj Kallan Sangathon Char Pagla Char Kadira  01821550867 01711 713990
34 Jagoron Upakulio Punurbashon Unnyan Shagastha Uttar kalkini Char Kalkini 01725 390898
35 Kalkini UCC Kalkini Kalkini 01710 913344 01820 933020
36 Folkon UCC Char Folkon Char Folkon 01742 422380 01726 854937
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Table>A5.28   List of CBOs in Feni district

SL.>
no. ID>no. Name>of>CBO Village Union Upazila District President/>>>>>

Secretary
  Upazila: Feni Sadar          
1 29103 Mitali Shamaj Kallyan Shamittee Purba Chhilania Sanua Feni Sadar Feni 01711 716632
2 29104 Alamin Jubo Kalyan Shamittee Purba Bijoyshing Ward No-01 Feni Sadar Feni 01713 603838
3 29105 Madhu Daliya Somaj Kallyan Shamittee Madhu Daliya Dhalia Feni Sadar Feni 01714 437612
4   Ecota Mohila Unnayan Somity Dharmapur Dharmapur Feni Sadar Feni 1724744202

5 29107 Bangladesh Rural Development Society 
(BRDS) Uttar Kashimpur Panchgachia Feni Sadar Feni 1711285881

6   Purba Fazilpur Kalibari Matsa Jibi Sangstha Purba Fazilpur Fazilpur Feni Sadar Feni 1816028140
7   Kata Mobarokghona Samaj Kallyan Sangstha Kata Mobarokghona Farhadnagar Feni Sadar Feni 1817606499

8   Dakshin Matiara Jaladasbari Matsa Jibi 
Somabai Sommittee Dakshin Matiara Pachgachia Feni Sadar Feni 1822368776

9   Dakshin Matiara ICM Club Dakshin Matiara Pachgachia Feni Sadar Feni  
  Upazila:Daganbhuiyan          

10 25101 Godhuli Shamaj Unnyan Shangstha Sonapur Jailashkara Daganbhuiyan Feni 01716 274956

11 25102 Bandhargora Unnyan Bahumukhi Shomubai 
Shamittee Sekenderpur Ramnagar Daganbhuiyan Feni 1720198350

12 25104 Parchim Ramnagar IPMC Ramnagar Ramnagar Daganbhuiyan Feni 1819600669
13 25105 Omarpur IPMC Omarpur Joylaskor Daganbhuiyan Feni 1816060909
14 25106 Moddya Aziz Fazilpur IPMC Aziz Fazilpur Ramnagar Daganbhuiyan Feni 1822029371
15   Daskin Barahiguni ICM Club Daskin Barahiguni Jailashkara Daganbhuiyan Feni 1816909749

  Upazila: Chhagalnaiya          
16   Muhorigonj Bahumukhi Samabi Sammittee Muhurigonj Ghopal Chhagalnaiya Feni 1821409326
17   Dowlatpur IPM Club Daulotpur Ghopal Chhagalnaiya Feni 1713605357
18 14102 Nij Panua Shamaj Kallan Sangshad Nijpanua Radhanagar Chhagalnaiya Feni 1715338934
19   Suvapur Krishi Samabaya Samity Suvapur Suvapur Chhagalnaiya Feni 1818581549

  Upazila: Parshuram          

20 51103 Chathalia Bahumukhi Shamaj Unnyan 
Shangstha Rampur Chithalia Parshuram Feni 01731 189891

21 51104 Dakshin Kolapara Somaj Kallyan Shangstha/
RACA Dakshin Kolapara Parshuram Parshuram Feni 01818 068512

  Upazila: Sonagazi          
22 94102 Mangalkandi Jubo Unnyan Shangshod Mangalkandi Mangalkandi Sonagazi Feni 1815122215
23 94104 Adarsha Somaj kallyan Sanghatha Adarsha Gram Char Darbesh Sonagazi Feni 1816032089
24 94105 Shahapur Jonokallyan Socity Voirab Chowdhury Bazar Sonagazi Sonagazi Feni 1812782568
25   Upoma Atto Kormosongthan Society Mahbub Miar Bazar Char majlishpur Sonagazi Feni 1710784547
26   Purba Shariat Kandi Gram Unnayan Sangstha Saraitkandi Sonagazi Sonagazi Feni 01813 934837
27   Akota Samaj Kallyan Sangstha Raghunathpur Nawabpur Sonagazi Feni 1913414958

28   Visnipur Arta Samajik Unnayan O Manab 
Kallyan Sangstha Visnopur Char Mojlishpur Sonagazi Feni 1821742354

  Upazila: Fulgazi          
31 52101 Monshir Hat Polli Unnyan Sangasta Darbarpur Munshirhat Fulgazi Feni 01716 842579

  Upazila:Fatikchari          
32   Digonta Somaj Kollayan Songtha (SIC) Baganbazar Baganbazar Fatikchari Chitagong  
33   Sheth Shora Sheba O upokoron Kendra (SIC) Sheth Shora Narayanhat Fatikchari Chitagong 1825664259
34   Neptune Shebha O upokoron Kendra (SIC) Neptune Narayanhat Fatikchari Chitagong 1818539990
35   Sotata Krishi O Somaj Kollayan Songtha (SIC) Heako Datmara Fatikchari Chitagong 1722616758
36   Ecota Krishi O Somaj Kollayan Songtha (SIC) kachua Khunda Baganbazari Fatikchari Chitagong 1827285329

  Upazila:Mirsari          
37   Ecota Krishok Songothon (SIC) Koiala Korerhat Mirsari Chitagong 1749132248
38   Sonali Krishok Songothon (SIC) Pachim Sonai Korerhat Mirsari Chitagong  
39   Jagrato Krishok Songothon (SIC) Nokhol Korerhat Mirsari Chitagong 1817233421
40   Kalapani Tripura Math Gobeshona Group Kalapani Korerhat Mirsari Chitagong  
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RFLDC – Barisal

the tsu of rFldc – Barisal is working in 39 upazilas of six districts of greater Barisal. over the project period 
they have formed 296 cBos and 5 cBo associations. geographical distribution of cBos is included below 
(table a5.29 – a5.35).

Table>A5.29   Geographical distribution of CBOs of RFLDC-TSU, Barisal

District Upazila Union>no.* No.>of>CBOs CBO>Association

Barguna** Amtali 10 13

1
Bamna 4 4
Sadar 11 12
Betagi 7 12
Patharghata 8 9

Bhola Sadar 13 13

1

Burhanuddin 10 10
Charfasson 8 17
Daulatkhan 7 10
Lalmohan 7 10
Manpura 5 5
Tazumuddin 5 5

Jhalokathi** Sadar 4 4

1
Kanthalia 5 6
Nalchity 4 4
Rajapur 2 2

Patuakhali** Bauphal 13 14

1

Dashmina 6 9
Galachipa 11 22
Kalapara 9 11
Mirzaganj 5 6
Sadar 6 16
Dumki 4 4

Pirojpur Bhandaria 4 4

None

Kawkhali 2 1
Mathbaria 7 11
Nazirpur 2 2
Sadar 6 6
Zianagar 2 2
Swarupkathi 4 4

Barisal** Agailjhara 3 3

1

Babuganj 3 3
Bakerganj 5 5
Banaripara 5 5
Gournadi 4 4
HIjla 3 6
Sadar 3 3
Mehendiganj 13 14
Muladi 4 8
Wazirpur 4 4

Total 39>upazila’s 238 303 5

* These figures represent the total number of unions in each upazila.
** These regions overlap with the IAPP.



98

a
n

n
ex 5: extra d

etails o
n

 Fo
s lin

ked
 to g

overn
m

en
t a

g
en

cies
Farm

ers’ o
rg

an
izatio

n
s in

 B
an

g
lad

esh
: a

 M
ap

p
in

g
 an

d
 c

ap
acity a

ssessm
en

t

List of CBOs of RFLDC in greater Barisal region 

Table>A5.30   List of CBOs in Barguna district

District Upazila Sl>no. Name>of>CBO

Barguna Amtali 1 Amtali Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 2 Arpangashia Union Sammannito Matshya Chasi Kallyan SamabaiSamity Ltd.
Barguna Amtali 3 Atharagashia Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 4 Amtola Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 5 Barabagi Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 6 Chowra Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 7 Kownia Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 8 Chandra Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 9 Gulisakhali Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 10 Haldia Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 11 Karaibaria Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 12 Kukua Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Amtali 13 Pancha Koralia Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Bamna 14 Bamna Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Bamna 15 Bukabunia Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Bamna 16 Dauatala Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Bamna 17 Ramna Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 18 Ayla Patakata Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 19 Badarkhali Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 20 Barguna Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 21 Burir Char Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 22 Burir Char Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 23 Choto Labongola Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 24 Dhalua Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 25 Phuljhuri Union Samannito Chasi Kallyan Samity
Barguna Barguna Sadar 26 Gaurichanna Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 27 Keorabunia Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 28 M.Baliatali Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Barguna Sadar 29 Naltona Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Betagi 30 Betagi Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Betagi 31 Betagi PS
Barguna Betagi 32 Bibichini Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Betagi 33 Putiakhali khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Barguna Betagi 34 Bura Mazumdar Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Betagi 35 Hosnabad Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Betagi 36 Kabilakon khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Barguna Betagi 37 Jalisha khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Barguna Betagi 38 Kazirabad Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Betagi 39 Betmor debapurar khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Barguna Betagi 40 Mokamia Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Betagi 41 Sarishamuri Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Patharghata 42 Char Duanti Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Patharghata 43 Kakchira Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Patharghata 44 Rupdon Bahumukhi Shamonnito Mahila Chasi Kallyan  Samity.
Barguna Patharghata 45 Kalmegha Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.
Barguna Patharghata 46 Kanthaltali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.
Barguna Patharghata 47 Nachna Para Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barguna Patharghata 48 Patharghata Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.
Barguna Patharghata 49 Pathorghata Paurashava Samannito Chasi Kallyan Samity
Barguna Patharghata 50 Raihanpur Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.

Total 5>upazilla’s 50>CBOs>>(1578>FFS)
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Table>A5.31   List of CBOs in Bhola district

District Upazila Sl>no. Name>of>CBO

Bhola Bhola Sadar 1 Alinagar Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 2 Bapta Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 3 Char Samaia Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 4 Char Shibpur Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 5 Dhania Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 6 Paschim Illisha Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 7 Purba Illisha Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 8 Kachia Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 9 Uttar Dighaldi Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 10 Rajapur Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 11 Dakshin Dighaldi Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 12 Bhedaria Sammannito Chasi Kallyan Samity
Bhola Bhola Sadar 13 Bhelu Miah Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 14 Bara Manika Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 15 Deula Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 16 Gangapur Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 17 Hassan Nagar Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 18 Kachia Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 19 Kutba Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 20 Burhanuddin PS Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 21 Pakshia Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 22 Sachra Sammannito Chasi Kallyan Samity
Bhola Burhanuddin 23 Tabgi Sammannito Chasi Kallyan Samity
Bhola Char Fasson 24 Aminabad Sammannito Chasi Kallyan Samity
Bhola Char Fasson 25 Aslampur Sammannito Chasi Kallyan Samity
Bhola Char Fasson 26 Omarpur Sammannito Chasi Kallyan Samity Ltd. (Amiruddi khal Jalmohol)
Bhola Char Fasson 27 Char Kalmi Sammannito Chasi Kallyan Samity
Bhola Char Fasson 28 Char Kukri Mukri Sammannito Chasi Kallyan Samity
Bhola Char Fasson 29 Char Madras Sammannito Chasi Kallyan Samity
Bhola Char Fasson 30 Char Manika Sammannito Chasi Kallyan Samity
Bhola Char Fasson 31 Hazariganj Sammannito Chasi Kallyan Samity
Bhola Char Fasson 32 Ewaspur Sammannito Chasi Kallyan Samity
Bhola Char Fasson 33 Rasulpur Sammannito Chasi Kallyan Samity
Bhola Char Fasson 34 Jahanpur Sammannito Chasi Kallyan Samity
Bhola Char Fasson 35 Jinnaghar Sammannito Chasi Kallyan Samity
Bhola Char Fasson 36 Nilkamal Sammannito Chasi Kallyan Samity
Bhola Char Fasson 37 Surji and Morangi khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Bhola Char Fasson 38 Pangasia khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Bhola Char Fasson 39 Nurabad Sammannito Chasi Kallyan Samity
Bhola Char Fasson 40 Osmanganj Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 41 Bhabanipur
Bhola Daulatkhan 42 Char Khalifa Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 43 Char Pata Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 44 Hajipur Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 45 Madanpur Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 46 Medua Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 47 Uttar Joynagar Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 48 Dakkhin Joynagar Sammannito Chasi Kallyan Samity
Bhola Daulatkhan 49 Daulatkhan PS
Bhola Daulatkhan 50 Saidpur Sammannito Chasi Kallyan Samity
Bhola Lalmohan 51 Badarpur Sammannito Chasi Kallyan Samity
Bhola Lalmohan 52 Char Bhuta Sammannito Chasi Kallyan Samity
Bhola Lalmohan 53 Dhali Gaurnagar Sammannito Chasi Kallyan Samity
Bhola Lalmohan 54 Farazganj Sammannito Chasi Kallyan Samity
Bhola Lalmohan 55 Kalma Sammannito Chasi Kallyan Samity
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District Upazila Sl>no. Name>of>CBO

Bhola Lalmohan 56 Lalmohan Sammannito Chasi Kallyan Samity
Bhola Lalmohan 57 Lord Hardinje Sammannito Chasi Kallyan Samity
Bhola Lalmohan 58 Ramganj Sammannito Chasi Kallyan Samity
Bhola Lalmohan 59 Bapter Khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Bhola Lalmohan 60 Paschim Char Umed Sammannito Chasi Kallyan Samity
Bhola Manpura 61 Hajirhat Sammannito Chasi Kallyan Samity
Bhola Manpura 62 Harir khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Bhola Manpura 63 Manpura Sammannito Chasi Kallyan Samity
Bhola Manpura 64 Sakuchia Sammannito Chasi Kallyan Samity
Bhola Manpura 65 Sagorika khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Bhola Tazumuddin 66 Chanchra Sammannito Chasi Kallyan Samity
Bhola Tazumuddin 67 Chandpur Sammannito Chasi Kallyan Samity
Bhola Tazumuddin 68 Keya mollah khal Jalmohol Matshya Chasi Samabai Samity Ltd.
Bhola Tazumuddin 69 Sonapur Sammannito Chasi Kallyan Samity
Bhola Tazumuddin 70 Shambhupur Sammannito Chasi Kallyan Samity

Total 7>upazilla’s 70>CBO>>(2115>FFS)

Table>A5.32   List of CBOs of Patuakhali district

District Upazila Sl>no. Name>of>CBO

Patuakhali Bauphal 1 Adabaria Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 2 Baga Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 3 Bauphal Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 4 Daspara Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 5 Dhulia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 6 Kanchi Para Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 7 Kalaiya Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 8 Kalisuri Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 9 Kanakdia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 10 Keshabpur Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 11 Madanpura Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 12 Noamala

Patuakhali Bauphal 13 Nazirpur Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Bauphal 14 Surjyamani Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dashmina 15 Alipur Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dashmina 16 Chandpur khal Jalmohol Matshya Chasi Samabai Samity Ltd.

Patuakhali Dashmina 17 Bahrampur Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dashmina 18 Banshbaria Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dashmina 19 Betagi Sankipura Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dashmina 20 Dashmina Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dashmina 21 Golkhali khal Jalmohol Matshya Chasi Samabai Samity Ltd.

Patuakhali Dashmina 22 Rangopaldi Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dashmina 23 Gulir khal Jalmohol Matshya Chasi Samabai Samity Ltd.

Patuakhali Galachipa 24 Amkhola Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 25 Bashbunia Matshya Chasi Kallyan Samabai Samity Ltd.

Patuakhali Galachipa 26 Bakulbaria Sammannito Chasi Kallyan Samity

Patuakhali Galachipa 27 Kalagachia Sammannito Chasi Kallyan Samity

Patuakhali Galachipa 28 Bara Baisdia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 29 Chalitabunia

Patuakhali Galachipa 30 Char Biswas Sammannito Chasi Kallyan Samity

Patuakhali Galachipa 31 Char kajai Sammannito Chasi Kallyan Samity

Patuakhali Galachipa 32 Chhota Baisdia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.
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District Upazila Sl>no. Name>of>CBO

Patuakhali Galachipa 33 Chiknikandi Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 34 Gajalia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 35 Gazalia Matshya Chasi Kallyan Samabai Samity Ltd.

Patuakhali Galachipa 36 Dakua Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 37 Pangashia Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 38 Galachipa Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 39 Bualia Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 40 Golkhali Sammannito Chasi Kallyan Samity

Patuakhali Galachipa 41 Panpatty Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 42 Rangabali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 43 Char Momtaj Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 44 Ratandi Taltali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Galachipa 45 Manikchand Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 46 Chakamaiya

Patuakhali Kala Para 47 Khaprabhanga Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 48 Dhulasar

Patuakhali Kala Para 49 Lalua Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 50 Lata Chapli Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 51 Dhankhali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 52 Mithaganj Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 53 Nilganj Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 54 Pakhimara Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 55 Tiakhali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Kala Para 56 Badurtali Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Mirzaganj 57 Amragachhia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Mirzaganj 58 Deuli Subidkhali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Mirzaganj 59 Karabunia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Mirzaganj 60 Madhabkhali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Mirzaganj 61 Majidbari Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Mirzaganj 62 Mirzaganj Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 63 Paurashava

Patuakhali Patuakhali Sadar 64 Badarpur Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 65 Chhota Bighai Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 66 Auliapur Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 67 Itabaria Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 68 Jainkati Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 69 Bara Bighai Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 70 Kalikapur

Patuakhali Patuakhali Sadar 71 W. Bohalgachia Samajvittik Jalmohol Babosthapana Matshyajibi Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 72 Kamalapur Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 73 Dharandi Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 74 Lohalia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 75 Laukati Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 76 Madarbunia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 77 Marichbunia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Patuakhali Sadar 78 Marichbunia Jalmohol Matshya Chasi Samabai Samity Ltd.

Patuakhali Dumki 79 Lebukhali Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dumki 80 Angaria Sammannito Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dumki 81 Muradia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Patuakhali Dumki 82 Pangashia Union Sammannito Matshya Chasi Kallyan Samabya Samity Ltd.

Total 7>upazilla’s 82>CBO>>(2632>FFS)
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Table>A5.33   List of CBOs in Barisal district

District Upazila Sl>no. Name>of>CBO

Barisal Agailjhara 1 Bagdha  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Agailjhara 2 Rajiher  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Agailjhara 3 Ratnapur Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Babuganj 4 Agarpur  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Babuganj 5 Chandpasha  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Babuganj 6 Kedarpur Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Babuganj 7 Rahmatpur Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Bakerganj 8 DarialUnion Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Bakerganj 9 Dudhal  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Bakerganj 10 Durga Pasha Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Bakerganj 11 Garuria  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Bakerganj 12 Rangasree  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Banari Para 13 Banari Para Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Banari Para 14 Baisari Para Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Banari Para 15 Salia Bakpur  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Banari Para 16 Saidkati  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Gaurnadi 17 BarthiUnion Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Gaurnadi 18 Batajore Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Gaurnadi 19 Nalchira  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Gaurnadi 20 Sarikal  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Hizla 21 Bara Jalia Union Sammannito Chasi Kallyan Samabai Samity Ltd.
Barisal Hizla 22 Dhulkhola Union Sammanita Chashi Kallyan Somabai Somity Ltd
Barisal Hizla 23 Guabaria Sammannito Chasi Kallyan Samity
Barisal Hizla 24 Harinathpur Sammannito Chasi Kallyan Samity
Barisal Hizla 25 Hizla Gaurabdi Sammannito Chasi Kallyan Samity
Barisal Hizla 26 Memania Sammannito Chasi Kallyan Samity
Barisal Barisal Sadar (Kotwa) 27 Jagua Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Barisal Sadar (Kotwa) 28 Roy Pasha Karapur  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Barisal Sadar (Kotwa) 29 Shayestabad Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Mehendiganj 30 Alimabad Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 31 Andhar Manik Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 32 Bhasan Char Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 33 Bidyanandapur Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 34 Chandpur Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 35 Gobindapur Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 36 Char Ekkuria Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 37 Char Gopalpar Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 38 Dari Char Khajuria Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 39 Jangalia Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 40 Lata Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 41 Mehendiganj  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Mehendiganj 42 Mehendigonj Porasava Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Mehendiganj 43 Ulania Union Sammanita Chashi Kallyan Somabai Somitte Ltd
Barisal Muladi 44 Batamara Union Sammannito Chasi Kallyan Samabai Samity Ltd.
Barisal Muladi 45 Char Kalekhan Union Sammannito Chasi Kallyan Samity
Barisal Muladi 46 Gachhua Sammannito Chasi Kallyan Samity
Barisal Muladi 47 Kazir Char Sammannito Chasi Kallyan Samity
Barisal Muladi 48 Muladi Sammannito Chasi Kallyan Samity
Barisal Muladi 49 Nazirpur Sammannito Chasi Kallyan Samity
Barisal Muladi 50 Safipur Sammannito Chasi Kallyan Samity
Barisal Muladi 51 Paurashava Sammannito Chasi Kallyan Samity
Barisal Wazirpur 52 Harta Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Wazirpur 53 Jalla Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Wazirpur 54 Otra  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.
Barisal Wazirpur 55 Sholak  Union Sammannito Matshya Chasi Kallyan Samabai Samity Ltd.

Total 8>upzilla’s 55>CBO>(1,277>FFS)
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Table>A5.34   List of CBOs in Jhalakathi district

District Upazila Sl>no Name>of>CBO

Jhalakathi Jhalokati Sadar 1 Basanda Sammannito Chasi Kallyan Samity
Jhalakathi Jhalokati Sadar 2 Nathullabad Sammannito Chasi Kallyan Samity
Jhalakathi Jhalokati Sadar 3 Kirtipasha Sammannito Chasi Kallyan Samity
Jhalakathi Jhalokati Sadar 4 Ponabalia  Sammannito Chasi Kallyan Samity
Jhalakathi Kanthalia 5 Amua Sammannito Chasi Kallyan Samity
Jhalakathi Kanthalia 6 Adrabunia Sammannito Chasi Kallyan Samity
Jhalakathi Kanthalia 7 Chenchri Rampur Sammannito Chasi Kallyan Samity
Jhalakathi Kanthalia 8 Kanthalia Sammannito Chasi Kallyan Samity
Jhalakathi Kanthalia 9 Patkelghata Sammannito Chasi Kallyan Samity
Jhalakathi Kanthalia 10 Sauljalia Sammannito Chasi Kallyan Samity
Jhalakathi Nalchity 11 Kusanghal Union Sammannito Chasi Kallyan Samity
Jhalakathi Nalchity 12 Mollahat Union Sammannito Chasi Kallyan Samity
Jhalakathi Nalchity 13 Nachan Mohal Union Sammannito Chasi Kallyan Samity
Jhalakathi Nalchity 14 Bhairabpasha Sammannito Chasi Kallyan Samity
Jhalakathi Rajapur 15 Baruia Sammannito Chasi Kallyan Samity
Jhalakathi Rajapur 16 Saturia Union Sammannito Chasi Kallyan Samity

Total 4>upzilla’s 16>CBO>(278>FFS)

Table>A5.35   List of CBOs in Pirojpur district

District Upazila Sl>no. Name>of>CBO

Pirojpur Bhandaria 1 Bhandaria Sammannito Chasi Kallyan Samity
Pirojpur Bhandaria 2 Bhitabaria Union Sammannito Chasi Kallyan Samity
Pirojpur Bhandaria 3 Gauripur Sammannito Chasi Kallyan Samity
Pirojpur Bhandaria 4 Ikri Sammannito Chasi Kallyan Samity
Pirojpur Kawkhali 5 Chira Para Union Sammannito Chasi Kallyan Samity
Pirojpur Kawkhali 6 Shialkati Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 7 Amragachhia Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 8 Bara Machhua Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 9 Betmore Rajpara Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 10 Daudkhali Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 11 Dhanisafa Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 12 Gulishakhali Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 13 Mathbaria Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 14 Mathbaria Pourashava Sammannito Chasi Kallyan Samabya Samity Ltd.
Pirojpur Mathbaria 15 Mirukhali Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 16 Sapleza Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 17 Tikikata Sammannito Chasi Kallyan Samity
Pirojpur Mathbaria 18 Tushkhali Sammannito Chasi Kallyan Samity
Pirojpur Nazirpur 19 Sekhmatia Sammannito Chasi Kallyan Samity
Pirojpur Nazirpur 20 Shankharikati Sammannito Chasi Kallyan Samity
Pirojpur Pirojpur Sadar 21 Durgapur Union Sammannito Chasi Kallyan Samity
Pirojpur Pirojpur Sadar 22 Kadamtala Sammannito Chasi Kallyan Samity
Pirojpur Pirojpur Sadar 23 Kalakhali Union Sammannito Chasi Kallyan Samity
Pirojpur Pirojpur Sadar 24 Shankarpasha Sammannito Chasi Kallyan Samity
Pirojpur Pirojpur Sadar 25 Sariktala Union Sammannito Chasi Kallyan Samity
Pirojpur Pirojpur Sadar 26 Tona Union Sammannito Chasi Kallyan Samity
Pirojpur Zianagar 27 Bali Para Sammannito Chasi Kallyan Samity
Pirojpur Zianagar 28 Parerhat Sammannito Chasi Kallyan Samity
Pirojpur Nesarabad (Swarupkat 29 Baldia Union Sammannito Chasi Kallyan Samity
Pirojpur Nesarabad (Swarupkat 30 Sarengkati Sammannito Chasi Kallyan Samity
Pirojpur Nesarabad (Swarupkat 31 Shohagdol Union Sammannito Chasi Kallyan Samity
Pirojpur Nesarabad (Swarupkat 32 Sutiakati Union Sammannito Chasi Kallyan Samity

Total 7>upzilla’s 32>CBOs>>(562>FFSs)
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National Agricultural Technology Project – DLS Part

Project summary

the natP is the first five-year phase of a long-term (15-year) programme of the government to increase 
national agricultural productivity and farm incomes. under the dls part, livestock and poultry rearers have 
been mobilized and organized into cigs.

Table>A5.36  Geographical distribution of CIGs under NATP – Livestock Component (phase I)

Sl.>no. Districts Upazila>covered> Union>covered Pouroshova>covered Livestock>CIG

1 Mymensingh 8 105 3 318
2 Kishoreganj 4 33 4 105
3 Sherpur 3 31 3 102
4 Tangail 8 66 7 213
5 Gazipur 4 36 4 117
6 Narsingdi 5 46 5 138
7 Dhaka 2 28 2 84
8 Comilla 6 66 6 207
9 B.Baria 4 46 4 174

10 Chandpur 4 48 4 138
11 Chittagong 6 93 6 252
12 Cox'bazar 3 27 2 81
13 Sylhet 6 47 2 144
14 Moulvibazar 6 61 5 183
15 Kushtia 4 43 4 135
16 Jhenaidah 3 33 3 108
17 Jessore 8 91 8 279
18 Khulna 5 45 2 138
19 Satkhira 3 38 2 120
20 Rajbari 3 31 2 120
21 Faridpur 3 26 1 78
22 Natore 4 41 6 129
23 Bogra 6 58 6 186
24 Dinajpur 6 55 3 165
25 Rangpur* 6 68 3 207

Total 120 1,262 97 3,921

* This region overlaps with the IAPP.

Integated Agricultural Productivity Project– 
DLS Part

Project summary

as mentioned earlier, the objective of the overall 
iaPP is to sustainably enhance productivity of 
agriculture (crop, livestock and fisheries) in two 
agro-ecologically constrained and economically 
fragile areas.

Table>A5.37   Year-wise target of Livestock Rearers Group 
                        mobilization under IAPP-DLS part

Agency year-wise>target Total

2011 2012 2013 2014 2015

DLS (Livestock Rearers Group) 272 942 1,296 864 376 3,750

Source: Work Plan, IAPP, December 2012.

KEy>FEATURES

Project:>IAPP
Funded>by:>GAFSP
Duration:>2010-2015
Approach>in>forming>FO:>Livelihood>Field>School
Name>of>FO:>LFS,>Livestock>Rearer>Group
Total>LFS:>1,200
Geo.>Coverage:>4>districts>in>northern>and>
southern>regions.
Innovation:>Multi-agency>(8)>coordination.
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Ministry of Local Government, Rural Development & Cooperatives (MLGRD&C)

Village Savings and Loans Groups (VSLGs) under the Chars Livelihood Programme (CLP)

recognizing the lack of awareness of the importance of saving among the char dwellers as well as the lack of 
access to formal microfinance from ngos, the clP introduced the Village savings and loans (Vsl) project.

no database on geographical distribution of Vslgs was found during mapping exercises.

Social Development Foundation

the social development Foundation (sdF) is an autonomous organization of the government of Bangladesh. 
it was established in 2000 and is registered under the companies act of 1994. since 2001, sdF has been 
implementing the World Bank-funded social investment Program Project (siPP). the siPP completed its first 
phase in december 2010 and phase 2 (also called the nuton Jibon Project) began thereafter.

Project summary 

the empowerment and livelihood improvement “nuton 
Jibon” Project (new life Project) is part of a long-term 
approach to support holistic village development. 
this development comes through the establishment 
of effective and efficient financing and institutional 
arrangements to improve access to local infrastructure 
and basic services, which give importance to the 
hardcore poor and poor. Members of these institutions 
are not exclusively farmers, but a large share do draw all 
or a part of their livelihood from agriculture (including 
livestock).

Table>A5.38   Gram Samitys formed by the Nuton Jibon Project of SDF

Region District Cluster>offices>(no.s) Village>Assocations

Barisal Patuakhali, Barisal, Pirojpur, Bagerhat and Barguna 45 709

Jamalpur Jamalpur, Serajganj, Sylhet, Mymensingh, Sherpur 36 1,133

Rangpur Gaibandha, Rangpur, Dinajpur, Kurigram, Nilphamari, 
Naogaon 43 1,420

Total 16>districts 124>cluster>offices 3,262>Gram>Samitys

KEy>FEATURES

Project:>Nuton>Jibon
Funded>by:>World>Bank
Duration:>2010-2016
Name>of>FO:>>Gram>Samity
Total>FO:>3,262
Geo.>coverage:>16>districts>covering>six>
divisions>such>as>Dhaka,>Rangpur,>Rajshahi,>
Khulna,>Barisal>and>Sylhet.
Innovation:>Intensive>institution>formation.
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Figure>A5.2   Organigram of Gram Parishad

GRAM SAMITY (Village Association) 
(9 members: 7 members from NJG and others from the rest of the HHs,

to be selected by the hardcore poor and poor; at least 2 women and 1 youth)

GRAM PARISHAD (Village Council) 
One adult member from each household; quorum: 70% of the HCP and 60% of the poor people of the village.

Of them 50% must be women and 30% youth.

SanchaySangrakhan Committee (SSC)

Leaders & cashiers from 3-5 NJG

Social Audit Committee (SAC)

5 members out of whom 
4 are from HCP/Poor 

and 3 women

Village Credit Organization (VCO)

All leaders of SSC and
2 nominated VI members

SanchaySangrakhan Committee (SSC)

Leaders & cashiers from 3-5 NJG

NJG NJG NJG NJG NJG NJG

10-15 
members of
HCP & Poor

10-15 
members of
HCP & Poor

10-15 
members of
HCP & Poor

10-15 
members of
HCP & Poor

10-15 
members of
HCP & Poor

10-15 
members of
HCP & Poor

Other committee (if needed) Procurement committee Finance committee O&M committee
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information in this annex is directly linked to the different sections of the main report. it is organized by 
international ngo and by project.

Action Aid Bangladesh

Kendrio Krishok Moitree

Kendrio Krishok Moitree (KKM) (central Farmers’ alliance) was established in 2009 under the european union-
funded Food security for sustainable household livelihoods (Foshol) project. it has been supported both 
financially and technically by action aid Bangladesh since that time. the Foshol project has since closed, and 
action aid is now only providing technical assistance.

Figure>A6.1   Organogram of KKM

Annex 6
Extra details on farmers’ organizations formed 
with support from international non-governmental 
organizations

General Assembly 
(Presently 30 union farmers’ alliance representatives)

1. Thirty union moitree coordinators 
(paid by KKM) to directly support the 
village and union level organizations.  

2. Ten executive commmittee members 
support and mentor the union 
moitree coordinator. 

3. One supervisor for central alliance 
activity supervision. 

4. One marketing o�cer for seed 
business running. 

Executive Committee (13 members)

1.  President: Md. Ali Shamsuddin
2.  Vice President: Md. Munir Ahammed 
3.  Secretary: Mohammad Alauddin Sikder
4.  Organizational Secretary: Abul Kalm Azad
5.  Cashier : Md. Abdul Mozid 
6.  Rina Akter- Executive member 
7.  Morzina Begom- Executive member
8.  Afsana Yesmeen- Executive member
9.  Jhorna Begom- Executive member
10.  Nikhil Mollik- Executive member 
11.  Kakon Mojumdar- Executive member 
12.  Mrs. Shokhina Begum - Executive member 
13.  Md. Abdul Awal- Executive member

Union Farmers Alliance
Made up of 25-30 

farmers’ organizations 
(with 25-30 farmers each)

Union Farmers Alliance
Made up of 25-30 

farmers’ organizations 
(with 25-30 farmers each)

Union Farmers Alliance
Made up of 25-30 

farmers’ organizations 
(with 25-30 farmers each)

Union Farmers Alliance
Made up of 25-30 

farmers’ organizations 
(with 25-30 farmers each)
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Table>A6.1   Administrative distribution of Union Farmers’ Alliance, FOs and number of farmers with KKM

District Upazilla Name>of>Union>Farmers’>Alliance No.>of>farmers’>organization>/>
Union>Farmers’>Alliance

Total>no.>of>farmers>/>>
Union>Farmers>Alliance

Kurigram

Sadar
1. Vogdanga 25 625
2. Ghogadaha 28 700
3. M. Komorpur 34 850

Ulipur
4. Pandul 33 825
5. Dharanibari 29 725
6. Sadi 30 750

Sunamgonj Biswamvarpur
7. Badaghat 34 850
8. Solukabad 33 825
9. Dhanpur 26 650

Noakhali Sadar

10. Noannoai 19 475
11. Awozbalia 29 725
12. Dadpur 20 500
13. Noakhali 25 625

Satkhira

Sadar
14. Dhulihor 34 850
15. Brommorajpur 32 800
16. Fingri 27 675

Tala
17. Nogorghata 18 450
18. Sorulia 33 825
19. Tetulia 34 850

Khulna

Rupsha
20. Alypur 30 750
21. Ghatvog 31 775
22. Noihati 24 600

Koyra

23. Bagali 27 675
24. Moharajpur 16 400
25. Koyra 27 675
26. Uttor Bedkashi 22 550

Patuakhali Kalapara
27. Mithagonj 44 1,100
28. Nilgonj 40 1,000
29. Lalua 9 225

Dinajpur Ghoraghat 30. Ghoraghat 15 375

Total>number>of>organizations>&>members>of>Kendio>Krishok>Moitree-KKM 828>farmers>organizations 20,700>farmers>under>>
Kendrio>Krishok>Moitree

NB: These farmers are engaged in different types of agricultural production and marketing activities to improved their profit 
margin. They also put a lot of emphasis on organizational development, as well as on building relationships and alliances with 
others FOs in Bangladesh.

Figure>A6.2   Process of federating FOs in KKM

Coops

• Mobilize poor and landless 
farmers in groups

• Leadership development

• Form alliance at union level 
• Raise voice of farmers
• Group dissemination 

of technologies • Organizational skill 
development

• Leadership development 
• Networking with 

producers of KKM and 
other organizations 

Village level FOs
(828)

Union Moitree
(30) 

Kendrio Krishak
Moitree (1)
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CARE Bangladesh

at present, care Bangladesh is implementing 2 projects relevant to agriculture that work with Fos. these 
are: strengthening household ability to respond to development opportunities (shouhardo ii) and Food 
security for ultra-Poor in the haor region (FsuP-h Project). information regarding Fos under shouhardo ii 
was not available at the head office, as there is no 
central management information system for the project. 
however, information about Fos under the FsuP-h 
project was available during the mapping exercise, and 
is included herewith.

Project summary

the overall objective of the FsuP-h project is to reduce 
extreme poverty and food insecurity of 55,000 ultra poor 
households in the haor19 region of northeast Bangladesh. 
it is to be done by sustainably improving food access and 
utilization and reducing the vulnerability of women and 
their dependents in ultra poor households in sunamganj, 
netrakona and Kishoreganj districts.

Table>A6.2   Haor district-wise distribution of VDCs of FSUP-H Project of CARE Bangladesh

District Upazila* Unions* Village>Development>Committee>(VDC)

Kishoreganj 7 36 233

Netrakona 5 19 177

Sunamganj 6 36 235

Total 18 91 645

Source: FSUP-H Project, CARE Bangladesh, 2012.
* These figures represent the total number of upazilas and unions in each district.

Table>A6.3   Haor district-wise detail distribution of VDCs under FSUP-H Project

VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

001 Adampur Adampur Austagram Kishoreganj POPI
002 Ainarkandi Adampur Austagram Kishoreganj POPI
003 Baluchar Adampur Austagram Kishoreganj POPI
004 Boragirkandi Adampur Austagram Kishoreganj POPI
005 Jabalonga Adampur Austagram Kishoreganj POPI
006 Lawra Adampur Austagram Kishoreganj POPI
007 Nayahati Adampur Austagram Kishoreganj POPI
008 Austogram (Das para) Austogram sadar Austagram Kishoreganj POPI
009 Austogram (Habila para) Austogram sadar Austagram Kishoreganj POPI
010 Austogram (Hatkhola) Austogram sadar Austagram Kishoreganj POPI
011 Austogram (Kalapara) Austogram sadar Austagram Kishoreganj POPI
012 Austogram (Kazipara) Austogram sadar Austagram Kishoreganj POPI
013 Austogram (Sonaidighi) Austogram sadar Austagram Kishoreganj POPI
014 Anowarpur Bangalpara Austagram Kishoreganj POPI
015 Bhatinagar Bangalpara Austagram Kishoreganj POPI
016 Hydrabad - kalimpur Bangalpara Austagram Kishoreganj POPI
017 Karamnagar Bangalpara Austagram Kishoreganj POPI
018 Laura Bangalpara Austagram Kishoreganj POPI

19 Haor - Large natural inter-riverine depression typically extending over 1,000 ha or more; may be inundated to depths of three meters or more during the monsoon season. 

KEy>FEATURES

Project:>FSUP-H
Funded>by:>CARE
Duration:>2007-2013
Name>of>FO:>>VDC
Total>VDC:>645
Geo.>coverage:>Haor areas>of>Sunamganj,>
Netrakona>and>Kishoreganj>districts.
Innovation:>Mobilize>VDCs>as>self>managed>
‘peoples>organizations’>so>that>they>can>
dialogue>with>local>government>to>establish>
farmers’>rights.
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VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

019 Najirpur Bangalpara Austagram Kishoreganj POPI
020 Noyagoan Bangalpara Austagram Kishoreganj POPI
021 Osmanpur Bangalpara Austagram Kishoreganj POPI
022 Rothani Bangalpara Austagram Kishoreganj POPI
023 Ali nagar Deoghar Austagram Kishoreganj POPI
024 Deoghor Deoghar Austagram Kishoreganj POPI
025 Poschim Deoghor Deoghar Austagram Kishoreganj POPI
026 Savia nagar Deoghar Austagram Kishoreganj POPI
027 Dhalarkandi Kalma Austagram Kishoreganj POPI
028 Kalma Kalma Austagram Kishoreganj POPI
029 Sharif pur Kalma Austagram Kishoreganj POPI
030 Shibla Kalma Austagram Kishoreganj POPI
031 Bramanpara Kastail Austagram Kishoreganj POPI
032 Masjidjam (Dakhin) Kastail Austagram Kishoreganj POPI
033 Masjidjam (Daspara) Kastail Austagram Kishoreganj POPI
034 Masjidjam (Mira hati) Kastail Austagram Kishoreganj POPI
035 Kastual (Muslimpara) Kastail Austagram Kishoreganj POPI
036 Kastual (Shantinagar) Kastail Austagram Kishoreganj POPI
037 Abdullahpur Khayerpur-Abdullahpur Austagram Kishoreganj POPI
038 Kalimpur Khayerpur-Abdullahpur Austagram Kishoreganj POPI
039 Kodomchol Khayerpur-Abdullahpur Austagram Kishoreganj POPI
040 Birgoan Purbo austogram Austagram Kishoreganj POPI
041 Hazipara Purbo austogram Austagram Kishoreganj POPI
042 Kabir khandan Purbo austogram Austagram Kishoreganj POPI
043 Khashal Purbo austogram Kishoreganj POPI
044 Pukurpar Purbo austogram Austagram Kishoreganj POPI
045 Badla Badla Itna Kishoreganj POPI
046 Borshikura Badla Itna Kishoreganj POPI
047 Thaneshor Badla Itna Kishoreganj POPI
048 Boraibari Baraibari Itna Kishoreganj POPI
049 Dhitpur Baraibari Itna Kishoreganj POPI
050 Panchkahania Baraibari Itna Kishoreganj POPI
051 Chandrapur Chuaganga Itna Kishoreganj POPI
052 Chuaganga Chuaganga Itna Kishoreganj POPI
053 Keruala Chuaganga Itna Kishoreganj POPI
054 Komol-bag (Modho) Chuaganga Itna Kishoreganj POPI
055 Komol-bag (Purbo) Chuaganga Itna Kishoreganj POPI
056 Krisnopur Chuaganga Itna Kishoreganj POPI
057 Bak-sai Dhanpur Itna Kishoreganj CARE B
058 Charpara Dhanpur Itna Kishoreganj CARE B
059 Kathoir Dhanpur Itna Kishoreganj CARE B
060 Koroncha Dhanpur Itna Kishoreganj CARE B
061 Raj nagar Dhanpur Itna Kishoreganj CARE B
062 Shahila Dhanpur Itna Kishoreganj CARE B
063 Boro hatkabila Elongjuri Itna Kishoreganj POPI
064 Kak-tengur Elongjuri Itna Kishoreganj POPI
065 Nurpur Elongjuri Itna Kishoreganj POPI
066 Aroura Mozlispur Itna sadar Itna Kishoreganj CARE B
067 Betega Itna sadar Itna Kishoreganj CARE B
068 Chotul Itna sadar Itna Kishoreganj CARE B
069 Ershadnagar Itna sadar Itna Kishoreganj CARE B
070 Modho-gram Itna sadar Itna Kishoreganj CARE B
071 Purbo-gram Itna sadar Itna Kishoreganj CARE B
072 Nurpur Itna sadar Itna Kishoreganj CARE B
073 Shakendarpur Itna sadar Itna Kishoreganj CARE B
074 Udierpar Itna sadar Itna Kishoreganj CARE B



111

a
nn

ex
 6

: e
xt

ra
 d

et
ai

ls
 o

n 
Fo

s 
lin

ke
d 

to
 in

te
rn

at
io

na
l n

g
o

s
Fa

rm
er

s’
 o

rg
an

iz
at

io
n

s 
in

 B
an

g
la

d
es

h
: a

 M
ap

p
in

g
 a

n
d

 c
ap

ac
it

y 
a

ss
es

sm
en

t

VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

075 Algapara Joysiddhi Itna Kishoreganj POPI
076 Duarpar Joysiddhi Itna Kishoreganj POPI
077 Karanshi Joysiddhi Itna Kishoreganj POPI
078 Modirgoan Joysiddhi Itna Kishoreganj POPI
079 Pagalshi Joysiddhi Itna Kishoreganj POPI
080 Ray hati Joysiddhi Itna Kishoreganj POPI
081 Shampur Joysiddhi Itna Kishoreganj POPI
082 Dakshin Raji Raituti Itna Kishoreganj POPI
083 Dhara Raituti Itna Kishoreganj POPI
084 Gondobpur Raituti Itna Kishoreganj POPI
085 Guara Raituti Itna Kishoreganj POPI
086 Pachiasia Raituti Itna Kishoreganj POPI
087 Patharkandi Raituti Itna Kishoreganj POPI
088 Pungdulan Raituti Itna Kishoreganj POPI
089 Raituti Raituti Itna Kishoreganj POPI
090 Uttar Raji Raituti Itna Kishoreganj POPI
091 Barbarta Baragharia Karimganj Kishoreganj CARE B
092 Baroghoria Baragharia Karimganj Kishoreganj CARE B
093 Chatal Baragharia Karimganj Kishoreganj CARE B
094 Ditpur Baragharia Karimganj Kishoreganj CARE B
095 Jahirabad Baragharia Karimganj Kishoreganj CARE B
096 Vusarkanda Baragharia Karimganj Kishoreganj CARE B
097 Ashatoka Gundhar Karimganj Kishoreganj CARE B
098 Bhati Gangatia Gundhar Karimganj Kishoreganj CARE B
099 Chonkanda Gundhar Karimganj Kishoreganj CARE B
100 Gundhar Gundhar Karimganj Kishoreganj CARE B
101 Kadim-maij hati Gundhar Karimganj Kishoreganj CARE B
102 Khairat Gundhar Karimganj Kishoreganj CARE B
103 Mokam Bari Gundhar Karimganj Kishoreganj CARE B
104 Sultan Nagar Gundhar Karimganj Kishoreganj CARE B
105 Urdighi Gundhar Karimganj Kishoreganj CARE B
106 Baliapara Sutarpara Karimganj Kishoreganj CARE B
107 Sutarpara Sutarpara Karimganj Kishoreganj CARE B
108 Uttar Gonespur Sutarpara Karimganj Kishoreganj CARE B
109 Durgapur Chandpur Katiadi Kishoreganj POPI
110 Kona para Chandpur Katiadi Kishoreganj POPI
111 Kurerpar Chandpur Katiadi Kishoreganj POPI
112 Modinaspara Chandpur Katiadi Kishoreganj POPI
113 Nimok purara Chandpur Katiadi Kishoreganj POPI
114 Poschim mondal bhoge Chandpur Katiadi Kishoreganj POPI
115 Purbo mondal Bhoge Chandpur Katiadi Kishoreganj POPI
116 Purbo para Chandpur Katiadi Kishoreganj POPI
117 Shekher para Chandpur Katiadi Kishoreganj POPI
118 Bahatta Kargaon Katiadi Kishoreganj POPI
119 Baster par Kargaon Katiadi Kishoreganj POPI
120 Bhuna Kargaon Katiadi Kishoreganj POPI
121 Dangergoan Kargaon Katiadi Kishoreganj POPI
122 Kargaon Poschim Kargaon Katiadi Kishoreganj POPI
123 Kawna Kargaon Katiadi Kishoreganj POPI
124 Lohondo Kargaon Katiadi Kishoreganj POPI
125 Mahamudpur Kargaon Katiadi Kishoreganj POPI
126 Pachlipara Kargaon Katiadi Kishoreganj POPI
127 Baher Char Lohajuri Katiadi Kishoreganj POPI
128 Char kawnia Lohajuri Katiadi Kishoreganj POPI
129 Dakhin Jirarpar Lohajuri Katiadi Kishoreganj POPI
130 Dakhin Lohajuri Lohajuri Katiadi Kishoreganj POPI
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VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

131 Uttor Lohajuri Lohajuri Katiadi Kishoreganj POPI
132 Uttor-Purbo Char para tala Lohajuri Katiadi Kishoreganj POPI
133 Baghjor kanda Shahasram Dhuldia Katiadi Kishoreganj POPI
134 Dewjan Shahasram Dhuldia Katiadi Kishoreganj POPI
135 Diakul Shahasram Dhuldia Katiadi Kishoreganj POPI
136 Kautori para Shahasram Dhuldia Katiadi Kishoreganj POPI
137 Nokla Shahasram Dhuldia Katiadi Kishoreganj POPI
138 Purara Shahasram Dhuldia Katiadi Kishoreganj POPI
139 Raykhola Shahasram Dhuldia Katiadi Kishoreganj POPI
140 Sataradran Shahasram Dhuldia Katiadi Kishoreganj POPI
141 Shahsram Dhuldia Shahasram Dhuldia Katiadi Kishoreganj POPI
142 Atpasha Dhaki Mithamain Kishoreganj POPI
143 Borokanda Dhaki Mithamain Kishoreganj POPI
144 Chorpara Dhaki Mithamain Kishoreganj POPI
145 Dhaki purbo ati Dhaki Mithamain Kishoreganj POPI
146 Gobindopur Dhaki Mithamain Kishoreganj POPI
147 Mahamudpur Dhaki Mithamain Kishoreganj POPI
148 Meherkona Dhaki Mithamain Kishoreganj POPI
149 Shantipur Dhaki Mithamain Kishoreganj POPI
150 Silimpur Dhaki Mithamain Kishoreganj POPI
151 Chomakpur Ghagra Mithamain Kishoreganj POPI
152 Dhopajora Ghagra Mithamain Kishoreganj POPI
153 Maliundi Ghagra Mithamain Kishoreganj POPI
154 Alua Gopedighi Mithamain Kishoreganj POPI
155 Bajakpur Gopedighi Mithamain Kishoreganj POPI
156 Chanpur Puraton Gopedighi Mithamain Kishoreganj POPI
157 Dhalai Gopedighi Mithamain Kishoreganj POPI
158 Gopdighi south hati Gopedighi Mithamain Kishoreganj POPI
159 Khasalpara Gopedighi Mithamain Kishoreganj POPI
160 Puran Bogadia Gopedighi Mithamain Kishoreganj POPI
161 Shaildia Gopedighi Mithamain Kishoreganj POPI
162 Shampur Gopedighi Mithamain Kishoreganj POPI
163 Hemontoganj Keorjori Mithamain Kishoreganj POPI
164 Kura-kandi Keorjori Mithamain Kishoreganj POPI
165 Uttor kewarjar Keorjori Mithamain Kishoreganj POPI
166 Beshirikuna Khatkhal Mithamain Kishoreganj POPI
167 Chor-katkhal Khatkhal Mithamain Kishoreganj POPI
168 Dhalargoan Khatkhal Mithamain Kishoreganj POPI
169 Hasimpur Khatkhal Mithamain Kishoreganj POPI
170 Kakua Khatkhal Mithamain Kishoreganj POPI
171 Katkhal Khatkhal Mithamain Kishoreganj POPI
172 Khaushor Khatkhal Mithamain Kishoreganj POPI
173 Saheb nagar Khatkhal Mithamain Kishoreganj POPI
174 Shantipur Khatkhal Mithamain Kishoreganj POPI
175 Boro Ati Mithamain Sadar Mithamain Kishoreganj POPI
176 Islampur Mithamain Sadar Mithamain Kishoreganj POPI
177 Islampur-Agla hati Mithamain Sadar Mithamain Kishoreganj POPI
178 Kalipur Mithamain Sadar Mithamain Kishoreganj POPI
179 Kamalpur Mithamain Sadar Mithamain Kishoreganj POPI
180 Khaliapara Mithamain Sadar Mithamain Kishoreganj POPI
181 Khidirpur Mithamain Sadar Mithamain Kishoreganj POPI
182 Mohorpur Beribadhn Mithamain Sadar Mithamain Kishoreganj POPI
183 Moulobipara Mithamain Sadar Mithamain Kishoreganj POPI
184 Puran Nababpur Mithamain Sadar Mithamain Kishoreganj POPI
185 Sarkar Ati Mithamain Sadar Mithamain Kishoreganj POPI
186 Poschim para Chatirchar Nikli Kishoreganj CARE B
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187 Sonaullah hati Chatirchar Nikli Kishoreganj CARE B
188 Aliya para Dampara Nikli Kishoreganj CARE B
189 Borokanda Dampara Nikli Kishoreganj CARE B
190 Kamal pur Dampara Nikli Kishoreganj CARE B
191 Purba dampara Dampara Nikli Kishoreganj CARE B
192 Saheb hati Dampara Nikli Kishoreganj CARE B
193 Uttor Dampara Dampara Nikli Kishoreganj CARE B
194 Azidpur Gurai Nikli Kishoreganj CARE B
195 Doulatpur Gurai Nikli Kishoreganj CARE B
196 Gurai Gurai Nikli Kishoreganj CARE B
197 Bodarpur Karpasha Nikli Kishoreganj CARE B
198 Nanshree Karpasha Nikli Kishoreganj CARE B
199 Shoharmul Karpasha Nikli Kishoreganj CARE B
200 Kursha Nikli Sadar Nikli Kishoreganj CARE B
201 Mohor-kona Nikli Sadar Nikli Kishoreganj CARE B
202 Panch Rukhi Nikli Sadar Nikli Kishoreganj CARE B
203 Purbo Kursha Nikli Sadar Nikli Kishoreganj CARE B
204 Sait Dhair Nikli Sadar Nikli Kishoreganj CARE B
205 Tikkol Hati Nikli Sadar Nikli Kishoreganj CARE B
206 Bagar baid Damiha Tarail Kishoreganj POPI
207 Chack para Damiha Tarail Kishoreganj POPI
208 Damiha Damiha Tarail Kishoreganj POPI
209 Dakhin Khalpar Damiha Tarail Kishoreganj POPI
210 Hasla Damiha Tarail Kishoreganj POPI
211 Hat kajla Damiha Tarail Kishoreganj POPI
212 Kachila hati Damiha Tarail Kishoreganj POPI
213 Makhna Bon Damiha Tarail Kishoreganj POPI
214 Manik bon Damiha Tarail Kishoreganj POPI
215 Nagarkul Damiha Tarail Kishoreganj POPI
216 Rahela Damiha Tarail Kishoreganj POPI
217 Sachawakanda Damiha Tarail Kishoreganj POPI
218 Singuanpar Damiha Tarail Kishoreganj POPI
219 Bhadera Digdair Tarail Kishoreganj POPI
220 Boruha Digdair Tarail Kishoreganj POPI
221 Digdair Digdair Tarail Kishoreganj POPI
222 Kalla Digdair Tarail Kishoreganj POPI
223 Kawra Digdair Tarail Kishoreganj POPI
224 Laxkhipur Digdair Tarail Kishoreganj POPI
225 Nayan shukh Digdair Tarail Kishoreganj POPI
226 Saurakanda Digdair Tarail Kishoreganj POPI
227 Singdha Digdair Tarail Kishoreganj POPI
228 Belangka Jawar Tarail Kishoreganj POPI
229 Biri jawar Jawar Tarail Kishoreganj POPI
230 Borgoan Jawar Tarail Kishoreganj POPI
231 Chon Jawar Jawar Tarail Kishoreganj POPI
232 Isaposhor Jawar Tarail Kishoreganj POPI
233 Sekendar nagar Jawar Tarail Kishoreganj POPI
234 Baksatra Borokhapon Kalmakanda Netrokona CARE B
235 Bausari Borokhapon Kalmakanda Netrokona CARE B
236 Bishara Borokhapon Kalmakanda Netrokona CARE B
237 Chouhatta Borokhapon Kalmakanda Netrokona CARE B
238 Gobindo pur Borokhapon Kalmakanda Netrokona CARE B
239 Hailati Borokhapon Kalmakanda Netrokona CARE B
240 Jatrabari Borokhapon Kalmakanda Netrokona CARE B
241 Keshobpur Borokhapon Kalmakanda Netrokona CARE B
242 Parilakul Borokhapon Kalmakanda Netrokona CARE B
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243 Chandual Kalmakanda sadar Kalmakanda Netrokona SUS
244 Chatrangpur Kalmakanda sadar Kalmakanda Netrokona SUS
245 Dobirakuna Kalmakanda sadar Kalmakanda Netrokona SUS
246 Gujakulia Kalmakanda sadar Kalmakanda Netrokona SUS
247 Isubpur Kalmakanda sadar Kalmakanda Netrokona SUS
248 Kalihala Kalmakanda sadar Kalmakanda Netrokona SUS
249 Montola Kalmakanda sadar Kalmakanda Netrokona SUS
250 Pachura Kalmakanda sadar Kalmakanda Netrokona SUS
251 Rajapur Kalmakanda sadar Kalmakanda Netrokona SUS
252 Saud para Kalmakanda sadar Kalmakanda Netrokona SUS
253 Souljan Kalmakanda sadar Kalmakanda Netrokona SUS
254 Bamongaon Kharnai Kalmakanda Netrokona SUS
255 Bausham Kharnai Kalmakanda Netrokona SUS
256 Gobindopur Kharnai Kalmakanda Netrokona SUS
257 Gouripur Kharnai Kalmakanda Netrokona SUS
258 Kachugara Kharnai Kalmakanda Netrokona SUS
259 Laxmipur Kharnai Kalmakanda Netrokona SUS
260 Sundorighat Kharnai Kalmakanda Netrokona SUS
261 Tilokpur Kharnai Kalmakanda Netrokona SUS
262 Bakurikanda Pogla Kalmakanda Netrokona SUS
263 Charulia Pogla Kalmakanda Netrokona SUS
264 Dhupapara Pogla Kalmakanda Netrokona SUS
265 Gonganagar Pogla Kalmakanda Netrokona SUS
266 Goyatala Pogla Kalmakanda Netrokona SUS
267 Kutigoan Pogla Kalmakanda Netrokona SUS
268 Panchpara Pogla Kalmakanda Netrokona SUS
269 Pogla Pogla Kalmakanda Netrokona SUS
270 Ponarparuya Pogla Kalmakanda Netrokona SUS
271 Uttar Sonoi Pogla Kalmakanda Netrokona SUS
272 Hasa Noyagoan Rangchati Kalmakanda Netrokona CARE B
273 Horinakuri Rangchati Kalmakanda Netrokona CARE B
274 Kalaikandi Rangchati Kalmakanda Netrokona CARE B
275 Moutola (Pacharmari) Rangchati Kalmakanda Netrokona CARE B
276 Nollahpara Rangchati Kalmakanda Netrokona CARE B
277 Panchgaon Rangchati Kalmakanda Netrokona CARE B
278 Rangchati Rangchati Kalmakanda Netrokona CARE B
279 Sannasipara Rangchati Kalmakanda Netrokona CARE B
280 Terotopa Rangchati Kalmakanda Netrokona CARE B
281 Faridpur Chaqua Khaliajuri Netrokona SUS
282 Fatua Chaqua Khaliajuri Netrokona SUS
283 Harakandi Chaqua Khaliajuri Netrokona SUS
284 Hatila Chaqua Khaliajuri Netrokona SUS
285 Ranichapur Chaqua Khaliajuri Netrokona SUS
286 Shaldigha Chaqua Khaliajuri Netrokona SUS
287 Amanipur Khaliajhuri Sadar Khaliajuri Netrokona SUS
288 Khaliajhuri (Nayapara VDC) Khaliajhuri Sadar Khaliajuri Netrokona SUS
289 Chanpur Khaliajhuri Sadar Khaliajuri Netrokona SUS
290 Khaliajhuri VDC Khaliajhuri Sadar Khaliajuri Netrokona SUS
291 Monirampur Khaliajhuri Sadar Khaliajuri Netrokona SUS
292 Rowaile Khaliajhuri Sadar Khaliajuri Netrokona SUS
293 Krisnopur Krishnopur Khaliajuri Netrokona SUS
294 Muradpur Krishnopur Khaliajuri Netrokona SUS
295 Muslimpur-1 Krishnopur Khaliajuri Netrokona SUS
296 Muslimpur-2 Krishnopur Khaliajuri Netrokona SUS
297 Ashadpur Mendipur Khaliajuri Netrokona SUS
298 Banuair Mendipur Khaliajuri Netrokona SUS
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299 Boalee Mendipur Khaliajuri Netrokona SUS
300 Jagannathpur -1 Mendipur Khaliajuri Netrokona SUS
301 Jagannathpur-2 Mendipur Khaliajuri Netrokona SUS
302 Jhiakara Mendipur Khaliajuri Netrokona SUS
303 Khalapara Mendipur Khaliajuri Netrokona SUS
304 Satgaon-1 Mendipur Khaliajuri Netrokona SUS
305 Satgaon-2 Mendipur Khaliajuri Netrokona SUS
306 Adompur Nagar Khaliajuri Netrokona SUS
307 Goalbari Nagar Khaliajuri Netrokona SUS
308 Tatia (Noagoan) Nagar Khaliajuri Netrokona SUS
309 Tatia Nagar Khaliajuri Netrokona SUS
310 Chatrokona Fateh pur Madan Netrokona SUS
311 Deoshahila (Dakhin) Fateh pur Madan Netrokona SUS
312 Deoshahila (Mailpara) Fateh pur Madan Netrokona SUS
313 Hasanpur (Dakhin Para) Fateh pur Madan Netrokona SUS
314 Hasanpur (Purbopara) Fateh pur Madan Netrokona SUS
315 Niz Fatehpur Fateh pur Madan Netrokona SUS
316 Paschim Fatehpur Fateh pur Madan Netrokona SUS
317 Rudrasree Fateh pur Madan Netrokona SUS
318 Kadamsree (Baro ati) Gobindosree Madan Netrokona SUS
319 Kadamsree (Sarker ati) Gobindosree Madan Netrokona SUS
320 Naodhar Gobindosree Madan Netrokona SUS
321 Demargati (Paschim para) Maghan Madan Netrokona SUS
322 Demargati (Purbo, shantipara) Maghan Madan Netrokona SUS
323 Jangal Maghan Madan Netrokona SUS
324 Katla (Adorshogram) Maghan Madan Netrokona SUS
325 Katla (Main) Maghan Madan Netrokona SUS
326 Maghan (Paschin para) Maghan Madan Netrokona SUS
327 Maghan (Purbopara) Maghan Madan Netrokona SUS
328 Nayapara Maghan Madan Netrokona SUS
329 Poderkona Maghan Madan Netrokona SUS
330 Tripon (Atkapara) Maghan Madan Netrokona SUS
331 Tripon (Borati) Maghan Madan Netrokona SUS
332 Akashsree Nayekpur Netrokona SUS
333 Basori (Dakhin para) Nayekpur Madan Netrokona SUS
334 Basori (Uttar para) Nayekpur Madan Netrokona SUS
335 Borati (Dakhin para) Nayekpur Madan Netrokona SUS
336 Borati (Uttar para) Nayekpur Madan Netrokona SUS
337 Chandratala Nayekpur Madan Netrokona SUS
338 Dakhin Makhna Nayekpur Madan Netrokona SUS
339 Gabortola Nayekpur Madan Netrokona SUS
340 Makhna (Atmakha) Nayekpur Madan Netrokona SUS
341 Mouati Nayekpur Madan Netrokona SUS
342 Nayekpur (Poschim para) Nayekpur Madan Netrokona SUS
343 Nayekpur (Purbo para) Nayekpur Madan Netrokona SUS
344 Panch  Alamsree Nayekpur Madan Netrokona SUS
345 Rajtola Nayekpur Madan Netrokona SUS
346 Bagzan Teosree Madan Netrokona SUS
347 Balali (Dakhin para) Teosree Madan Netrokona SUS
348 Balali (Uttar para) Teosree Madan Netrokona SUS
349 Bairaura Teosree Madan Netrokona SUS
350 Doribinni Teosree Madan Netrokona SUS
351 Doulotpur Teosree Madan Netrokona SUS
352 Kawalibinni Teosree Madan Netrokona SUS
353 Kuturikona Teosree Madan Netrokona SUS
354 Paharpur Teosree Madan Netrokona SUS



116

a
n

n
ex 6: extra d

etails o
n

 Fo
s lin

ked
 to in

tern
atio

n
al n

g
o

s
Farm

ers’ o
rg

an
izatio

n
s in

 B
an

g
lad

esh
: a

 M
ap

p
in

g
 an

d
 c

ap
acity a

ssessm
en

t

VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

355 Saitpur Teosree Madan Netrokona SUS
356 Shibpasa (Dakhin) Teosree Madan Netrokona SUS
357 Shibpasa (Uttar) Teosree Madan Netrokona SUS
358 Teosree Teosree Madan Netrokona SUS
359 Atbari Gaglajur Mohanganj Netrokona SUS
360 Banihari Gaglajur Mohanganj Netrokona SUS
361 Borontor Dakhin (Beli) Gaglajur Mohanganj Netrokona SUS
362 Borontor Dakhin (Shalik) Gaglajur Mohanganj Netrokona SUS
363 Borontor Uttar (Palpara-Dowel) Gaglajur Mohanganj Netrokona SUS

364 Borontor Uttar (Purbopara-
Surjomukhi) Gaglajur Mohanganj Netrokona SUS

365 Chandpur Gaglajur Mohanganj Netrokona SUS
366 Gaglajur Gaglajur Mohanganj Netrokona SUS
367 Jalalpur Gaglajur Mohanganj Netrokona SUS
368 Kamalpur Gaglajur Mohanganj Netrokona SUS
369 Kanuhari Gaglajur Mohanganj Netrokona SUS
370 Korachapur Gaglajur Mohanganj Netrokona SUS
371 Mandarbari (Shapla) Gaglajur Mohanganj Netrokona SUS
372 Mandarbari (Surjomukhi) Gaglajur Mohanganj Netrokona SUS
373 Mohabbat nagar Gaglajur Mohanganj Netrokona SUS
374 Bakhorpur Maghan Hiadhar Mohanganj Netrokona CARE B
375 Boro Betham Maghan Hiadhar Mohanganj Netrokona CARE B
376 Daspara Maghan Hiadhar Mohanganj Netrokona CARE B
377 Kandapara Maghan Hiadhar Mohanganj Netrokona CARE B
378 Khurshimul Maghan Hiadhar Mohanganj Netrokona CARE B
379 Maghan Maijhati Maghan Hiadhar Mohanganj Netrokona CARE B
380 Manarkandi Maghan Hiadhar Mohanganj Netrokona CARE B
381 Mansree palpara Maghan Hiadhar Mohanganj Netrokona CARE B
382 Perirchar Maghan Hiadhar Mohanganj Netrokona CARE B
383 Ramnagar Maghan Hiadhar Mohanganj Netrokona CARE B
384 Shewratoli Maghan Hiadhar Mohanganj Netrokona CARE B
385 Shiadhar Maghan Hiadhar Mohanganj Netrokona CARE B
386 Joypur purbo (Akata) Samaj Sahialdeo Mohanganj Netrokona SUS
387 Joypur (Jagoran) Samaj Sahialdeo Mohanganj Netrokona SUS
388 Koyrapara Samaj Sahialdeo Mohanganj Netrokona SUS
389 Nehera Samaj Sahialdeo Mohanganj Netrokona SUS
390 Patharkata Samaj Sahialdeo Mohanganj Netrokona SUS
391 Sohialdeo Samaj Sahialdeo Mohanganj Netrokona SUS
392 Bollovpur Suair Mohanganj Netrokona SUS
393 Hatniya Alipur Suair Mohanganj Netrokona SUS
394 Janodpur Suair Mohanganj Netrokona SUS
395 Kulpatak Suair Mohanganj Netrokona SUS
396 Lakkonpur Suair Mohanganj Netrokona SUS
397 Naraiz Suair Mohanganj Netrokona SUS
398 Noljuri Suair Mohanganj Netrokona SUS
399 Paboi Suair Mohanganj Netrokona SUS
400 Palgaon Suair Mohanganj Netrokona SUS
401 Ranahijal Suair Mohanganj Netrokona SUS
402 Suair Alipur Suair Mohanganj Netrokona SUS
403 Vatiya Suair Mohanganj Netrokona SUS
404 Voram Suair Mohanganj Netrokona SUS
405 Dhulia Tetulia Mohanganj Netrokona CARE B
406 Gojdhar Tetulia Mohanganj Netrokona CARE B
407 Hanbir Tetulia Mohanganj Netrokona CARE B
408 Joinpur Tetulia Mohanganj Netrokona CARE B
409 Tetulia Tetulia Mohanganj Netrokona CARE B
410 Vatapara Tetulia Mohanganj Netrokona CARE B
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411 Bodherpur Chamardani Dharmopasha Sunamganj SUS
412 Chamardani Chamardani Dharmopasha Sunamganj SUS
413 Dugnai Chamardani Dharmopasha Sunamganj SUS
414 Koyethkanda Chamardani Dharmopasha Sunamganj SUS
415 Lahur Dugnai Chamardani Dharmopasha Sunamganj SUS
416 Abuarchar Dharmopasha Sadar Dharmopasha Sunamganj CARE B
417 Atkapara Dharmopasha Sadar Dharmopasha Sunamganj CARE B
418 Deola Dharmopasha Sadar Dharmopasha Sunamganj CARE B
419 Dudhbahar Dharmopasha Sadar Dharmopasha Sunamganj CARE B
420 Fatemanagar Dharmopasha Sadar Dharmopasha Sunamganj CARE B
421 Holidakanda Dharmopasha Sadar Dharmopasha Sunamganj CARE B
422 Lamamahari Dharmopasha Sadar Dharmopasha Sunamganj CARE B
423 Lankapatharia Dharmopasha Sadar Dharmopasha Sunamganj CARE B
424 Nalgora Dharmopasha Sadar Dharmopasha Sunamganj CARE B
425 Naogaon Dharmopasha Sadar Dharmopasha Sunamganj CARE B
426 Radhanagar Dharmopasha Sadar Dharmopasha Sunamganj CARE B
427 Rajnagar Dharmopasha Sadar Dharmopasha Sunamganj CARE B
428 Bahdahoripur Joysree Dharmopasha Sunamganj CARE B
429 Borai gram Joysree Dharmopasha Sunamganj CARE B
430 Chanpur Joysree Dharmopasha Sunamganj CARE B
431 Durgapur Joysree Dharmopasha Sunamganj CARE B
432 Horipur Joysree Dharmopasha Sunamganj CARE B
433 Mahespur Joysree Dharmopasha Sunamganj CARE B
434 Bangaon Madhyanagar Dharmopasha Sunamganj SUS
435 Enayet Nagar Madhyanagar Dharmopasha Sunamganj SUS
436 Khalishakanda Madhyanagar Dharmopasha Sunamganj SUS
437 Kamaura Madhyanagar Dharmopasha Sunamganj SUS
438 Karuajan Madhyanagar Dharmopasha Sunamganj SUS
439 Madhyanagar Sunoipara-1 Madhyanagar Dharmopasha Sunamganj SUS
440 Madhyanagar Purbopara-2 Madhyanagar Dharmopasha Sunamganj SUS
441 Bakhajura Paikarati Dharmopasha Sunamganj SUS
442 Balijhuri Paikarati Dharmopasha Sunamganj SUS
443 Barayhati- Purba para Paikarati Dharmopasha Sunamganj SUS
444 Barayhati- Uttar para Paikarati Dharmopasha Sunamganj SUS
445 Berikandi Paikarati Dharmopasha Sunamganj SUS
446 Bharkhola Paikarati Dharmopasha Sunamganj SUS
447 Chakiachapar Paikarati Dharmopasha Sunamganj SUS
448 Jinglegora Paikarati Dharmopasha Sunamganj SUS
449 Kurikhania Paikarati Dharmopasha Sunamganj SUS
450 Dakhin Sunoi Paikarati Dharmopasha Sunamganj SUS
451 Uttar Sunoi Paikarati Dharmopasha Sunamganj SUS
452 Barapachur Selborash Dharmopasha Sunamganj SUS
453 Bangavi Selborash Dharmopasha Sunamganj SUS
454 Dakshin salav Selborash Dharmopasha Sunamganj SUS
455 Khalapara Selborash Dharmopasha Sunamganj SUS
456 Mahamudpur Selborash Dharmopasha Sunamganj SUS
457 Sarisham Selborash Dharmopasha Sunamganj SUS
458 Vatapara Selborash Dharmopasha Sunamganj SUS
459 Vatokpur Selborash Dharmopasha Sunamganj SUS
460 Babupur Uttar Sukhair Rajapur Dharmopasha Sunamganj SUS
461 Barir Par Uttar Sukhair Rajapur Dharmopasha Sunamganj SUS
462 Digjan Uttar Sukhair Rajapur Dharmopasha Sunamganj SUS
463 Islampur Uttar Sukhair Rajapur Dharmopasha Sunamganj SUS
464 Noorpur Uttar Sukhair Rajapur Dharmopasha Sunamganj SUS
465 Sharisakanda Uttar Sukhair Rajapur Dharmopasha Sunamganj SUS
466 Astoma-1 Joykolosh Dk. Sunamganj Sunamganj ASD
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467 Astoma-2 Joykolosh Dk. Sunamganj Sunamganj ASD
468 Boglar Khara Joykolosh Dk. Sunamganj Sunamganj ASD
469 Dungira Joykolosh Dk. Sunamganj Sunamganj ASD
470 Hasnabaz Joykolosh Dk. Sunamganj Sunamganj ASD
471 Jamlabaj-1(Charhati) Joykolosh Dk. Sunamganj Sunamganj ASD
472 Jamlabaj-2 (Gangpar) Joykolosh Dk. Sunamganj Sunamganj ASD
473 Joykolosh-1 (Hindu Para) Joykolosh Dk. Sunamganj Sunamganj ASD
474 Joykolosh-2 (Muslim Para) Joykolosh Dk. Sunamganj Sunamganj ASD
475 Durbakanda Paschim Birgaon Dk. Sunamganj Sunamganj ASD
476 Joyshiddhi Paschim Birgaon Dk. Sunamganj Sunamganj ASD
477 Shantipur Paschim Birgaon Dk. Sunamganj Sunamganj ASD
478 Amdabad Patharia Dk. Sunamganj Sunamganj ASD
479 Ashamura Patharia Dk. Sunamganj Sunamganj ASD
480 Hasarchar Patharia Dk. Sunamganj Sunamganj ASD
481 Kandi gaon Patharia Dk. Sunamganj Sunamganj ASD
482 Puran Zahanpur Patharia Dk. Sunamganj Sunamganj ASD
483 Shreenathpur Patharia Dk. Sunamganj Sunamganj ASD
484 Birgaon Hindu hati Purba Birgaon Dk. Sunamganj Sunamganj ASD
485 Dolmoinsha Purba Birgaon Dk. Sunamganj Sunamganj ASD
486 Haskuri Purba Birgaon Dk. Sunamganj Sunamganj ASD
487 Khalpar Purba Birgaon Dk. Sunamganj Sunamganj ASD
488 Checker Kandi Purbo Pagla Dk. Sunamganj Sunamganj ASD
489 Chur Khai Purbo Pagla Dk. Sunamganj Sunamganj ASD
490 Kuderai Purbo Pagla Dk. Sunamganj Sunamganj ASD
491 Noagaon Purbo Pagla Dk. Sunamganj Sunamganj ASD
492 Terahal Shimulbak Dk. Sunamganj Sunamganj ASD
493 Zibdara-1 (Paschim hati) Shimulbak Dk. Sunamganj Sunamganj ASD
494 Zibdara-2 (Purba hati) Shimulbak Dk. Sunamganj Sunamganj ASD
495 Bhatipara Bhatipara Derai Sunamganj CARE B
496 Dattagram Bhatipara Derai Sunamganj CARE B
497 Dhalkutub Bhatipara Derai Sunamganj CARE B
498 Kuchirgaon Bhatipara Derai Sunamganj CARE B
499 Nur Nagar Bhatipara Derai Sunamganj CARE B
500 Urdhanpur-Ur. Para Bhatipara Derai Sunamganj CARE B
501 Charnerchar Charnachar Derai Sunamganj ASD
502 Hasnabad Charnachar Derai Sunamganj ASD
503 Joypur Charnachar Derai Sunamganj ASD
504 Kamalpur Charnachar Derai Sunamganj ASD
505 Lularchar Charnachar Derai Sunamganj ASD
506 Madhupur Charnachar Derai Sunamganj ASD
507 Maitwi Charnachar Derai Sunamganj ASD
508 Noarchar Charnachar Derai Sunamganj ASD
509 Nowagaon Charnachar Derai Sunamganj ASD
510 Parua Charnachar Derai Sunamganj ASD
511 Shamarchar Charnachar Derai Sunamganj ASD
512 Shantipur Charnachar Derai Sunamganj ASD
513 Goroma Jagdal Derai Sunamganj ASD
514 Kaldhar Jagdal Derai Sunamganj ASD
515 Kaliarkaphon Jagdal Derai Sunamganj ASD
516 Vatiargaon Jagdal Derai Sunamganj ASD
517 Chandpur Karimpur Derai Sunamganj ASD
518 Kajua Karimpur Derai Sunamganj ASD
519 Mukshedpur Karimpur Derai Sunamganj ASD
520 Nasirpur Karimpur Derai Sunamganj ASD
521 Puratan Kornagaon Karimpur Derai Sunamganj ASD
522 Shree Narayanpur Karimpur Derai Sunamganj ASD
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VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

523 Balanpur Rafinagar Derai Sunamganj ASD
524 Khagaura Rafinagar Derai Sunamganj ASD
525 Machimpur Rafinagar Derai Sunamganj ASD
526 Megna Rafinagar Derai Sunamganj ASD
527 Mirjapur Rafinagar Derai Sunamganj ASD
528 Rafinagar Rafinagar Derai Sunamganj ASD
529 Chitalia Saramangal Derai Sunamganj CARE B
530 Jarulia Saramangal Derai Sunamganj CARE B
531 Kallani Saramangal Derai Sunamganj CARE B
532 Noyagaon Saramangal Derai Sunamganj CARE B
533 Rangamatia Saramangal Derai Sunamganj CARE B
534 Saramangal Saramangal Derai Sunamganj CARE B
535 Amirpur Tarol Derai Sunamganj CARE B
536 Islampur Tarol Derai Sunamganj CARE B
537 Jalalnagor Tarol Derai Sunamganj CARE B
538 Noagaon Tarol Derai Sunamganj CARE B
539 Saralitopa Tarol Derai Sunamganj CARE B
540 Tolbaushi Tarol Derai Sunamganj CARE B
541 Vangadohor Tarol Derai Sunamganj CARE B
542 Bagra Dowarabazar Sadar Dowarabazar Sunamganj CARE B
543 Pachim Machimpur Dowarabazar Sadar Dowarabazar Sunamganj CARE B
544 Pachim Noyangaon Dowarabazar Sadar Dowarabazar Sunamganj CARE B
545 Purbo Noyangaon Dowarabazar Sadar Dowarabazar Sunamganj CARE B
546 Roynagar Dowarabazar Sadar Dowarabazar Sunamganj CARE B
547 Tablai Dowarabazar Sadar Dowarabazar Sunamganj CARE B
548 Baday Goraspur Dohalia Dowarabazar Sunamganj ASD
549 Choumona Dohalia Dowarabazar Sunamganj ASD
550 Goraspur Dohalia Dowarabazar Sunamganj ASD
551 Kanchonpur Dohalia Dowarabazar Sunamganj ASD
552 Kittarajonpur Dohalia Dowarabazar Sunamganj ASD
553 Noyagaon Dohalia Dowarabazar Sunamganj ASD
554 Panil (puran) Dohalia Dowarabazar Sunamganj ASD
555 Protabpur Dohalia Dowarabazar Sunamganj ASD
556 Ragurampur Dohalia Dowarabazar Sunamganj ASD
557 Shibpur Dohalia Dowarabazar Sunamganj ASD
558 Aruakhai Lakshmipur Dowarabazar Sunamganj ASD
559 Boktarpur Lakshmipur Dowarabazar Sunamganj ASD
560 Fateapur Lakshmipur Dowarabazar Sunamganj ASD
561 Islampur Lakshmipur Dowarabazar Sunamganj ASD
562 Noyapara Lakshmipur Dowarabazar Sunamganj ASD
563 Noyagaon Lakshmipur Dowarabazar Sunamganj ASD
564 Roshorai Lakshmipur Dowarabazar Sunamganj ASD
565 Sultanpur Lakshmipur Dowarabazar Sunamganj ASD
566 Ziragaon Lakshmipur Dowarabazar Sunamganj ASD
567 Ajompur Mannergaon Dowarabazar Sunamganj ASD
568 Dulposhi Mannergaon Dowarabazar Sunamganj ASD
569 Edonpur Mannergaon Dowarabazar Sunamganj ASD
570 Hajarigaon Mannergaon Dowarabazar Sunamganj CARE B
571 Jalalpur Mannergaon Dowarabazar Sunamganj CARE B
572 Jogirgaon Mannergaon Dowarabazar Sunamganj CARE B
573 Gopinagar Pandergaon Dowarabazar Sunamganj CARE B
574 Islamnagar Pandergaon Dowarabazar Sunamganj CARE B
575 New Krisnonagar Pandergaon Dowarabazar Sunamganj CARE B
576 Nutannagar Pandergaon Dowarabazar Sunamganj CARE B
577 Pandergaon Pandergaon Dowarabazar Sunamganj CARE B
578 Polerchor Pandergaon Dowarabazar Sunamganj CARE B
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VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

579 Radanagar Pandergaon Dowarabazar Sunamganj CARE B
580 Ratinagar Pandergaon Dowarabazar Sunamganj CARE B
581 Shahebargoan Pandergaon Dowarabazar Sunamganj CARE B
582 Ali Pur Luxmipur (Surma) Dowarabazar Sunamganj ASD
583 Nurpur Luxmipur (Surma) Dowarabazar Sunamganj ASD
584 Sonapur Luxmipur (Surma) Dowarabazar Sunamganj ASD
585 Alipur Behali Jamalganj Sunamganj CARE B
586 Islampur Behali Jamalganj Sunamganj CARE B
587 Radhanagar Behali Jamalganj Sunamganj CARE B
588 Kamdhorpur Fenarbag Jamalganj Sunamganj CARE B
589 Shorifpur Fenarbag Jamalganj Sunamganj CARE B
590 Gojaria hati Jamalganj Sadar Jamalganj Sunamganj CARE B
591 Kalipur Jamalganj Sadar Jamalganj Sunamganj CARE B
592 Laxmipur Jamalganj Sadar Jamalganj Sunamganj CARE B
593 Saratpur Jamalganj Sadar Jamalganj Sunamganj CARE B
594 Talia Lamapara Jamalganj Sadar Jamalganj Sunamganj CARE B
595 Umedpur Jamalganj Sadar Jamalganj Sunamganj CARE B
596 Horipur Shasna Bazar Jamalganj Sunamganj CARE B
597 Polok Shasna Bazar Jamalganj Sunamganj CARE B
598 Radhanagar Shasna Bazar Jamalganj Sunamganj CARE B
599 Ramnagar Shasna Bazar Jamalganj Sunamganj CARE B
600 Rangamati Shasna Bazar Jamalganj Sunamganj CARE B
601 Shukdeb Pur Shasna Bazar Jamalganj Sunamganj CARE B
602 Adarshagram Badaghat Tahirpur Sunamganj ASD
603 Dighirpar Badaghat Tahirpur Sunamganj ASD
604 Ghagra Badaghat Tahirpur Sunamganj ASD
605 Kaikorpara Badaghat Tahirpur Sunamganj ASD
606 Kalipur Badaghat Tahirpur Sunamganj ASD
607 Laurerghar Badaghat Tahirpur Sunamganj ASD
608 Muksedpur Daskin Badaghat Tahirpur Sunamganj ASD
609 Sonapur Badaghat Tahirpur Sunamganj ASD
610 Sondar Pahari Badaghat Tahirpur Sunamganj ASD
611 Anwarpur Balijuri Tahirpur Sunamganj ASD
612 Borhokhola Balijuri Tahirpur Sunamganj ASD
613 Mahtabpur Balijuri Tahirpur Sunamganj ASD
614 Menjergaon Balijuri Tahirpur Sunamganj ASD
615 Puran Barunka Balijuri Tahirpur Sunamganj ASD
616 Puran Gaon Balijuri Tahirpur Sunamganj ASD
617 Barodol Natun hati Daskin Barodol Tahirpur Sunamganj ASD
618 Barodol Puran hati Daskin Barodol Tahirpur Sunamganj ASD
619 Holholia Daskin Barodol Tahirpur Sunamganj ASD
620 Kukur Kandi Daskin Barodol Tahirpur Sunamganj ASD
621 Nalerband Daskin Barodol Tahirpur Sunamganj ASD
622 Takatukia Daskin Barodol Tahirpur Sunamganj ASD
623 Anandanagar Dakhin Shreepur Tahirpur Sunamganj ASD
624 Patabuka Dakhin Shreepur Tahirpur Sunamganj ASD
625 Sreepur Paschim Dakhin Shreepur Tahirpur Sunamganj ASD
626 Umedpur Dakhin Shreepur Tahirpur Sunamganj ASD
627 Gobanda sree Tahirpur Sadar Tahirpur Sunamganj ASD
628 Surjer Gaon Tahirpur Sadar Tahirpur Sunamganj ASD
629 Vati Tahirpur Paschim hati Tahirpur Sadar Tahirpur Sunamganj ASD
630 Vati Tahirpur Purbo hati Tahirpur Sadar Tahirpur Sunamganj ASD
631 Baruhal Uttar Barodol Tahirpur Sunamganj ASD
632 Chandpur Uttar Barodol Tahirpur Sunamganj ASD
633 Fakirnagar Uttar Barodol Tahirpur Sunamganj ASD
634 Gotila Noagao Uttar Barodol Tahirpur Sunamganj ASD
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VDC*>
code Name>of>the>VDC Union Upazila District Implementing>

organization

635 Holholia Char gaon Uttar Barodol Tahirpur Sunamganj ASD
636 Rajain Uttar Barodol Tahirpur Sunamganj ASD
637 Rajaniline Uttar Barodol Tahirpur Sunamganj ASD
638 Shantipur Uttar Barodol Tahirpur Sunamganj ASD
639 Shemoltola Uttar Barodol Tahirpur Sunamganj ASD
640 Baliaghata Uttar Shreepur Tahirpur Sunamganj ASD
641 Bania Gaon Uttar Shreepur Tahirpur Sunamganj ASD
642 Duder Awta Uttar Shreepur Tahirpur Sunamganj ASD
643 Jamalpur Uttar Shreepur Tahirpur Sunamganj ASD
644 Noaband Uttar Shreepur Tahirpur Sunamganj ASD
645 Teligaon Uttar Shreepur Tahirpur Sunamganj ASD

Helvetas Swiss Intercooperation

helVetas swiss intercooperation (hsi), a swiss-based development organization, has been working in 
Bangladesh since 2000 in the areas of local governance, livelihoods, agricultural value chains, market 
development and natural resource management.

National Nursery Society

Context of forming the National Nursury School (NNS)

in 2001, hsi initiated the human and infrastructure development Project for the nursery sector, which led 
to the formation of unMs and district nursery Malik samitys (dnMss). as a continuation of the process, on 
29 June 2010, a convention was held in dhaka with approximately 900 delegates from all over the country 
representing unMs and dnMs. the convention formally established the nns.

Figure>A6.3>  Development Process of Nursery Malik Samitys
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Geographical distribution of nurseries, UNMS and DNMS

there are around 9  000 nurseries associated with the nns through 356 upazila nursery Malik samitys and 
62 dnMss. according to the concentration of nurseries, rangpur division has the highest coverage, followed 
by rajshahi and dhaka. of the 63 districts, the concentration of nurseries was highest in Bogra (800), 
gaibandha (429), Kurigram (386) and dinajpur (375).

Table>A6.4   Division-wise number of nurseries and distribution of UNMS and DNMS

Division District>covered Upazila>covered No.>of>Nursery UNMS DNMS

Dhaka 17 111 1,511 111 17

Rajshahi 6 41 1,551 41 6

Chittagong 11 59 818 59 11

Khulna 9 40 1,190 40 9

Sylhet 4 27 557 27 4

Barisal* 6 30 468 30 6

Rangpur* 10 74 3,337 74 10

Total 63 382 9,432 382 63

Functional 63 382 9,000 356 62

Source: NNS, 2012 and www.nnsbd.com; www.krishibangla.com.
* These divisions overlap with the IAPP.

SPAs under Samriddhi

Project summary

hsi, through the ‘samriddhi’ project, covers 211 unions 
and 58 upazilas of 7 districts (rangpur, gaibandha, Bogra, 
Joypurhat, naogaon, rajshahi, sunamgonj). Market 
development under the samriddhi project focuses on 
12 pro-poor value chains in the fields of medicinal plants, 
fish, vegetables, fruit, milk, chicken, duck, bull fattening, 
goat, cotton, jute and plant crafts.

Example Service Provider Association

in 2004, in Badarganj upazila in rangpur, 40 local service 
providers (lsPs) formed a service Provider association 
(sPa). these lsPs have skills in different areas, including 
vegetable production, livestock and poultry, agricultural 
machinery, product marketing and packaging. the 
executive committee has seven members, and is formed 
with specific structural rules and regulations. hsi provides 
technical backstopping in the areas of marketing and 
organizational empowerment to members of the sPa.

one the main challenges of the sPa members was to collect fees for their services, as farmers were not 
accustomed to paying for services. “this was crucial for us as it supports the livelihoods of individual lsPs”, 
said Mr. asad, secretary of Badarganj upazila sPa. however, as farmers began to see benefits from the services 
of the lsPs, the situation has changed. Mr. asad shared that now each lsP has a monthly income of around 
Bdt 8 000 from their work providing services through the sPa.

KEy>FEATURES

Project:>Samriddhi
Funded>by:>Swiss>Agency>for>Development>and>
Cooperation>(SDC)
Duration:>2010-2013
Name>of>FO:>>Service>Providers>Association>(SPA)
Name>of>Federation:>To>be>developed
Total>FO:>58
Geo.>coverage:>7>Districts>of>Rajshahi>and>
Rangpur>Divisions>and>Sunamganj>District>of>
Sylhet>Division.
Innovation:>Promotion>of>market>and>value>
chain>development>for>sustainable>and>
inclusive>market>systems>based>on>principles>
such>as>facilitation,>knowledge>management,>
innovation,>and>competitiveness.
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Figure>A6.4   Market Development Model of Samriddhi
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Table>A6.5   List of Service Providers Association under Helvetas Swiss Intercooperation

Sl>no. Upazila District

1 Atwari Panchagor

2 Thakurgaon Sadar Thakurgoan

3 Dimla Nilphamari

4 Jaldhaka Nilphamari

5 Domar Nilphamari

6 Nilphamari Sadar Nilphamari

7 Saidpur Nilphamari

8 Parbotipur Dinajpur

9 Khansama Dinajpur

10 Fulbari Dinajpur

11 Ghoraghat Dinajpur

12 Rajarhat Kurigram

11 Kurigram Sadar Kurigram

14 Lalmonirhat Sadar Lalmonirhat

15 Aditmari Lalmonirhat

16 Badargonj Rangpur

17 Taraganj Rangpur

18 Pirgacha Rangpur

19 Mithapukur Rangpur

20 Pirgonj Rangpur

21 Sadullapur Gaibandha

22 Palashbari Gaibandha

23 Gobindagonj Gaibandha

24 Gaib. sadar Gaibandha

25 Bogra sadar Bogra

26 Sundarganj Bogra

27 Pachbibi Joypurhat

28 Joypur sadar Joypurhat

29 Badalgachi Naogoan

30 Naogoan sadar Noagoan

31 Sirajgonj sadar Sirajgonj

32 Raigonj Sirajgonj

33 Kamarkhand Sirajgonj

34 Chapainawabgonj Sadar Chapai N.

35 Shibgonj Chapai N.

36 Nachole Chapai N.

37 Godagari Rajshahi

38 Mohonpur Rajshahi

39 Durgapur Rajshahi

40 Bagmara Rajshahi

41 Paba Sadar Rajshahi
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42 Puthia Rajshahi

43 Bagha Rajshahi

44 Charghat Rajshahi

45 Natore Sadar Natore

46 Boraigram Natore

47 Chatmohar Pabna

48 Sadar Pabna

49 Atghoria Pabna

50 Iswardi Pabna

51 Sulla Sunamgonj

52 Jamalganj Sunamgonj

53 Derai Sunamgonj

54 South Sunamganj Sunamgonj

55 Dharmapasha Sunamgonj

56 Tahirpur Sunamgonj

57 Bishwamvarpur Sunamgonj

58 Doarabazar Sunamgonj

International Development Enterprises

ide has been operating in Bangladesh since 1984. ide works with different government and donor agencies in 
high-value agriculture, looking at opportunities and constraints for the entire market chain, from manufacturers 
and researchers, to input suppliers, to farmers, to market outlets. ide identifies appropriate, low-cost ways of 
transforming small producers’ incomes. at the time of the mapping, ide had nine ongoing projects (table a6.6). 
although it provides backstopping support for market development to more than 6 000 farmers’ groups, ide 
itself has directly formed and mobilized 42 cPMcs and 13 farmers’ associations, totalling 55 farmers associations 
in different regions.
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Save the Children

Project summary

save the children is implementing the nabo Jiban (new 
life) Project under the Multi-Year assistance Program 
(MYaP-ii), funded by the united states agency for 
international aid (usaid). 

the broad objective of the project is to reduce food 
insecurity and vulnerability for up to 191 000 households 
in nine cyclone sidr-affected upazilas of Barisal division. 
the project partners with different international and 
national ngos: helen Keller international for technical 
backstopping in nutrition issues; ide for technical 
backstopping in marketing issues; the World Fish center 
for the aquaculture sub-sector; the regional integrated Multi-hazard early Warning system for micro climate 
forecasting and local ngos (codec, south asia Partnership and sPeed trust) for community mobilization.

Geographical distribution

detailed information on the geographical dispersion of these groups was not available through the project 
at the central and divisional level. however, we do know that the project covers: Barisal sadar, hizla and 
Mehendiganj in the district of Barisal; dashmina, galachipa and Kalapara in the district of Patuakhali; and 
amtali, Patharghata and Bargunasadar in the district of Barguna. the concerned officer shared that the project 
maintains a database of farmers’ names but not of the organizations themselves. 

World Vision Bangladesh

since the late nineties, World Vision Bangladesh’s development approach has been the “area development 
Program.” these are long-term (10-15 year) programmes to address community needs and ensure self-reliance. 
currently, World Vision Bangladesh operates 72 programs in 70 upazilas and 27 districts. they serve around 
3-4  million direct and indirect beneficiaries using a needs-based approach that empowers communities to 
identify problems and develop and implement solutions themselves.

KEy>FEATURES

Project:>Nabo>Jiban
Funded>by:>USAID
Duration:>2010-2015
Name>of>FO:>>HPP>Groups,>PP>Groups,>EP>Groups,>
VSLA
Total>FO:>3,860
Geo.>coverage:>Barisal,>Patuakhali,>Barguna.
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BRAC

at present, Brac has two projects working exclusively with farmers through a group approach: the scdP 
and the tenant Farmers development Project (Borga chashi unnayan Prokalpa – BcuP). the BcuP is being 
implemented with Bangladesh Bank, and is funded by the government. Brac’s contribution under the scdP 
has already been described above.

The Tenant Farmers Development Project (BCUP)

the BcuP was designed to address bottlenecks faced by tenant farmers in accessing rural credit. the BcuP is a 
unique agricultural credit programme in which sharecroppers and marginal farmers in remote, rural areas are 
being mobilized into Vos. the project started in 2009 and is expected to close in 2016, depending on funding 
from Bangladesh Bank. the project is now working in 210 upazilas of 46 districts. detailed geographical 
distribution information was not available at headquarters level. 

Christian Commission for Development in Bangladesh

Table>A7.1   Project area information

Name>of>
division Name>of>district Name>of>upazila No.>of>

forum
Name>of>
area>office

Type>of>forum
Male Female Total

Phase-Out Status Quo Phase-In
Rangpur  Dinajpur Nawabgonj 82 Daudpur

 

78

 

52 100 15,926 15,923 31,849

 
Phulbari 33

Rangpur Pirgonj 39
Mithapukur 45

Thakurgoan Pirgonj 31
Total   230

Rajshahi

 

Naogoan

 

Niamotpur 37 Manda 39

 

10

 

37

 

859

 

4,341

 

5,200

 
Manda 30
Mohanpur 19

Total   86
Rajshahi Sadar Godagari 17 Chapai  38  26  35 631  7,600  8,231

Tanore 32
Chapainawabgonj Nachol 18

Chapai Sadar 32
Total   99

Annex 7
Extra details on farmers’ organizations formed 
with support from national non-governmental 
organizations
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Name>of>
division Name>of>district Name>of>upazila No.>of>

forum
Name>of>
area>office

Type>of>forum
Male Female Total

Phase-Out Status Quo Phase-In

 

Natore

  

Lalpur 28 Ishurdi   17  18  25  160  5,788  5,948
Atghoria 17
Ishurdi 15

Total   60
Pabna Bhangura 27  Pabna  41  36  25  165  5,571  5,736

Pabna Sadar 23
Santhia 19
Sujanagar 33

Total   102
Khulna  Jessore  Monirampur 38  Monirampur  0  0   38   0   2,238   2,238 

Total   38  
Dhaka

 

Manikgonj  Shivalaya 21 Daschira

 

33 7 28 194 6,059  6,253
Harirampur 19
Singair 28

Total   68
Madaripur Kalkini 24 Gournadi  0 0 24 0 2,056 2,056
Total   24
Gopalgonj Tungipara 25  Gopalgonj   18  18  25  103  5,207  5,310

Gopalgonjsadar 14
Kowtalipara 14
Muksudpur 8

Total   61
Mymensingh Phulbaria 36 Phulbaria 0 0 36 71 2,273 2,344
Total   36

Barisal Barisal Gournadi 10 Gournadi

 

12 16  0  90  5,891 5,981
Agailjhara 12
Wazirpur 6

Total   28
Chittagong

 

Bandarban

 

Bandarban Sadar 36 Bandarban  18 30 40 1,108 1,208 2,316
Rowangchori 16
Ruma 16
Thanchi 20

Total   88

Total     920   294 213 413 19,307 64,155 83,462

Rangpur Dinajpur Rural Services

there have been two projects that backstopped these union Federations, namely: capacity development of 
Federations (funded by the european commission) and empowering the Poor through Federations (funded by 
dan church aid).  

Figure>A7.1   Processes of federating FOs in RDRS

Coops

Village Groups
(12104)

• Mobilized small 
groups

• Group savings

• Coalition of 
small groups

• Raise voice of unity

Union Federations
(361)

Upazila Coordination
Committee (51)

• Coordination of 
union federation

• Raise voice at 
sub-district level

• Coordination of all 
federations within 
district

• Auditing

District Coordination 
Committee (9)

Divisional 
Coordination

Committee (1)

• Apex committee 
of all federations

• Auditing
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Table>A7.2   Upazila-wise distribution of Union Federations under RDRS

Sl>no. Name>of>district Name>of>upazila No.>of>federations

1 Panchagarh

Atwari 6
Boda 10
Debigonj 10
PanchagarhSador 10
Tetulia 7

    Total 43

2 Thakurgaon

ThakurgaonSador 19
Pirgonj 10
Haripur 6
Baliadangi 8
Ranisankail 8

    Total 51

3 Dinajpur

DinajpurSadar 4
Birgonj 6
Kaharol 4
Birol 10
Fulbhari 2
Birampur 3
Hakimpur 3
Goraghat 4
Bochagonj 6

    Total 42

4 Nilphamari*

Domar 10
Dimla 10
Jaldhaka 12
Kishoregonj 9
NilphamariSador 10
Sayedpur 4

    Total 55

5 Rangpur*

RangpurSador 7
Taragonj 4
Pirgonj 5
Mitapokur 5
Kounia 6

    Total 27

6 Lalmonirhat*

Aditmari 8
Hatibandha 12
Kaligonj 8
LalminirhatSador 9
Patgram 6

    Total 43

7 Kurigram*

KurigramSador 10
Rajarhat 7
Ulipur 16
Chilmari 6
Rajibpur 3
Rowmari 5
Nageshwari 16
Fulbhari 6
Bhurungamari 10

    Total 79
8 Jamalpur Dewangonj 2
    Total 2
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Sl>no. Name>of>district Name>of>upazila No.>of>federations

9 Gaibandha

GaibandhaSador 2
Sadullapur 4
Gobindagonj 5
Palashbari 4
Sundorgonj 2
Sagata 2

    Total 19

  Grand>total>in>9>districts> 361

Total>members 285,978>>(male>86,733;>female>199,245)

* These districts overlap with the IAPP.

Microfinance NGOs

ASA

asa has a renowned “cost–effective and sustainable Microfinance Model.” in 2007, asa topped Forbes 
Magazine’s first-ever list of 50 top microfinance institutions, which took into consideration institutions’ scale, 
efficiency, risks and returns.
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Annex 8
A brief history of the cooperative movement  
in Bangladesh21 

21 The main source of this information is the Dhaka Mirror, specifically two articles: “Cooperatives, a Moribund Movement,” 5 July  2011; and “Ailing Cooperative Sector Needs to be 
Revamped,” 7 July 2011.

a cooperative movement is a series of organized activities with a common goal. the term usually refers more 
specifically to the formation of non-profit economic enterprises for the benefit of those using their services. 
Begun in england in the nineteenth century, the cooperative movement stirred Bengal in the last decade of 
the century. under the initiative of the government of Bengal, it was formally launched with the enactment of 
the cooperative credit societies act in 1904. according to the act, cooperative societies were to be established 
in every district and were required to be managed democratically by their members. 

in 1912, a new cooperative act was enacted to coordinate the financing of cooperative activities. under the 
act, the provincial cooperative Federation was established in 1918 (in calcutta) and was then renamed the 
Principal cooperative Bank. By the 1920s, the cooperative movement gained momentum and the number 
of cooperatives increased from 222 in 1906-07 to 19  742, including 113 central co-operative banks. in 1939 
the Money-lenders act defined a cooperative as a money-lending agency and put them under a number of 
restrictions. By 1945, the cooperative movement was in a dire situation. 

to revive the cooperative movement, a central cooperative bank was established in 1948 but it was unfortunately 
not effective and the movement remained dormant.

a new hope in the cooperative movement arose during the 1960s with the establishment of the Bangladesh 
academy for rural development (Bard). it had 11 national, 249 secondary and 33 306 primary societies with 
2.49 million members.

the successes and failure of the cooperative movement during the Pakistan period have been investigated 
by the ilo’s asian co-operative Field Mission (1955), credit enquiry commission (1959), Food and agriculture 
commission (1960) and academically, by elliot tepper of Michigan state university (1966). according to 
their observation, the cooperative movement failed to achieve its desired goals of poverty alleviation and 
credit circulation. this failure was the result of management problems at both the central and local levels of 
government. in addition to endemic inefficiencies and corruption, the laws and cooperative department had 
always prioritized control rather than dissemination and motivation.

after the liberation war and birth of Bangladesh, two systems of cooperatives were seen in practice. one 
was traditional cooperatives under the cooperative department and the other was a new two-tier system 
of cooperatives under the integrated rural development Programme (irdP), later institutionalized as the 
Bangladesh rural development Board (BrdB). By 1988, cooperative societies increased from 33 566 (1971) to 
124 604. BrdB registered 65 002 Krishok samabay samitys (Ksss) by the year 1995 under its umbrella. they also 
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registered 34 395 cooperatives of landless people in the same year, of which 21 554 were landless women. the 
Bangladesh samabay Bank ltd. (BsBl) was functioning as the central credit institution. in 1995, the value of all 
assets of the cooperative in Bangladesh was Bdt 7.96 billion. up to July 2010, the capital of the cooperatives 
stood Bdt 50 billion. at least 9 million people including 1.5 million women are members of both active and 
inactive cooperatives.

despite all of this activity during the late 1980s and 1990s, today, only about 18  000 out of approximately 
170  000 registered cooperatives are active. at present, the cooperative societies act (passed in 2001, and 
amended in 2002) regulates the activities of cooperatives. under the existing law, the government controls the 
activities of cooperatives.

experts have opined that cooperative enterprises mobilized by people themselves, rather than external bodies, 
have the potential to muster savings, finance commercial activities, support employment, as well as stabilize 
prices and the supply chain of essential commodities. despite this, the cooperative movement in Bangladesh 
has remained stymied for a long time. owing to the absence of a democratic spirit, greed, corruption, and 
politicization, the cooperative movement in Bangladesh remains a “body without a soul.”
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this annex provides further details on how the capacity needs assessment was conducted. 

in order to produce the causal diagram shown hereafter, the respondents were first asked to identify the 
primary problems faced by their organizations. then, through follow-up discussions, intermediate and root 
causes of each problem were identified. 

Following this, respondents were asked to score the severity of each of the primary problems on a scale from 
1 to 10 – 10 being the most severe. the score for each of the primary problems was then divided among the 
intermediate causes contributing to it, according to the severity. Finally, root causes were scored by adding the 
individual scores of all related intermediate causes, and then ranked in severity accordingly.

the diagram on the following page provides a visual representation of these findings, while the matrix on the 
following page provides further details on each of the root causes found during the exercise.

Annex 9
Causal diagram and capacity needs assessment
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Table>A9.1   Capacity needs assessment matrix

Score Constraints>faced>by>FOs Capacity>needs/business>
services

Existing>service>
providers

Constraints>related>to>
service>provision Intervention>needed>

36 Lack of skill (organizational):
 – organization management 

skill
 – financial skill
 – business service skill
 – project management skill
 – networking and advocacy 

skill

Capacity needs related to:
 – organizational 

management training 
for selected Exec. Com. 
members those in turn will 
act as Master Trainer

 – financial management 
training for selected Exec. 
Com. members

 – advance skill training on 
area specific potential 
business services, 
negotiation, networking, 
lobbying and advocacy

National Coop Academy  

SCITI, private consulting 
firms, PripTrust

Private consulting firm

 

 – Not farming system 
focused, traditional

 – Not tailor made

 – Firm depends on 
individual freelancer, 
not institutionalize 

 – Lead farmers’ exposure 
visit to selected Village 
Institution of SDF, CBO of 
RFLDC, Federations of RDRS 
and KKM

 – Training on financial 
education for selected Exec. 
Com. members

 – Advance skill training on 
identification of appropriate 
business services for 
members, skill on market 
linkage

 – A comprehensive module 
from FO formation to 
marketing of produce

19 Lack of information about 
market at FO:

 – FO not capable to gather 
market info

 – lack of skill on value 
addition/value chain

 – weak linkages with input 
companies and large traders

Capacity needs related to:
 – establishing one stop 

information center at FO on 
market, technology, etc.

IDE, agribusiness 
consultants (individual)

Lack of linkage with 
private input sector

Value chain linkage promotion 
with private sector:

 – MoU with private sector for 
quality inputs

 – negotiate with private 
sector for information flow 
in a win-win deal

18 Price distortion at primary 
market: 

 – distorted price offered by 
syndicate  during peak 
harvesting season

 – farmers have to sell 
produces immediately after 
harvest to repay credit

 – farmers are not interested in 
group/bulk marketing

 – lack of skill of lead farmers 
(Exec. Com.) to translate 
economy of scale

Capacity needs related to:
 – generating alternative 

income just before and 
during peak harvesting 
season

 – formation of bulk buying 
and selling group within FO

RDRS (grain bank) Inadequate skill and 
resource mobilization 
to generate alternative 
income during lean and 
peak season

 – Exposure visit to Federations 
of RDRS that have Grain 
Banks

 – Generate savings among 
group members

 – Alternative Income 
Generating Activities 
(AIGAs)

12 Lack of skill (technical):
 – lack of skill on appropriate 

modern technology for 
value adding in crop, 
livestock, poultry, fisheries 
and agro-forestry sub-
sectors

 – technology mostly owned 
by absentee farmers (rich)

Capacity needs related to:
 – technology that reduces 

cost
 – women friendly technology 

(less drudgery)
 – establish Common Facility 

Center at FO

BRRI, BARI, BAU, RDA, 
IDE

Technology not 
translated into 
businesses

A comprehensive technology 
module with update flexibility 
by which FO can render service 
to members as a common 
facility center 

10 Rural elite capture often 
disrupts FOs in delivering 
community support

Capacity needs related to:
 – facilitation skills of 

extension agent in forming 
FOs using best practice 
participatory processes

Virtually none Few agencies have best 
tools but not publicly 
disclosed 

Improvement of curriculum 
of ATIs with more focus on 
institutional development 

8 Problem with access to credit Capacity needs related to:
 – writing bankable business 

proposal writing
 – develop linkages with MFIs 

and SME bank for Exec. 
Com.

SME bank, MFIs Shortage of skill 
facilitators within 
MFIs and SME bank 
to provide financial 
education to FOs 
despite perceiving huge 
potentials to enhance 
outreach

7 Lack of agribusiness attitude 
for group business

6 Lack of purchase power of 
farmers 
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Table>A10.1   List of FOs met during mapping exercise

Sl>no. Name>of>FOs> Contact>person>and>address Type>of>FO

1 Lahirir Hat ICM Farmers Club
Mr. Abdul Khalek & Mr. Boloram Mohondo 
Sadar, Rangpur 
Cell: 01729804621

Primary FO/ assisted by AEC

2 Kendriyo Krishak Moitree (KKM)
Mr. Alauddin Sikder, Secretary 
Osmanpur, Ghoraghat, Dinajpur 
Cell: 01718628302

Federated/ assisted by Action Aid

3 Kendriyo Krishak Moitree (KKM)

Ms. Rina Akhter 
Member  
Osmanpur, Ghoraghat, Dinajpur 
Cell: 01924-665181

Primary FO/ assisted by Action Aid

4 Bhogdanga Krishak Moitree

Mr. Md. Saidur Zaman 
President 
Vill & PO: Bhogdanga 
Upazila: Sadar, Dist: Kurigram 
Cell: 01760620246

Primary FO/ assisted by KKM and Action Aid

5
Livelihood Field School (Purba Balatary)

Mr. Md. Hafizur Rahman  
President 
Vill: Purba Balatary  
PO & Thana: Nageshwari  
Dist: Kurigram  
Cell: 01728-859853

Primary FO/ assisted by IAPP

6 Village Savings and Loan Group 

Ms. China  
Vill: Islampur  
PO: Bhurungamari  
Upazila: Bhurungamari  
Dist: Kurigram  
Cell: 01737-321957

Primary FO/ assisted by CLP

7 Livelihood Field School (Jamuna Kamarpara)

Mr. Md. Ashraful   
Secretary  
Vill: Jamuna (Paikpara)  
Panchpir,Uz: Ulipur  
Dist: Kurigram  
Cell: 01728-462425

Primary FO/ assisted by IAPP

8 Livelihood Field School (Chakirposhar)

Mr. Rafiqul Islam  
President  
Vill: Khuliatari  
PO: Rajarhat  
Dist: Kurigram  
Cell: 01773-311835

Primary FO/ assisted by IAPP

9 Chakirposhar Union Federation

Mr. Azizul Islam  
President  
Vill: Kanua  
Union: Chakirposhar  
UZ: Rajarhat  
Dist: Kurigram  
Cell: 01718-619756

Federated/ assisted by RDRS

Annex 10
List of farmers’ organizations met during 
mapping exercise
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Sl>no. Name>of>FOs> Contact>person>and>address Type>of>FO

10 CLP Group 

Ms. Bonecha Khatun  
President  
Vill: Islampur  
Union:Char Bhurungamari  
PO: Bhurungamari  
Dist: Kurigram  
Cell: 

Primary FO/ assisted by CLP

11 ICM Club

Mr. Md. Nurul Alam  
President  
Patuakhali Sadar  
Cell: 01716-715349

Primary FO/ assisted by AEC

12 Micro Credit Group of BRAC

Mr. Aminul Islam  
President  
Patuakhali  
Cell: 01718718023

Mixed group/ assisted by BRAC

13 Nabo Jibon Group

Md. Lal Mia Mridha  
President  
Patuakhali  
Cell: 01913-361230

Mixed group/ assisted by Save the Children

14 Adampur Chashi Unnayan IPM Club and Association

Syed Zahid Hasan Titu  
President  
Vill: Adampur  
Union: Bahrampur  
Uz: Dashmina  
Dist: Patuakhali  
Cell: 01714-989160

Primary group/ assisted by AEC and iDE 

15 Farmers Friends Organization

Mohammed Jalal Uddin  
President  
Vill: Padri Shibpur  
Uz: Bakerganj  
Dist: Barisal  
Cell: 01716-493136

Primary group/ assisted by iDE

16 Chandanpat Union Federation

Mr. Montajul Islam  
Coordinator  
Chandanpat  
Rangpur  
Cell: 01730-328246

Federated/ assisted by RDRS

17 Madhobram Sarderpara Gram Samity

A R Sajol  
Coordinator  
Vill: Madhabram Sarderpara  
Union: Bhogdanga  
Uz: Sadar  
Dist: Kurigram  
Cell: 01733-402435

Federated/ assisted by SDF

18 FGD with Jatrapur Union Federation

M A Jobbar  
President  
Jatrapur, Kurigram  
Cell: 01710-998888

Federated/ assisted by RDRS

19 Thethrai Union Federation

Mr. M A Rashid  
Coordinator  
Thethrai, Ulipur, Kurigram  
Cell: 01710-998905

Federated/ assisted by RDRS

20 Chandipur Gram Samity

Ms. Asma  
Community Professional  
Vill: Chandipur; Union: Kursa  
Uz: kawnia; Dist: Rangpur

Federated/ assisted by SDF

21 Idilpur Pineapple Producers Multipurpose 
Cooperative Society Ltd

Mr. M A Mannan  
Secretary  
Vill: Idilpur; Union: Kakraid  
Uz: Madhupur  
Dist: Tangail  
Cell: 01740-905408

Autonomous 

22 Kukua Union Integrated Fishermen Cooperative 
Association Ltd.

Mr. Mosharrof Hossain  
President  
Vill: Kukua Bazar  
Union: Kukua  
Uz: Amtali  
Dist: Barguna  
Cell: 01710-703645

Secondary FO/assisted by RFLDC-DANIDA
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Sl>no. Name>of>FOs> Contact>person>and>address Type>of>FO

23 Bodorkhali Union Fishermen Welfare Cooperative 
Association

Mr. Osim Roy  
Village: Kumrakhali; PO: Bawalkar; Union: 
Bodorkhali; Upazila: Sadar; District: 
Barguna  
Cell: 01735672420

Secondary FO/ assisted by RFLDC-DANIDA

24 Burirchar Union Integrated Fishermen Cooperative 
Association Ltd.

Mr. Rabiul  
Coordinator  
Vill: Charakganchia  
Union: Burichar  
Uz: Sadar  
Dist: Barguna  
Cell:01712-877494

Secondary FO/ assisted by RFLDC

25 Uttar Bawalkar Gram Samity

Ms. Anjuman Ara  
President  
Vill: Uttar Bawalkar  
Badarkhali, Barguna Sadar

Federated/ assisted by SDF

26 Monshatoli Gram Samity

Ms. Khadija  
President  
Vill: Monshatoli  
Union: Monshatoli Baliatoli  
Uz: Sadar; Dist: Barguna

Federated/ assisted by SDF

27 Adarsha Chashi Unnayan Samity

Md. Soliman  
President  
Purba Kancha Bazar  
Charfasson  
Bhola  
01724 323253

Autonomous

28 Ridoye Mati O Manush Krishak Samabay Samity

Mr. Ketab Mandal  
Secretary  
Mikomery, Ishurdi  
Pabna

Autonomous

29 Shurjamukhi Mahila Sangstha

Ms. Rosy Elijabeth  
President  
Laimi Para  
Bandarban Hill District  
Cell: 01820402446 

Autonomous

30 Badarganj Upazila Service Provider Association (SPA)

Md. Obydul Haque  
President  
Village: Osmanpur Sardarpara  
PO: Bishnupur  
Post Code: 5430  
Thana/Upazila: Badargonj  
District: Rangpur  
Cell: 01743922471

Primary FO/ assisted by Helvetas

31 Bangladesh Farmers Marketing Group Association

Mr. Bablur Rashid  
President  
Village: Durlavepur (sherpur bhander), PO: 
Shibganj, Upazila: Shibganj; Dist: Chapai 
Nawabganj  
Cell: 01718137022

Autonomous 
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